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1
Introduction
Metalogix Archive Manager for Exchange is a comprehensive solution to consolidate, preserve,
and retrieve your organization's emails from Microsoft Exchange Servers. This guide describes the
information available to monitor and manage your deployment, the options, actions, and
processes that you can leverage to archive emails, and the powerful search capability to locate
and manage the archives.
Managing the deployment
Whether you have a single-instance or a load-balanced distributed deployment with multiple
archive and retrieval servers, managing their health is centralized in the Archive Manager for
Exchange Administration Center (AMAC). The AMAC gives you full control of automated archival
jobs for user mailboxes and public folders, Microsoft Exchange Server synchronization,
compression, retention and threshold settings for mailboxes and groups, and a host of other
controls to fine-tune the solution to the needs of your organization.
Email archiving
When emails are archived with Archive Manager for Exchange, emails on the Microsoft Exchange
Server or Office 365 are replaced by a shortcut. The original email and all its versions are stored in
configurable external data stores. When you activate the Single Instance Store (SIS), duplicate
copies of emails going to multiple users are automatically removed during the archival process.
As a result, large amounts of corporate storage space is saved, dependency on PST files is
eliminated and your Microsoft Exchange Server retains its stability by eliminating the
unnecessary data.
Advanced search and eDiscovery
With the powerful search capability of the AMAC, you can retrieve emails on demand. You can
conduct focused searches by name, date range, and specific words, and export the results for
review. You can put selected groups of data on legal hold, or suspend them from disposition
policies.
The Metalogix Archive Manager for Exchange solution offers a variety of installable features and
extensions that simplify the collection, storage, availability, and protection of your organization's
data.
PST protection and elimination
The PST Gatherer is an extension that complements the PST Importer feature to help you collect,
upload, and archive PST files. Emails are safely archived and available on-demand even when
working remotely and without changing the end user’s Outlook folder structure. You can
eliminate corrupted files, password-protected files, and islands of information. For more
information see the PST Importer Administration Guide.
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Lifecycle management
You can capture, route, store, restore and manage archived emails externally with the
Hierarchical Storage Management (HSM) archive engine. HSM automatically controls the
retention policy of archived emails. The HSM engine can control a large range of external stores
like DVD, CD-ROM, HDD, tape, SAN, Jukebox systems, EMC Centera, NetApp, JVC, and many other
on-premise or cloud-based data storage solutions. You can move emails to cheaper locations as
their relevance changes and keep the option of deleting old messages unless they are on legal
hold. For more information see the Hierarchical Storage Management (HSM) Guide.
Disaster management and high availability
You can archive messages in parallel to multiple locations in real-time and provide a backup of
the archive on-the-go. With HSM, you can quickly retrieve archived emails from either location
and activate continuous off-site replication for deploying data disaster recovery, so end-users are
covered in the event of an outage.
Online on-demand access
With ArchiveWeb installed, you can work with archived emails even if the Microsoft Exchange
Server is unavailable. When you install the Outlook AddIn for your users, they can archive and
restore their emails on the go. For more information see the MS Outlook Addin User Guide. With
the Archive Manager Outlook Web Access (OWA) support emails are available to users online. For
more information see the OWA Installation Guide. Also, mobile users, Mac users, and Linux users
can work with archived emails when the Archive manager Universal Access extension is installed.
For more information see the Universal Access Installation Guide.
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2
About the Administration Center
The Archive Manager for Exchange Administration Center (AMAC) provides you with all the
information available to monitor and manage your deployment, the options, actions, and
processes that you can leverage to archive and work with emails, and a powerful search capability
to locate and manage the archives.
In this chapter:
· Starting the AMAC
· Managing Sessions
· Views

o Manager View
o Status View
o Archive View
o Toolbar Icons
· Tools
· Help

Starting the AMAC
You can start the AMAC in two ways:
1. Login to the Archive Manager for Exchange server.
Unless you added and granted the necessary permission to additional users, you must login as
the superuser to access the AMAC. A superuser account is a windows account with enterprise
administrator privileges to work with the Archive Manager for Exchange administration tools,
run services, manage databases, and manage extensions. It also has elevated privileges to
interact with the on-premise or online Microsoft Exchange servers.
If the Archive Manager for Exchange server is connected to Office 365, you must login as the
superuser.
You can grant logon permissions to additional users from the Tools > Options > User Roles tab.
For more information see Tools, Options and Settings. If you attempt to start the AMAC while
logged on as another user without sufficient rights, a notification dialog appears which
informs you that your user does not have enough permission to log on.
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2. Go to Start > Programs > Metalogix and click Archive Manager for Exchange.
or
Go to C:\Program Files (x86)
\Metalogix\MAM4Exchange\Applications\EnterpriseManager and click

PamEnterpriseMan.exe
3. The AMAC opens and the Manager view is displayed.

Managing Sessions
Via Archive Manager for Exchange administrator can connect to and administer also other Archive
Manager servers, if such are installed. To do so, on the Session menu click Connect to server. New
window pops-up. Switch to Remote host and enter the name of the server you want to connect to
in the Server name combo box. Then click OK.

To access the server installed on the local computer, switch to Local host and click OK.
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Views
There are three views in the AMAC:
· Manager view - default view that provides you with all the capabilities to manage your

deployment.
· Status view - provides the information to monitor and your deployment and start or stop

services.
· Archive view - provides a full range of manual archival and retrieval features for mailboxes and

public folders.
There are three ways to open or move between these views:
1. Use the following keyboard keys
· CTRL-1 for the Manager view.
· CTRL 2 for the Status view.
· CTRL 3 for the Archive view.

2. Open the View menu and select Manager, Status, or Archive

3. Click the respective icons in the lower left corner of the AMAC.
NOTE: AMAC can run in Full Access or Read-only mode. In the read-only mode the
configuration is locked, but archive management through the Archive view is not affected.
So in read-only mode you can manually archive and restore emails, but the settings cannot
be changed.
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Manager View
This is the default view. It is used to configure the automated archiving of mailbox user groups or
public folders with jobs, scheduling jobs, configuring archive settings and manage the locations
of several Archive Manager for Exchange servers in a distributed deployment. The image below
displays the default Groups tab that helps you manage settings for various user groups. Notice
that some groups are displayed in green. The green color indicates that the mailboxes of group
members have been activated for automated archiving. For more information see Manager view.
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Status View
The Status view displays information about the critical components of your deployment like the
the status of the Archive Manager for Exchange services, logged on users, the Hierarchical Storage
Management (HSM) engine and the database. For more information see Status view.
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Archive View
This view is reserved for manual archiving or restoration of mailbox and public folder items.
When you restore email items, the original item and its versions are retrieved from the archive
store and copied to the Microsoft Exchange server. For more information see Archive view.
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Toolbar Icons
The toolbar provides set of smart icons for standard commands and functions. Smart icons are
activated when you need to invoke a specific function in a specific view (e.g. Manager view,
Groups tab, and others).

Image

Name

Description

Properties

If you want to check or define specific criteria for group
archiving, just select the respective group on the Groups
tab and click the Properties icon to open its Properties
window. In the Properties window you may set your
criteria on the respective General, Scheduler, Folders,
Classes and the Script tabs. (See the section "Setting
criteria for group archiving”)
If you want to check or define specific criteria for public
folders, just select the respective public folder on the
Public folders tab in Manager view and click on the
Properties icon to open its Properties window. In the
Properties window that is displayed you may set your
criteria on the respective General, Scheduler, Classes,
and the Script tabs. (See the section "Public folders tab”)

Refresh

By clicking on this icon you will refresh the screen so that
it is updated following the recently completed
instruction.

Copy settings

By using this icon you may easily copy one group or public
folder settings.

Paste settings

By using this icon you may easily paste one group or
public folder copied settings to another.

Remove

This icon can be used for instance for removing
mailboxes or groups from full-text search on the Settings
tab in Manager view. In general, it is used for removing
objects from different tabs under the Settings tab in
Manager view, or for removing objects from the Jobs tab.

Create new job

Accessible from the Jobs tab in Manager view. By clicking
on this icon you may create a new job simply by entering
its specifications in the Job Settings window.
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Schedule job

Accessible from the Jobs tab in Manager view. When a
job is stopped you may schedule it easily by clicking on
the Schedule job icon.

Stop job

Accessible from the Jobs tab in Manager view. When a
job is scheduled you may stop it easily by clicking on the
Stop job icon.

Archive

Accessible on the Mailboxes tab as well as Public folders
tab in Archive view. This icon is used for manual archiving
of individual emails, groups, folders, mailboxes etc. Just
select the desired item and click on the Archive icon on
the toolbar. The Archive options window opens and you
can select the retention category under which the chosen
item will be archived.

Restore

Accessible on the Mailboxes tab as well as Public folders
tab in Archive view. This icon is used for the manual
restoring of individual emails, groups, folders, mailboxes
etc. Just select the desired item and click on the Restore
icon on the toolbar. In the Restorer options window click
on the Accept button. Archived mail will be restored and
the respective shortcuts will be replaced with previous
icons.

Advanced search

Accessible in all three views. If you need to search for
some information in the archive, simply use the Search in
archive icon on the toolbar (see further).

Show legend

Accessible in the Archive view. When you click this icon,
the legend dialog pops up displaying all kinds of icons
that you can see on the tabs of Archive view and the
explanation for the icons.

Address Book Manager

Opens the Address Book Manager which synchronizes
servers, groups and mailboxes with Archive Manager for
Exchange (see the section "Address book Manager”).
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Tools
This menu provides the administrative tools, options and settings to manage the application and
preferences for the AMAC. The list of menu options are summarized below. For more
information see Tools, Options and Settings.
· Mailbox Rights Manager - manages user access rights for the ArchiveWeb feature. ArchiveWeb

is used for viewing and working with archived emails over the internet and includes full-text
searching. For more information see Mailbox Rights Manager.
· Check Mailboxes - this command lets you check mailbox connections to the Microsoft Exchange

Server. For more information see Check Mailboxes.
· Create folders - this wizard helps you create Outlook folders for your users. For more

information see Create folders
· Export tasks - manages the export of items from the result set of the advanced search in the

AMAC or ArchiveWeb, to a mailbox or PST file. For more information on how to export found
items see Advanced Search.
· Statistics - helps the administrator get an overview of the number of items archived during

specific hours, days, weeks, months, or years. For more information see Statistics.
· Address Book Manager - manages the synchronization of your servers, groups, mailboxes and

their permissions with the Active Directory. For more information see Address Book Manager.
· Options and Settings - opens the configuration windows for configuring AMAC preferences. For

more information see Options and Settings.

Help
The Help option on the menu bar provides access to different information dialogs and assistance
features.

The options in this menu are described below:
· About – provides information about the current Archive Manager for Exchange version.
· License – provides information about your license, its limit and the expiration date.
· Support – provides a link to the Knowledge base articles on the Quest website. You can click

the Open support ticket which directs you to the online support portal where you can submit a
support request.
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· Help Topics – opens the Metalogix Archive Manager for Exchange Administration Guide.
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3
Tools, Options and Settings
This chapter describes the administration tools, options and settings to manage the application,
synchronization and preferences for the AMAC.
· Administration Tools

o Mailbox Rights Manager
o Check Mailboxes
o Create folders
o Export tasks
o Statistics
o Address Book Manager
· Options
· Settings

Mailbox Rights Manager
The Mailbox Rights Manager is a tool to manage the access rights for designated administrators of
ArchiveWeb. Privileged users can use ArchiveWeb for viewing and working with archived emails
over the internet and includes full-text searching. Archived mailboxes and folders are visible in
ArchiveWeb even if the Microsoft Exchange Server or Office 365 is unavailable.
NOTE:
You must synchronize the mailboxes and folders before you use the Mailbox Rights
Manager tool. This will ensure that mailbox and folder permissions are available and
applicable to ArchiveWeb. For more information about synchronization see Synchronizing
Address Book Manager.
To manage rights with the Mailbox Rights Manager tool, the logged in user must have the
Modify Mailbox Permission role set to Allow. User roles are assigned in the Tools >
Options > User Roles tab.

About Mailbox Rights Manager
1. From the Tools menu, click Mailbox Rights Manager. The Mailbox Rights Manager window
opens.
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2. Click any tab to view the list of mailboxes by the preset alphabetical filter. The All tab is the
default preset filter that returns all mailboxes
or
Enter the name of a mailbox in the search field below the tabs. You can also enter one or more
letters to search for all mailboxes that contain the letters. Wildcards are not allowed.
NOTE: The Mailbox Rights Manager for individual mailboxes can also be opened from
the Address Book Manager > Mailboxes tab where you right-click the mailbox from the
list view and select Permissions.

The list columns are described below:
a. Display Name - the display name of the synchronized mailboxes available to the tool.
b. Shared - indicates whether or not a listed mailbox is accessible to the logged in user. Yes
indicates the logged in user has been granted rights to the mailbox. A blank value indicates
the mailbox is either not shared or belongs to the logged in user. In the figure above, the
logged in user is the domain administrator. Since the logged in user cannot assign access
rights to their own mailbox, the value is blank.
c. Email address - the email address of the synchronized mailbox.
3. Click the Refresh button to reload the search result or click Close to exit the window.

Steps to grant access rights to mailboxes
1. Open the Mailbox Rights Manager.
2. Locate one or more mailboxes that you want to share with the users through ArchiveWeb.
3. Select a single mailbox or press ctrl on your keypad and select multiple mailboxes that you
want to share.
4. Right-click the selection and click Properties from the context menu.

Archi ve Ma na ger for Excha nge Admi ni s tra ti on Gui de
Tool s , Opti ons a nd Setti ngs

19

5. The Mailbox Rights window opens. If you selected multiple mailboxes, the Mailbox Rights
window opens and displays the the Mailbox security tab. If you selected multiple mailboxes,
you will see additional tabs that are explained later in this topic. To share the rights to
mailboxes, only the Mailbox security tab is relevant. If the mailbox was previously shared, the
list of all users who have the rights to the mailbox(es) will be listed.

Figure a. Onl y the ma i l box s ecuri ty ta b a ppea rs when Figure b. Addi ti ona l ta bs a ppea r when a s i ngl e
mul ti pl e ma i l boxes a re s el ected
ma i l box i s s el ected

6. To grant rights to additional users, click Add. The Select mailbox window opens.
7. Select one or more users who will be granted the rights to the mailbox(es). Then click
to add the selected user(s) to the Selected objects list. To remove users from the Selected
objects list, select one or more users from the Selected objects list and click
to move
them back to the list of mailboxes. If you enter the name of a listed mailbox user directly in
the search field and click enter, the mailbox user will be directly added to the Selected
objects list.
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8. Click OK to grant the rights to the users who are listed in the Selected objects list.
9. Verify that the additional users were granted the rights to share the selected mailbox(es).
When mailboxes are shared using the Mailbox Rights Manager tool, the users that are granted
the rights appear in bold font. If a mailbox was shared through permission settings in the
Microsoft Exchange Server or Office 365, the users appear in normal font.

10. To revoke access rights to a mailbox, select a user from the Mailbox rights list and click
Remove.
11. Click OK to close the window.

Steps to grant access rights to mailbox folders
1. Open the Mailbox Rights Manager.
2. Locate the mailbox that you want to share with the users through ArchiveWeb.
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3. Select a mailbox and right-click the selection. Then click Properties from the context menu.
The Mailbox Rights window opens. The window title indicates the mailbox name and the
mailbox identifier.
4. Click the Folder security tab.
5. Select the folder that you want to share with other users. Only one folder can be selected at a
time.

6. To grant rights to additional users, click Add. The Select mailbox window opens.
7. Select one or more users who will be granted the rights to the folder and click
to add
the selected user(s) to the Selected objects list. To remove users from the Selected objects
list, select one or more users from the Selected objects list and click
to move them
back to the list of mailboxes. If you enter the name of a listed mailbox user directly in the
search field and click enter, the mailbox user will be directly added to the Selected objects
list.

8. Click OK to grant the rights to the users who are listed in the Selected objects list.
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9. Verify that the additional users were granted the rights to share the selected folder. When a
folder is shared using the Mailbox Rights Manager tool, the users that are granted the rights
appear in bold font. If a folder was shared through permission settings in the Microsoft
Exchange Server or Office 365, the users appear in normal font. The shared folder is indicated
with a green folder icon.

10. To grant the same permission to all subfolders, right-click the folder and click Apply to
subfolders from the context menu.

11. Verify the result and click OK to close the window.

Steps to grant access rights to public folders
1. Open the Mailbox Rights Manager.
2. Locate the public folder mailbox that contain the public folders you want to share with the
users through ArchiveWeb.
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3. Select the public folder mailbox and right-click the selection. Then click Properties from the
context menu. The Mailbox Rights window opens. The window title indicates the mailbox
name and the mailbox identifier.

4. Click the Folder security tab.
5. Select the public folder that you want to share with other users. Only one folder can be
selected at a time. A green icon indicates that a public folder has been shared.
6. To grant rights to additional users, click Add. The Select mailbox window opens.
7. Select one or more users who will be granted the rights to the mailbox(es) and click
add the selected user(s) to the Selected objects list. To remove users from the Selected

to

objects list, select one or more users from the Selected objects list and click
to move
them back to the list of mailboxes. If you enter the name of a listed mailbox user directly in
the search field and click enter, the mailbox user will be directly added to the Selected
objects list.

8. Click OK to grant the rights to the users who are listed in the Selected objects list.
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9. Verify that the additional users were granted the rights to share the selected folder.

10. To grant the same permission to all subfolders, right-click the folder and click Apply to
subfolders from the context menu.

11. Click OK to close the window.

Steps to view the access rights of a user
1. Open the Mailbox Rights Manager.
2. Locate the user and right-click the selected mailbox. Then click Properties from the context
menu. The Mailbox Rights window opens. The window title indicates the mailbox name and
the mailbox identifier.
3. Click the Access tab to view all the mailboxes and folders that are shared with this user.
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4. Click OK to close the window. If you click Cancel the window closes and any changes you may
have made in other tabs that were not saved will be rejected.

Check Mailboxes
This tool checks the connection between mailboxes available in the AMAC and the Microsoft
Exchange Server. Use this tool:
· After the first installation of Archive Manager for Exchange.
· After configuration changes on Microsoft Exchange Server, like a mailbox migration.

Steps to use the Check Mailbox tool
1. From the Tools menu click Check mailboxes. The Check mailbox connections wizard opens.
The list view displays mailboxes synchronized with Archive Manager for Exchange.
2. Select the check boxes below the list as described below:
· Include deleted mailboxes to display the mailboxes that were deleted.
· Include deactivated mailboxes to display the deactivated mailboxes.

3. Select the mailboxes for which you want to check the connection to Microsoft Exchange
server.
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4. Click Finish to start checking the mailbox connections. The Checking in progress window
opens.

5. Verify the result and address any connection issues. Click Close to close the window.

Create Folders
The Create Folders tool helps you create custom folders in MS Outlook for one or more users that
are available in the Address Book Manager.

Steps to create a folder in MS Outlook
1. From the Tools menu click Create Folders. The Create Folder Wizard opens.
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2. Specify the properties as described below:
a. Folder to create - specify the name of the folder to create. The default name is Archive and
is specified as an an example.
b. Folder Type - specify the type from one of the standard types: Mail, Calendar, Contact,
Task, Notes or Journal.
c. Create folder in the following mailboxes
· all mailboxes - choose this option to create the folder in all user mailboxes.
· select mailbox from the list - choose this option to select specific users from the user

mailbox list available in Address Book Manager.
d. Set folder home page - Select the check box to set a home page for the created folder and
then specify the URL for the home page. For example, the ArchiveWeb application can be
made available to users in the folder.
3. Click Next. If you have selected the select mailbox from the list option, the Select mailboxes
window opens.

4. Select the mailboxes where the folder will be created. Then click Finish. The Folder creation
in progress window opens.
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5. Verify the result and click Close to exit the tool.

Export Tasks
When you save a search result to an XML file using the Advanced Search feature of the AMAC, the
Export Tasks tool helps you to export the email items in the search result to another mailbox or a
PST file.
In this topic:
· About the export task list
· Create new task
· Start or stop a task
· Remove a task or refresh the task list
· Add documents to a task
· Remove documents from a task
· Change the properties of a task

About the export task list
1. From the Tools menu click Export tasks. The Export Tasks window opens.
2. The table lists all the existing tasks otherwise the table is blank.
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The columns are as described below. The columns can removed or added back when you
right-click and choose Add/remove columns from the context menu. You can also click a
column title to sort the rows in alphabetical order.
a. Type - the task type. Valid values are Export to mailbox or Export to PST.
b. Name - name of the task
c. Status - the status of the task. Valid values are Waiting, Finished, Processing.
d. Messages total - the number of email messages in the XML file that was attached to the
task.
e. Processed messages - the number of email messages that the tool attempted to export.
f. Success - the number of email messages that were successfully exported.
g. Warning - the number of email messages that were exported with some data issues.
h. Error - the number of email messages that could not be exported.
i. Mailbox - identifier of the mailbox where the data will be exported if the task type is
Export to mailbox.
j. PST File - path of the PST file where the data will be exported if the task type is Export to
PST.
k. Folder - folder path where the Task details are stored. For example, C:\Program Files
(x86)\Metalogix\MAM4Exchange\Export\<folder-identifier>

l. Target Folder - name of the root folder that will be created in the target mailbox or PST
file.
m. Settings - Number that indicates a unique combination of settings from the Export Tasks
Properties window.
n. Last Error - The most recent error that occured when the export task runs. For example, it
could be a global error that caused the export task to fail or an error specifically related to
the most recent item in the export task.
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Steps to create a new task
1. Right-click anywhere in the Export Tasks window and select Create new task. The Select export
source window opens.
2. Enter a name for the task. We recommend that you use descriptive names to avoid confusion.
3. Click Load. The Open Search Result File window opens. Locate and select the XML file. Then
click Open.
4. The file is attached to the task. Verify that the number of email messages indicated by the
Number of loaded documents property is as expected.

5. Click Next. The Select export destination window opens.
6. Select Export to mailbox or Export to PST.

7. Click Next. The Export settings window opens.
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The properties in this window apply to both destinations: mailbox or PST, and are described
below:
Export folder hierarchy
a. Target folder base - name of the folder that will be created when email items are exported
to a mailbox or PST file. Default value is Export.
b. Create folder hierarchy - choosing this option creates a folder hierarchy as defined in the
email being exported. For example, if the email is an inbox item, the email will be
exported to the Export\Inbox folder.
c. Export all documents to one folder - choosing this option exports the messages to the
same root folder specified in the Target folder base property.
d. Create separate folder for each distinct mailbox - Select this check box to create a subfolder for each recipient mailbox that is specified in the message. For example if there are
two messages in the source XML file that belong to different mailboxes like David Webb
and
Task start
e. Start Export immediately f. Create and export task, but do not start it 8. Click Next. The Summary window opens.
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9. Verify the settings and click Finish. The new task appears in the task list of the Export Tasks
window.

Steps to start or stop a task
1. Select a task from the task list of the Export Tasks window.
2. Right-click the selected task to open the context menu.

3. Click Tasks and then click Start task to start a task, or click Stop task to stop a task.

Steps to remove a task or refresh the task list
1. Select a task from the task list of the Export Tasks window.
2. Right-click the selected task to open the context menu.

3. Click Remove task to remove a task from the task list. Click Yes to confirm the removal.
4. Choose between two options to refresh tasks:
a. Click Refresh to manually refresh the task list.
b. Right-click Automatic refresh to allow the application to refresh the task list every 15
seconds which is preferred for long task lists. After it is activated, you can right-click
Automatic refresh again to deactivate it.
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Steps to add documents to a task
Adding documents to tasks lets you combine more XML source files in one export task. This is
helpful when you need to perform two searches with different search criteria and generate
separate XML files for each search result.
1. Select a task from the task list of the Export Tasks window.
2. Right-click the selected task to open the context menu.
3. Click Tasks and then click Add documents to task. The Open Search Result File window opens.
4. Locate and select the XML file. Then click Open.
5. The document is added to task. The Messages total column value for the task will increase.
Verify that the total is as expected.

Steps to remove documents from a task
1. Select a task from the task list of the Export Tasks window.
2. Right-click inside the window to open the context menu.
3. Click Tasks and then click Clear Documents.
4. Confirm that all documents will removed from the task.
5. Verify that the Messages total column value for the task is 0.

Steps to edit task properties
1. Select a task from the task list of the Export Tasks window.
2. Right-click inside the window and select Properties from the context menu. The Properties
window opens.
a. Export task tab - allows you to view or change the name of the task and the export folder
settings as described previously in this topic.
b. Documents tab – displays task statistics.
· Documents of task - this section displays the statistics of the documents attached to the

file.
· PST File Info - in this section you can check the Total PST size and set the Maximum size

of the PST file. By default size is 2 GB. You can limit the file size when exporting. If the
exported amount is exceeds this limit, a new file is created.
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Statistics
Statistics functionality helps the administrator get an overview of:
· number of items archived during a specific period (Archived messages view)
· size of individual mailboxes and their archive (Archived size view)

To display the statistic overview in Archive Manager for Exchange, click Tools/Statistics on the
main menu. The Statistics window opens by default in the Archived messages view. Switch
between views in the left pane of the window.
To get statistics on the number of archived messages, select the Archived messages view in the
left pane. In the Date range section define the time period for which you want to generate the
statistics. If you have selected "Interval”, specify the time span in the From/to text boxes (either
overwrite the dates or click the down arrows to select desired days in the calendar).
As a next step sort the data by hours/days/weeks/months/years as you select the respective
option in the Grouping section. Finally click Apply.

The statistical data for the chosen time period will be represented in the form of a graph and on
the Data tab as a statistics table. To export the statistical data, click the Export button and then
select the export folder.
TIP: Use the icons in the upper bar of the Statistics window to switch between bar graph ()
and line graph ().
It is also possible to zoom parts of the graph. Simply click inside the graph and draw the
cursor to select the part which you want to zoom. To un-zoom, right-click inside the graph.
In the context menu select Un-Zoom. The graph context menu offers also additional
commands as Print, Save Image As etc.
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To get an overview of individual mailboxes, the size of messages, archive, shortcuts etc. switch to
the Archive size view in the left pane. On the Mailboxes tab check the mailboxes for which you
want to generate the statistics and click Run.
NOTE: If you check the Include Exchange size check box the report will contain a new
column: current size of the mailbox on Microsoft Exchange. This helps you to report the
size of the mailbox after archiving.

The statistical data for the chosen mailboxes will be represented in the form of a graph and on
the Data tab as a statistics table. Colors in the graph represent the following:
red – the size of all messages of the given mailbox
green – the size of the mailbox in the HSM store, i.e. archive size
yellow – the shortcut size, i.e. the size of shortcuts left in the Microsoft Exchange server
NOTE: Overview reports for mailboxes can be created in the Manager view from the
Settings tab > Archive size report. The Export wizard on that tab offers advanced
functionality. The report can be exported and adjusted to the administrator’s needs

Address Book Manager
Active Directory forest and domains store information about Microsoft Exchange servers,
mailboxes, and other Microsoft Exchange-related objects in your organization. The Address Book
Manager helps you to manage the Microsoft Exchange servers, mailboxes and groups which are
imported into Address Book Manager and keep them in synch to facilitate email archiving. You
can schedule automatic synchronization to keep the Metalogix Archive Manager for Exchange
database up to date and synchronized with the Active Directory.
In this topic:

Archi ve Ma na ger for Excha nge Admi ni s tra ti on Gui de
Tool s , Opti ons a nd Setti ngs

36

· Steps to open the Address Book Manager
· About the Address Book Manager
· Importing Microsoft Exchange Servers
· Importing Mailboxes
· Importing or Creating Groups
· Synchronizing Address Book Manager
· Managing Servers
· Managing Groups
· Managing Mailboxes

Steps to open the Address Book Manager
1. Log in to the Metalogix Archive Manager for Exchange console.
2. From the Tools menu, click Address Book Manager

or, click the Address Book Manager icon from the toolbar.

3. If no Microsoft Exchange servers, mailboxes or groups are available in the Address Book
Manager, the Address Book Setup wizard appears. Otherwise the Address Book Manager
window opens.

About the Address Book Manager
The Address Book Manager window provides two menu options:
Setup - starts the Address Book Setup wizard that provides a step-by-step guide to add Microsoft
Exchange servers, mailboxes and groups. If no Microsoft Exchange servers, mailboxes or groups
are available in the Address Book Manager, the Address Book Setup wizard appears by default
when you open the Address Book Manager.
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Refresh - reloads information about Microsoft Exchange servers, mailboxes and groups based on
the available configuration settings.
The management of Microsoft Exchange servers, mailboxes, groups and synchronization settings
are organized by tabs in the Address Book Manager window.
· Synchronization – for manual or automatic synchronization of mailboxes, groups and

permissions with the Active Directory of available servers.
· Servers – for adding, removing and managing Microsoft Exchange servers.
· Groups – for importing groups, creating user-defined groups and managing group features.
· Mailboxes – for importing new mailboxes and managing mailboxes.

Importing Microsoft Exchange Servers
In this topic:
· Options for importing Microsoft Exchange servers
· Steps to add on-premise Microsoft Exchange servers
· Steps to add online Microsoft Exchange servers
· Steps to verify the imported Microsoft Exchange servers

Options for importing Microsoft Exchange servers
Microsoft Exchange Servers can be added to the Address Book Manager in one of two ways:
· Option 1 - By using the Address Book Setup Wizard.
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1. Open the Address Book Manager.
2. From the Setup menu, click Setup Wizard. The Address book setup wizard appears.
3. Click the Launch server wizard to initiate the import process.

· Option 2 - By starting a task from the Servers tab of the Address Book Manager.

1. Open the Address Book Manager.
2. Click the Servers tab.
3. Right-click inside the list view and from the context menu point to Tasks and select Add
Server... to initiate the import process.

Whichever method you choose, the Select Exchange Server Type window opens.
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Steps to add on-premise Microsoft Exchange servers
1. In the Select Exchange Server Type window, select Import Exchange On-Premise.

2. Click Next. A list of Microsoft Exchange Servers appear that are accessible within your trusted
domain.

Select the servers that contain the mailboxes and folders you want to archive and then select
the check boxes to set the permissions as described below:
a. Set Exchange server permissions for Metalogix service account - grants elevated rights to
the superuser on each of the selected Microsoft Exchange Servers.
b. Set Public Folder permissions for Metalogix service account - grants OWNER permission to
the Public folders.
3. Click Next. The Superuser's mailbox SMTP address window opens.
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4. In the Superuser's mailbox SMTP address field, enter the email address of the superuser if not
already filled in. You can change the email from the server Properties window.

5. Click Next. The Summary window opens that lists the on-premise servers that will be added.

6. Click Finish to start the import process. The Creating objects window opens. You can click Back
to select more servers to add or remove some of the selected servers.
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7. When the import process has completed, click Close.

Steps to add online Microsoft Exchange servers
1. In the Select Exchange Server Type window, select Import Exchange Online.

2. Click Next. The Service account for O365 Exchange server import window opens.
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3. Enter the administrator credentials for the Microsoft Exchange online server.

4. Click Next. The Available Exchange Servers window opens. Select the desired Office 365
instance. You can click Back to select more servers to add or remove some of the selected
servers.

Select the servers that contain the mailboxes and folders you want to archive and then select
the check boxes to set the permissions as described below:
c. Set Exchange server permissions for <Exchange server online superuser> - grants elevated
rights to the Exchange serve online superuser on each of the selected servers.
d. Set Public Folder permissions for <Exchange server online superuser> - grants OWNER
permission for the Public folders to the Exchange serve online superuser.
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5. Click Next. The Summary window opens that lists the online Microsoft Exchange servers that
will be added.

6. Click Finish to start the import process. The Creating object window opens.
7. When the import process has completed, click Close.
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Steps to verify the imported Microsoft Exchange
servers
1. Open the Address Book Manager
2. Click the Servers tab and verify the imported servers in the list view.

Importing Mailboxes
In this topic:
· Options for importing mailboxes
· Steps to import mailboxes from on-premise Microsoft Exchange servers
· Steps to import mailboxes from online Microsoft Exchange servers
· Steps to verify the imported mailboxes

Options for importing mailboxes
Microsoft Exchange server mailboxes can be added to the Address Book Manager in one of two
ways:
· By using the Address Book Setup Wizard.

1. Open the Address Book Manager.
2. From the Setup menu, click Setup Wizard. The Address book Setup wizard appears.
3. Click the Launch mailbox wizard to initiate the import process.
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· By using the Mailboxes tab of the Address Book Manager.

1. Open the Address Book Manager.
2. Click the Mailboxes tab.
3. Right-click inside the list view and from the context menu point to Tasks and select Import
mailbox wizard... to initiate the import process.

Whichever method you choose, the Import mailbox wizard window opens.
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Steps to import mailboxes from an on-premise
Microsoft Exchange Server
1. In the Select Exchange Server Type window, select Import from Exchange On-Premise.

2. Click Next. The Mailboxes - search and select mailboxes to import window opens.

3. Click Search to return the list of all mailboxes across all on-premise servers available to the
Address Book Manager. To reduce the list of mailboxes, you can specify a search term in the
Look for Name search box. Only the initial letters of the mailbox Display Name can be
specified, and wildcards are not supported. The search term is case-insensitive. For example,
if you enter ni as the search term and click Search, the mailboxes that start with the letters ni
will be returned in the search results list.
4. Select one or more mailboxes that you want to import.
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NOTE: Mailboxes that are highlighted indicate that they already exist in the Address
Book Manager. The list summary above the list of mailboxes will indicate how many
mailboxes that you select are new, and how many already exist. If you select preexisiting mailboxes, they will be updated during the import process.
5. Click Next. The Summary window opens that lists the mailboxes from the on-premise
Microsoft Exchange servers that will be imported.

6. Click Finish to start the import process. The Creating Object window opens. You can click Back
to select more mailboxes to add or remove some of the selected mailboxes.

7. When the import process has completed, click Close.
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Steps to import mailboxes from an online Microsoft
Exchange Server
1. In the Select Exchange Server Type window, select Import from Exchange Online.

2. Click Next. The Exchange Online window opens. Select the desired Office 365 instance.
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3. Click Next. The Mailboxes - search and select mailboxes to import window opens.

4. Click Search to return the list of all mailboxes across all on-premise servers available to the
Address Book Manager. To reduce the list of mailboxes, you can specify a search term in the
Look for Name search box. Only the initial letters of the mailbox Display Name can be
specified, and wildcards are not supported. The search term is case-insensitive. For example,
if you enter A as the search term and click Search, the mailboxes that start with the letter A
will be returned in the search results list.
5. Select one or more mailboxes that you want to import.
NOTE: Mailboxes that are highlighted indicate that they already exist in the Address
Book Manager. The list summary above the list of mailboxes will indicate how many
mailboxes that you select are new, and how many already exist. If you select preexisiting mailboxes, they will be updated during the import process.
6. Click Next. The Summary window opens that lists the online Microsoft Exchange servers that
will be added.
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7. Click Finish to start the import process. The Creating Object window opens. You can click Back
to select more mailboxes to add or remove some of the selected mailboxes.

8. When the import process has completed, click Close.

Steps to verify the imported mailboxes
1. Open the Address Book Manager
2. Click the Mailboxes tab and verify the imported mailboxes in the list view.

NOTE:
In the mailboxes list you will also see mailboxes names public_<name-of-MicrosoftExchange-server>. These mailboxes are the public folders from the respective Microsoft
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Exchange server because Address Book Manager considers a public folder as a profile.
These mailboxes are always highlighted in blue , so you can distinguish them faster.
Imported mailboxes must be added to a group in Address Book Manager to activate
automatic archiving with scheduled jobs. If you do not add mailboxes to a group you can
archive them manually. For more information about adding mailboxes to groups see
Adding members to a user defined Archive Manager group.

Importing or Creating Groups
Groups activate you to schedule archiving jobs. There must be at least one group (either
imported from Active Directory or a user-defined group) if you plan to schedule archiving jobs.
User-defined groups are not Active Directory groups.
In this topic:
· Options for importing groups
· Steps to import groups from on-premise Microsoft Exchange servers
· Steps to import groups from online Microsoft Exchange servers
· Steps to create user-defined groups
· Steps to verify the imported groups

Options for importing groups
Microsoft Exchange server groups can be added to the Address Book Manager in one of two ways:
· By using the Address Book Setup Wizard.

1. Open the Address Book Manager.
2. From the Setup menu, click Setup Wizard. The Address book Setup wizard appears.
3. Click the Launch group wizard to initiate the import process.
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· By using the Groups tab of the Address Book Manager.

1. Open the Address Book Manager.
2. Click the Groups tab.
3. Right-click inside the list view and from the context menu point to Tasks and select Add
group wizard... to initiate the import process.

Whichever method you choose, the Import group wizard window opens.
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Steps to import groups from an on-premise
Microsoft Exchange Server
1. In the Import group wizard window, select Import Groups.

2. Click Next. The Exchange type selection window opens. Select Import form Exchange OnPremise.

3. Click Next. The Groups - search and select groups to import window opens.
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4. Click Search to return the list of all groups across all on-premise servers available to the
Address Book Manager. To reduce the list of groups, you can specify a search term in the Look
for Name search box. Only the initial letters of the groups Display Name can be specified, and
wildcards are not supported. The search term is case-insensitive. For example, if you enter D
as the search term and click Search, the groups that start with the letter D will be returned in
the search results list.
5. Select one or more groups that you want to import.
NOTE: Groups that are highlighted indicate that they already exist in the Address Book
Manager. The list summary above the list of groups will indicate how many groups that
you select are new, and how many already exist. If you select preexisting groups, all new
mailboxes will also be imported.
6. Click Next. The Group settings - default values window opens.

7. Specify the settings which will be applied when the groups are imported now or synchronized
in future with the Address Book Manager automatically or manually. The settings are
described below:
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a. Automatically import mailbox members - check this box to import all Active Directory
accounts with a mailbox that are members of this group.
b. Advanced import settings - check this box if you intend to import subgroups and subgroup
mailbox members. You can activate this setting only if you select the Automatically import
mailbox members setting.
c. Import subgroups along with members - check this box to import existing subgroups of
selected groups including its member mailboxes. This is the default setting.
d. Import only mailbox members without subgroups - check this box to import only member
mailboxes from subgroups. These mailboxes will be added to mailboxes in the parent
group in the Address Book Manager.
8. Click Next. The Summary window opens that lists the groups that will be added.

9. Click Finish to start the import process. The Creating Object window opens.

10. When the import process has completed, click Close.
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Steps to import groups from an online Microsoft
Exchange Server
1. In the Import group wizard window, select Import Groups.

2. Click Next. In the Exchange Type selection window, select Import from Exchange Online.

3. Click Next. The Exchange Online window opens. Select the desired online Microsoft Exchange
server.
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4. Click Next. The Groups - search and select groups to import window opens.

5. Click Search to return the list of all groups across all online servers available to the Address
Book Manager. To reduce the list of groups, you can specify a search term in the Look for
Name search box. Only the initial letters of the group Display Name can be specified and
wildcards are not supported. The search term is case-insensitive.
NOTE: Groups that are highlighted indicate that they already exist in the Address Book
Manager. The list summary above the list of groups will indicate how many groups that
you select are new, and how many already exist. If you select pre-existing groups, all new
mailboxes in those groups will also be imported.
6. Select the groups that you want to import.
7. Click Next. The Group settings - default values window opens
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8. Specify the settings which will be applied when the groups are imported now or synchronized
in future with the Address Book Manager automatically or manually. The settings are
described below:
a. Automatically import mailbox members - check this box to import all Active Directory
accounts with a mailbox that are members of this group.
b. Advanced import settings - check this box if you intend to import subgroups and subgroup
mailbox members. You can activate this setting only if you select the Automatically import
mailbox members setting.
c. Import subgroups along with members - check this box to import existing subgroups of
selected groups including its member mailboxes. This is the default setting.
d. Import only mailbox members without subgroups - check this box to import only member
mailboxes from subgroups. These mailboxes will be added to mailboxes in the parent
group in the Address Book Manager.
9. Click Next. The Summary window opens that lists the groups that will be added.
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10. Click Finish to start the import process. The Creating objects window opens. You can click Back
to select more groups to add or remove some of the selected groups.

11. When the import process has completed, click Close.

Steps to create user-defined groups
1. In the Import group wizard window, select Create user defined group. Enter a name for the
group in the Group Name field.

2. Click Next. The User Defined Group - Add members to group window opens. By default, the
on-premise Microsoft Exchange server is the source for the list of mailboxes and groups that
can be added to the user-defined group. To use O365 Exchange servers as a source for
mailboxes and groups, select Exchange Online.
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3. Click Search to return the list of all mailboxes and groups. To reduce the list of mailboxes and
groups, you can specify a search term in the Look for Name search box. Only the initial letters
of the mailbox or group Display Name can be specified and wildcards are not supported. The
search term is case-insensitive.
NOTE: If the Exchange Online check box is checked, only the online Microsoft Exchange
servers will be used as the source. If the Exchange Online check box is unchecked, only
on-premise Microsoft Exchange servers will be used as the source.
Mailboxes and groups that are highlighted indicate that they already exist in the Address
Book Manager. The list summary above the list of groups will indicate how many
mailboxes and groups are available.

4. Select one or more mailboxes and groups that want to add to the user-defined group. If you
select one or more groups, all mailboxes in that group will also be add to the user-defined
group during the import process.
5. Click Next. The Summary window opens that indicates the user-defined group that will be
created.

Archi ve Ma na ger for Excha nge Admi ni s tra ti on Gui de
Tool s , Opti ons a nd Setti ngs

61

6. Click Finish to start the group creation process. The Creating Object window opens. You can
click Back to revise your selection of mailboxes and groups.

7. When the import process has completed, click Close.
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Steps to verify the imported groups
1. Open the Address Book Manager
2. Click the Groups tab and verify that the imported Active Directory and user-defined groups
appear in the list view as expected. User-defined groups are highlighted in green .

3. Select a group and right-click to open the context menu. Click Properties. The Properties
window of the selected group appears.
4. Click the Members tab and verify that the list of mailboxes were imported as expected.

Synchronizing Address Book Manager
Synchronization with the Microsoft Exchange servers keeps groups and mailboxes up to date so
that emails can be archived without problems. With the Address Book Manager, you can set up
automatic synchronization schedules and initiate manual synchronization of various artifacts.
In this topic:
· Steps to perform a manual synchronization
· Steps to schedule automatic synchronization

Steps to perform a manual synchronization
1. Open Address Book Manager by clicking the toolbar icon
from the Tools menu.

or clicking Address Book Manager

2. The Synchronization tab opens by default.
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3. Select the Microsoft Exchange mailboxes, groups and permissions that you want to
synchronize.
4. In the Select servers box, select the Microsoft Exchange servers with which you want to
synchronize the mailboxes, groups and permissions.
5. Click Apply to confirm the settings.
6. Click Sync Now in the Microsoft Exchange Synchronization box to manually initiate the
synchronization of the mailboxes and groups with the selected Microsoft Exchange servers.

7. Click Stop to halt the synchronization process before it completes. When the process
completes, click the Close button that appears. You can find the results of the synchronization
process in a log file located at C:\Program Files (x86)
\Metalogix\MAM4Exchange\Log\Synchronization_<timestamp>.log
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8. Click Sync Now in the Microsoft Exchange Permissions Synchronization box to manually initiate
the synchronization of the mailboxes and groups with the selected Microsoft Exchange
servers.

9. Click Stop to halt the synchronization process before it completes. When the process
completes, click the Close button that appears. You can find the results of the synchronization
process in a log file located at C:\Program Files (x86)
\Metalogix\MAM4Exchange\Log\Synchronization_<timestamp>.log

Steps to schedule automatic synchronization
1. Open Address Book Manager by clicking the toolbar icon
from the Tools menu.

or clicking Address Book Manager

2. The Synchronization tab opens by default.
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3. Select the Microsoft Exchange mailboxes, groups and permissions that you want to
synchronize.
4. In the Select servers box, select the Microsoft Exchange servers with which you want to
synchronize the mailboxes, groups and permissions.
5. Click Schedule in the Exchange Synchronization box. The Exchange Synchronization Scheduler
dialog appears.
-orClick Schedule in the Exchange Permissions Synchronization box. The Exchange Permissions
Synchronization Scheduler dialog appears.

6. Select Use scheduled synchronization to activate the synchronization calendar. Each row
corresponds to a day of the week. Each column corresponds to an hour of the day (24-hour
clock).
7. To set up a schedule using the synchronization calendar, click the cell that corresponds to the
day of the week and the hour of day when you want the scheduler to initiate a
synchronization job. For example, in the figure above, the synchronization schedule is set to
start at 18:00 hrs (6 pm) every weekday. The time zone of the computer where the application
is running will be used to determine the time.
NOTE: If you select consecutive cells in a single row, synchronization will start
automatically every hour on the hour. It will consume unnecessary processing time and
not recommended.
8. Click OK to save the schedule or Cancel to discard the setup.
9. You can find the results of the scheduled synchronization process in a log file located at C:
\Program Files (x86)
\Metalogix\MAM4Exchange\Log\Synchronization_<timestamp>.log
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Managing Servers
The Address Book Manager provides all the necessary tools to manage Microsoft Exchange onpremise and online servers that are imported into the Address Book Manager.
In this topic:
· Managing the servers list view
· Managing Server Tasks
· Managing Server Properties

Managing the servers list view
The servers list view displays the on-premise and online servers that are imported into the
Address Book Manager.

Steps to view the servers list
1. Open Address Book Manager by clicking the toolbar icon
from the Tools menu.

or clicking Address Book Manager

2. Click the Servers tab. The servers list view appears with a default set of columns. You can add
or remove these columns.

3. The columns are as follows:
a. Server name - the name of the on-premise or online Microsoft Exchange server
b. Version - the version of the Microsoft Exchange application installed on the server.
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c. Access Method - How Metalogix Archive Manager for Exchange connects to the Microsoft
Exchange server. The two possible values are MAPI or EWS.
d. Username - the username that is used to access the server. The format for an onpremise
exchange server is <domain>\<username> and for an O365 sever it is the email address.
e. Included - Yes indicates that the server will be synchronized. No indicates that the server
will not be synchronized and is also highlighted in green
f. Configuration path - LDAP Uniform Resource Locator (URL) that defines the server location.
g. Deleted - No indicates the server is active in Address Book Manager. Yes indicates that the
server is logically deleted from the list of servers and is will not be used. Deleted servers
are highlighted in red
h. Server DN - legacy distinguished name (DN) of the Microsoft Exchange server.
i. Server Id - a unique serial number allocated to each server in Address Book Manager.
j. Modification Date - the most recent date when the server was synchronized.

Steps to add or remove server list columns
1. Right-click to open the context menu and click Add/Remove columns...

2. To add a column to the display:
a. Select the column from the Available columns list box.
b. Click Add to move the column to the Selected columns list box.
c. Use the Up and Down buttons to column the new column. The topmost column in the
Selected columns list box corresponds to the first column in the list view.
d. Click OK to close the dialog box and view the revised set of columns in the list view.
3. To remove a column from the list view:
a. Select the column from the Selected columns list box.
b. Click Remove to move the column to the Available columns list box.
c. Click OK to close the dialog box and view the revised set of columns in the list view.
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Steps to refresh the list view
1. Right-click to open the context menu and select Refresh. All servers in the list will be
refreshed.

Managing Server Tasks
The Servers section of the Address Book Manager provides a set of tasks to add, update, remove
and repair Microsoft Exchange servers. Each of these tasks are described below.

Adding a new on-premise or online Microsoft Exchange server
1. Right-click inside the list view and from the context menu point to Tasks and select Add
Server... to initiate the import process.

2. For detailed steps about importing on-premise servers see Steps to add on-premise Microsoft
Exchange servers.
3. For detailed steps about importing online servers see Steps to add online Microsoft Exchange
servers.

Updating Microsoft Exchange servers
1. Select a server from the server list view.
2. Right-click to open the context menu. Point to Tasks to open the sub-menu and select Update
Servers.
3. When the selected server is updated successfully, a confirmation message is displayed.
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NOTE: If the superuser is changed, you must update the servers so that the superuser
information is updated.

Removing Microsoft Exchange servers from the list
1. Select a server from the server list view that you want to remove.
2. Right-click to open the context menu. Point to Tasks to open the sub-menu and select Purge
Servers.

3. Click Yes to confirm that you want to remove the selected server from the Address Book
Manager. Click No to cancel the operation.

Repairing the MAPI profile
1. Select a server from the server list view that you want to remove.
2. Right-click to open the context menu. Point to Tasks to open the sub-menu and select Repair
MAPI Profile.

3. The MAPI profile will be updated.
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Managing Server Properties
Microsoft Exchange Servers can be either on-premise servers or online Office 365 servers. The
properties of each Microsoft Exchange server added to the Address Book Manager can be
managed through the Properties dialog box. They are grouped by tabs and each property group is
explained in detail below.
For on-premise servers:
· General properties
· EWS properties
· MAPI properties
· Advanced properties

For online Office 365 servers:
· General properties
· O365 properties
· Steps to add additional service accounts

4For on-premise servers
General properties
1. Select an on-premise server from the server list.
2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected server appears and the General tab is displayed by default.
3. Click the General tab if not already selected.
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4. This section provides generic information about the server. The properties are as follows:
a. Server name - Read-only. The name of the on-premise or online Microsoft Exchange
server.
b. Version - Read-only. The version of the Microsoft Exchange application installed on the
server.
c. Access Method - Choose how Metalogix Archive Manager for Exchange connects to the
Microsoft Exchange server. The two access methods available are MAPI or EWS.

d. Include this server in synchronization - When this check box is checked, the server is
included in the synchronization process. When this check box is unchecked, the server will
not be synchronized and appears in the list view highlighted in green
5. Click OK to save changes and close the dialog. Click Cancel to reject any changes and close the
dialog.

EWS properties
1. Select an on-premise server from the server list.
2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected server appears.
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3. Click the EWS tab.

The properties are as follows:
a. EWS Url - https://<Microsoft-Exchange-server-IP-Address-or-Name>/EWS/Microsoft
Exchange.asmx
b. EWS Administrator - user name of an EWS administrator who must have impersonation
permissions. This is usually the super-user.
c. Password - password of the EWS Administrator.
d. Domain - domain of the given user.
4. Click OK to save changes and close the dialog. Click Cancel to reject any changes and close the
dialog.
NOTE: EWS Limitations
1. EWS does not support the RTF format for email messages.
RTF messages are converted to HTML when messages are archived and retrieved.
If HTML messages are saved as .MSG files in Unicode format, Outlook will remove
embedded images and use the RTF format to display the message. As a result, images
are available as attachments and not embedded in the body.
2. Shortcuts are not created for several message types
The message types listed below are not replaced with a shortcut when the messages
are archived. A copy of the original message is stored in the archive and retrieved when
needed.
· IPM.Post
· IPM.Schedule.Meeting.Request
· IPM.Schedule.Meeting.Canceled
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· IPM.Schedule.Meeting.Resp.Pos
· IPM.Schedule.Meeting.Resp.Tent
· IPM.Schedule.Meeting.Resp.Neg

3. Voting summary cannot be retrieved for archived voting responses
Emails can be created in Outlook using the Voting option that allows respondents to
cast a vote. If the original email message that contains the voting poll is archived and
retrieved with EWS, the poll results are not available through the sent items message
Tracking. If the response emails from votes are archived and retrieved, the voting poll
summary is not available when you click the View voting response info button.

MAPI properties
1. Select an on-premise server from the server list.
2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected server appears.
3. Click the MAPI tab.

The properties in this section are as follows:
a. SMTP address - email address of the superuser that is automatically imported from the
Exchange server settings.
b. User name - user name of the superuser for MAPI communication.
c. Password - password of the superuser for MAPI communication.
d. Connect to Microsoft Exchange using HTTP - If selected, the Exchange server connection
will use the HTTP protocol.
e. Proxy server URL - Address of the proxy server if applicable.
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f. Connect using SSL only - If selected, the connection will be encrypted using SSL.
g. Only connect to proxy servers that have this principal name in their certificate - specify the
Certificate Principal Name to connect to proxy servers if certificate mapping is used in the
Active Directory.
h. Proxy authentication settings - authentication protocol for the proxy server if a proxy
server is used.
5. Click OK to save changes and close the dialog. Click Cancel to reject any changes and close the
dialog.

Advanced properties
This section displays properties that define the configuration path and server distinguished name
1. Select an on-premise server from the server list.
2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected server appears.
3. Click the Advanced tab.

4. Click Update now to refresh server property values.
5. Click the Show button to display more information about the Microsoft Exchange server.
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6. Click Close to close the dialog.

4For on-line Office 365 servers
General properties
1. Select an on-line server from the server list.
2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected server appears and the General tab is displayed by default.
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3. Click the General tab if not already selected.

4. This section provides generic information about the server. The properties are as follows:
a. Server name - Read-only. The name of the on-premise or online Microsoft Exchange
server.
b. Version - Read-only. The version of the Microsoft Exchange application installed on the
server.
c. Access Method - Choose how Metalogix Archive Manager for Exchange connects to the
Microsoft Exchange server. The two possible values are MAPI or EWS. If access method is
EWS, all RTF messages will be converted to HTML when messages are archived.
d. Include this server in synchronization - When this check box is checked, the server is
included in the synchronization process. When this check box is unchecked, the server will
not be synchronized and appears in the list view highlighted in green
5. Click OK to save changes and close the dialog. Click Cancel to reject any changes and close the
dialog.

O365 properties
This section displays properties that define the server name and service accounts.
1. Select an online server from the server list.
2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected server appears.
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3. Click the O365 tab.

4. The properties in this section are as follows:
a. Organization Name in Office 365 - name of the imported online Exchange server.
b. Service Accounts - list of user names authorized to archive emails from the O365 server.

Steps to add additional service accounts
1. From the O365 tab of any online server Properties dialog, click Add. The Service account wizard
opens.
2. Enter the service account properties as described below:

The properties are as follows:
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a. User logon name - O365 user name.
b. Password - password of the O365 user account.
c. Confirm password - re-enter the password entered in the Password field.
d. Set Exchange server permissions for service account - select the check box to grant
elevated rights to the service account on the selected O365 Exchange Server.
e. Set Public Folder permissions for service account - select the check box to grant OWNER
permission to the Public folders.
3. Click Import to add the new service account to O365 service Accounts list.

4. Click OK to save changes and close the dialog. Click Cancel to reject any changes and close the
dialog.
NOTES:
1. The default service account is indicated in bold. To change the default service account,
select another user account and click Set as default. The selected user account will change to
a bold font.
2. To edit a service account, select an account and click Edit and make changes as needed.
3. To remove a service account, select an account that is not the default service account.
Click Remove to delete the account from the Service accounts list. Then click Yes in the
Confirmation dialog. You cannot remove a default service account. You must first set another
service account as a default if you want to remove the account.
4. Any user who has multi-factor authentication activated on Office 365 cannot be added as a
service account.
5. A user account with basic authentication deactivated on Office 365 cannot be used as a
superuser with the MAPI access method.
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Managing Groups
The Address Book Manager provides all the necessary tools to manage groups that are imported
from Microsoft Exchange servers or created by the administrator.
In this topic:
· Managing the Groups list view
· Managing Group Tasks
· Managing Group Properties
· Adding members to a user-defined group
· Removing members from a user-defined group

Managing the groups list view
The groups list view displays the groups that are imported from Microsoft Exchange servers or
created by the administrator.

Steps to view the groups list
1. Open Address Book Manager by clicking the toolbar icon
from the Tools menu.

or clicking Address Book Manager

2. Click the Groups tab. The groups list view appears with a default set of columns. You can add
or remove columns. User-defined groups are highlighted in green .

3. The columns are as follows:
a. RDN - Distinguished name of the recipient.

Archi ve Ma na ger for Excha nge Admi ni s tra ti on Gui de
Tool s , Opti ons a nd Setti ngs

80

b. Display Name - Display name of the recipient.
c. Alias - Alias of the recipient.
d. Email Address - Email address of the recipient.
e. Group Type - indicates the source of the group. Valid value are auto if the group was
imported from an on-Premise Exchange server, and manual if the group was created
manually.
f. Domain Name - the domain where the group belongs.
g. GUID - Unique identifier of this mailbox in the Microsoft Exchange server.
h. LDAP Path - Active Directory specification of the mailbox recipient.
i. Deleted - Yes indicates the mailbox is deleted. No indicates the mailbox is active.
j. Creation Date - the date when the mailbox was imported into Address Book Manager.
k. Deleted Date - the date when a mailbox update fails to find the Active Directory object
specified by the LDAP path, and the mailbox is marked as deleted by the system.
l. Modification Date - the most recent date when the mailbox was modified.
m. Reference Update - if the value is Yes, then only mailbox members without subgroups
should be imported during the next synchronization.
n. Auto create groups - if the value is Yes, then existing subgroups of the corresponding
group including its member mailboxes should be imported during the next
synchronization.
o. Auto create mailboxes - if the value is Yes, then the root group should be imported along
with its root mailbox members only during the next synchronization. No subgroups or
subgroup members will be imported.
p. GID - a unique serial number allocated to each group in Address Book Manager.

Steps to add or remove groups list columns
1. Right-click to open the context menu and click Add/Remove columns...
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2. To add a column to the display:
a. Select the column from the Available columns list box.
b. Click Add to move the column to the Selected columns list box.
c. Use the Up and Down buttons to column the new column. The topmost column in the
Selected columns list box corresponds to the first column in the list view.
d. Click OK to close the dialog box and view the revised set of columns in the list view.
3. To remove a column from the list view:
a. Select the column from the Selected columns list box.
b. Click Remove to move the column to the Available columns list box.
c. Click OK to close the dialog box and view the revised set of columns in the list view.

Steps to refresh the list view
1. Right-click to open the context menu and select Refresh. All groups in the list will be
refreshed.

Managing Group Tasks
The Groups section of the Address Book Manager provides a set of tasks to add and remove
groups. Each of these tasks are described below.

Adding groups
1. Right-click inside the list view and from the context menu point to Tasks and select Add group
wizard... to initiate the import process.
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2. For detailed steps about importing on-premise groups see Steps to import groups from onpremise Microsoft Exchange servers.
3. For detailed steps about importing online groups see Steps to add groups from online
Microsoft Exchange servers.
4. For detailed steps to create user-defined groups see Steps to create user-defined groups.

Managing Group Properties
The properties of each group added to the Address Book Manager can be managed through the
Properties dialog box. They are grouped by tabs and each property group is explained in detail
below.

General properties
1. Select a group from the groups list.
2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected group appears and the General tab is displayed by default.

3. The properties in this section are read-only. Their descriptions are as follows:
a. Name - Name of the group.
b. Display Name - Display name of the recipient.
c. Alias - Alias of the recipient.
d. Email - the email of the group if applicable, otherwise it is blank.
e. Folder - Distinguished name of the group in the Active Directory.
f. GUID - Unique identifier of this group in the Microsoft Exchange server.
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Member Of
1. Select a group from the groups list.
2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected group appears.
3. Click the Member Of tab. If the selected group is a sub-group of other parent groups, a list of
the parent groups appears in the Member of list box.

4. To view the properties of a parent group, right click on a selected group and click Properties.
The Properties dialog of the group appears.

Members
1. Select a group from the groups list.
2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected group appears.
3. Click the Members tab. If the selected group has mailboxes or other groups, they appear in
the List of Members list box.
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4. To view the properties of a mailbox or member group, right click on a selected mailbox or
group and click Properties. The Properties dialog of the mailbox or group appears.

Advanced
1. Select a group from the groups list.
2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected group appears.
3. Click the Advanced tab.

Automatic Updates
These settings will be applied when the group is updated manually or synchronized in future
with the Microsoft Exchange server automatically. The properties in this section are as
follows.
a. Automatically import mailbox members - check this box to import all Active Directory
accounts with a mailbox that are members of this group.
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b. Advanced import settings - check this box if you intend to import subgroups and subgroup
mailbox members. You can activate this setting only if you select the Automatically import
mailbox members setting.
c. Import subgroups along with members - check this box to import existing subgroups of the
selected group including its member mailboxes. This is the default setting.
d. Import only mailbox members without subgroups - check this box to import only member
mailboxes from subgroups. These mailboxes will be added to mailboxes in the parent
group in the Address Book Manager.
Click Update Now if you want to synchronize the group with the Microsoft Exchange server.
Extra
a. User defined group - read only property. When checked, it indicates that this group was
created manually and not imported from a Microsoft Exchange server.
b. Deactivate all group members - check this box to deactivate mailboxes of users in the
group. Members in sub-groups will not be deactivated. This check box is not available for
user-defined groups that are created in the Address Book Manager. When a group member
is deactivated the following rules apply:
· Archive Manager will deactivate the user's mailbox even though the user is a member of

another group where the member is still active.
· Archive Manager will temporarily activate a user's mailbox if the user is a member of two

or more groups where the member was deactivated and the member is subsequently
activated in any one of those groups.
· Archive Manager will deactivate a user's mailbox when mailboxes are synchronized if the

user is a deactivated member of any group.
This property is used when users registered with an Archive Server in one location needs
access permissions to archived content of users registered with an Archive Server in
another location. Consider an example where Susan Bennet in location 1 needs access to
archived content of a large number of users in location 2. As a global administrator you
would create a group in the Active Directory and add the users from location 2 to this group.
Then you would import this group to the Address Book Manager in location 1. You can now
grant permissions to Susan Bennet with the Mailbox Rights Manager to access the archived
content of the group members from location 2. However, you must deactivate these group
members by selecting the Deactivate all group members check box so that the primary
archive server for these members remains as location 2.
Associated Active Directory Object
a. Click the Show button to display more information about the group from the Microsoft
Exchange server.
NOTE: The Show Active Directory object and the Show button are not available for a userdefined group.
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4. Click OK to save any changes. Click Cancel to discard any changes and close the properties
dialog.

Adding members to a user-defined group
1. Select a user-defined group from the groups list. User-defined groups are highlighted in green
.
2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected group appears.
3. Click the Members tab. If the selected group has mailboxes or other groups, they appear in
the List of Members list box.

4. Click Add. The Select Mailbox dialog appears.
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5. Select one or more groups or mailboxes. You can hold down the Ctrl or Shift keys to select
multiple mailboxes and groups.
6. Click
to add the selected groups or mailboxes to the Selected objects list box. Conversely,
you can select groups or mailboxes from the Selected objects list box and click
to remove
the selected groups or mailboxes from the Selected objects list box.
7. Click OK to add the selected members to the group or click Cancel to discard the changes.

Removing members from a user-defined group
1. Select a user-defined group from the groups list. User-defined groups are highlighted in green
.
2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected group appears.
3. Click the Members tab. If the selected group has mailboxes or other groups, they appear in
the List of Members list box.
4. Select one or more members to remove. You can hold down the Ctrl or Shift keys to select
multiple members.
5. Click Remove. A confirmation dialog appears.
6. Click Yes in the confirmation dialog to remove the member. Click No to retain the member.

Managing Mailboxes
The Address Book Manager provides all the necessary tools to manage Microsoft Exchange onpremise and online mailboxes that are imported into the Address Book Manager.
In this topic:
· Managing the Mailboxes list view
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· Managing Mailbox Tasks
· Managing Mailbox Properties
· Managing Mailbox Permissions

Managing the Mailboxes list view
The servers list view displays the on-premise and online servers that are imported into the
Address Book Manager.
NOTE: In the mailboxes list there are mailboxes with names like public_<name-of-MicrosoftExchange-server>. These mailboxes are the public folder from the respective Microsoft
Exchange server because Address Book Manager considers a public folders as a profile. These
mailboxes are always highlighted in blue , so you can distinguish them faster. Some
features accessible for mailboxes are not applicable for these folders.
Mailboxes which are deactivated are highlighted in light blue

.

Steps to view the servers list
1. Open Address Book Manager by clicking the toolbar icon
from the Tools menu.

or clicking Address Book Manager

2. Click the Mailboxes tab. The mailbox list view appears with a default set of columns. You can
add or remove these columns.

3. The columns are as follows:
a. RDN - Distinguished name of the recipient.
b. Display Name - Display name of the recipient.
c. Alias - Alias of the recipient.
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d. Email Address - Email address of the recipient.
e. Home Server - Name of the Microsoft Exchange server that contains the mailbox.
f. GUID - Unique identifier of this mailbox in the Microsoft Exchange server.
g. LDAP Path - Active Directory specification of the mailbox recipient.
h. Logon Name - User name used to access the mailbox
i. Deleted - Yes indicates the mailbox is deleted. No indicates the mailbox is active.
j. Creation Date - the date when the mailbox was imported into Address Book Manager.
k. Deleted Date - the date when a mailbox update fails to find the Active Directory object
specified by the LDAP path, and the mailbox is marked as deleted by the system.
l. Modification Date - the most recent date when the mailbox was modified.
m. Mailbox DN - Distinguished name of the mailbox.
n. Mailbox Limit - Maximum number of emails that the mailbox can receive.
o. Locked - Most recent date when the mailbox was locked.
p. Activated - Most recent date when the mailbox was activated.
q. Mailbox Type - Indicates the type of the mailbox. Possible values are Normal or Journal.
r. MBXID - a unique serial number allocated to each mailbox in Address Book Manager.
s. Legal Hold - Yes indicates there is a litigation hold on the mailbox, and modifications to
archived emails are not permitted. No indicates there is no litigation hold.
t. Addresses - Collection of email aliases of the recipient.

Steps to add or remove mailbox list columns
1. Right-click to open the context menu and click Add/Remove columns...

2. To add a column to the display:
a. Select the column from the Available columns list box.
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b. Click Add to move the column to the Selected columns list box.
c. Use the Up and Down buttons to position the new column. The topmost column in the
Selected columns list box corresponds to the first column in the list view.
d. Click OK to close the dialog box and view the revised set of columns in the list view.
3. To remove a column from the list view:
a. Select the column from the Selected columns list box.
b. Click Remove to move the column to the Available columns list box.
c. Click OK to close the dialog box and view the revised set of columns in the list view.

Steps to refresh the list view
1. Right-click to open the context menu and select Refresh List.

Managing Mailbox Tasks
The Mailboxes section of the Address Book Manager provides a set of tasks to import, activate,
deactivate, migrate, remove, synchronize and update mailboxes. Each of these tasks are
described below.

Importing mailboxes
1. Right-click inside the list view and from the context menu point to Tasks and select Import
mailbox wizard... to initiate the import process.

2. For detailed steps about importing on-premise servers see Steps to import mailboxes from
on-premise Microsoft Exchange servers.
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3. For detailed steps about importing online servers see Steps to import mailboxes from online
Microsoft Exchange servers.

Activating a mailbox
1. Select a mailbox from the mailboxes list view that was previously deactivated and appear
highlighted in light blue .
2. Right-click to open the context menu. Point to Tasks to open the sub-menu and select Activate
mailbox.
3. The mailbox is activated, and it is no longer highlighted.

Deactivating a mailbox
1. Select a mailbox from the mailboxes list view that is not highlighted in any color.
2. Right-click to open the context menu. Point to Tasks to open the sub-menu and select
Deactivate mailbox.
3. The mailbox is deactivated and appears in the list view with a different icon and is highlighted
in light blue
NOTE: Deactivated mailboxes cannot be archived or restored.

Migrating a mailbox
1. Select a mailbox from the mailboxes list view.
2. Right-click to open the context menu. Point to Tasks to open the sub-menu and select Migrate
mailbox.

3. Click Search to return the list of all mailboxes that are not in Address Book Manager but are
available in the Microsoft Exchange servers. To reduce the list of mailboxes, you can specify a
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search term in the Look for Name search box. Only the initial letters of the mailbox Display
Name can be specified, and wildcards are not supported. The search term is case-insensitive.
4. Select the target mailbox from the result set.
5. Click Select. A confirmation dialog appears.
6. Click Yes to continue. The source mailbox will be merged with the target mailbox and
removed from Address Book Manager. The target mailbox will be imported into Address Book
Manager, and all the archived emails that belonged to the source mailbox will now belong to
the imported mailbox. You can click No to cancel the migration.

Removing a mailbox
1. Select a mailbox from the mailboxes list view.
2. Right-click to open the context menu. Point to Tasks to open the sub-menu and select Purge
mailbox.
3. The mailbox is removed from the Address Book Manager.
NOTE: You cannot remove a mailbox if it contains at least one email that has been archived.
Mailboxes that are highlighted in blue cannot be removed.

Synchronizing mailbox permissions
1. Select a mailbox from the mailboxes list view.
2. Right-click to open the context menu. Point to Tasks to open the sub-menu and select
Synchronize mailbox folder permissions.
3. The mailbox folders will be synchronized, and a confirmation dialog appears that indicates the
number of folders that were successfully synchronized and the number of folders that could
not be synchronized.
NOTE: Mailboxes that are highlighted in blue

cannot be synchronized.

Updating a mailbox
1. Select a server from the server list view.
2. Right-click to open the context menu. Point to Tasks to open the sub-menu and select Update
mailbox.
3. When the selected mailbox is updated successfully, a confirmation message is displayed.

Managing Mailbox Properties
The properties of each mailbox added to the Address Book Manager can be managed through the
Properties dialog box. They are grouped by tabs and each property group is explained in detail
below.
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General properties
1. Select a mailbox from the mailboxes list.
2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected mailbox appears and the General tab is displayed by default.

3. The properties in this section are as follows:
a. RDN - Distinguished name of the recipient.
b. Display Name - Display name of the recipient.
c. Alias - Alias of the recipient.
d. Email Address - Email address of the recipient.
e. Home Server - Name of the Microsoft Exchange server that contains the mailbox. You can
click the drop down and select another Exchange Server as the Home Server. For example,
if the user's mailbox is migrated from an on-premise Exchange server to an online Office
365 Exchange server, you can change the Home Server to the Office 365 server only if the
server was imported into the Address Book Manager. When you change the Home Server,
you must synchronize the Address Book Manager. For more information see Synchronizing
Address Book Manager.
f. Addresses - Collection of email aliases of the recipient.
g. Mailbox DN - Distinguished name of the mailbox.
h. GUID - Unique identifier of this mailbox in the Microsoft Exchange server.
i. Mailbox is activated - When checked the mailbox is fully operation. Uncheck this check box
to deactivate the mailbox. The mailbox can also be deactivated by selecting Deactivate
mailbox from the mailbox context menu Tasks.
j. Mailbox is on legal hold - When checked, the mailbox is on litigation hold and
modifications to archived emails are not permitted. When unchecked, the mailbox is not
on legal hold.
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k. Mailbox type - The type of mailbox. Valid values are Normal and Journal.
4. Click OK to save any changes. Click Cancel to discard any changes and close the properties
dialog.

Member Of
1. Select a mailbox from the mailboxes list.
2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected mailbox appears.
3. Click the Member Of tab. A list of groups appears in the Member of list box.

4. To view the properties of a group, right click on a selected group and click Properties. The
Properties dialog of the group appears.
5. Click OK to save any changes. Click Cancel to discard any changes and close the properties
dialog.

Other properties
1. Select a mailbox from the mailboxes list.
2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected mailbox appears.
3. Click the Others tab.
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4. The properties in this section are as follows:
a. Lock this mailbox - When checked, the mailbox is set to read-only and the mailbox cannot
not be updated or synchronized.
b. Creation date - the date when the mailbox was imported into Address Book Manager.
c. Modification date - the most recent date when the mailbox was modified
d. Mailbox is deleted - if the check box is checked, the mailbox is marked as deleted. When
you click Apply or OK, the Deleted Date field will indicate the current date and the mailbox
is indicated with the icon. A mailbox can also be marked as deleted by the system when
a mailbox update cannot find the Active Directory object specified by the LDAP path but
emails in the mailbox were previously archived. When a mailbox update cannot find the
Active Directory object specified by the LDAP path and there were no emails that were
archived for this mailbox, the mailbox will be permanently deleted from the Address
Book.
e. Deleted date - the date when the system marks the mailbox as deleted.
f. Mailbox size - size of the mailbox including all its folders as defined in the Microsoft
Exchange server.
g. Limit defined on mailbox level - the limit (in KB) set on the mailbox in the Microsoft
Exchange server.
h. Limit defined on store level - the storage limit (in KB) set on the mailbox in the Microsoft
Exchange server. The Limit defined on mailbox level has a higher priority.
5. Click OK to save any changes. Click Cancel to discard any changes and close the properties
dialog.

Advanced properties
1. Select a mailbox from the mailboxes list.
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2. Right-click to open the context menu and click Properties. The Properties dialog for the
selected mailbox appears.
3. Click the Advanced tab.

4. The properties in this section are as follows:
a. Show object properties - Click the Show button to display more information about the
mailbox from the Microsoft Exchange server

b. Container - displays the distinguished name of the LDAP container. Click Update now to
update the mailbox properties immediately.
c. Get mailbox and archive statistics - Click Stats to open the Mailbox statistics window where
you can check the number of archived or deleted messages in the mailbox folders
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d. Show mailbox permissions - Click Permissions to manage the mailbox permission rights.
The same settings are accessible also from Tools > Mailbox Rights Manager. For detailed
information see the section Mailbox Rights Manager.
5. Click OK to save any changes. Click Cancel to discard any changes and close the properties
dialog.

Managing Mailbox Permissions
For detailed information about managing permissions for a mailbox, see Mailbox Rights Manager.

Options
AMAC preferences set through Options and Settings apply if no specific archive settings are
selected. There are many preferences which you may configure to your needs. They include, for
instance, compressing of emails and their attachments, setting up the default retention category
depending on e.g. legal requirements, activating direct archiving, managing roles for different
users etc. Settings having been specified under Tools > Options and Tools > Settings are used as
the default for manual as well as automated archiving.

Tools/Options
Run Archive Manager for Exchange (click Start/Programs/Metalogix/Archive Manager for
Exchange). In the Archive Manager for Exchange click on the Tools menu, and then click on
Options to open the Options window. Here, on different tabs you may set your AMAC
preferences.

Server settings
Server role tab
Archive Manager for Exchange is a product of high scalability and users can decide for various LAN
solutions. Besides the simplest solution with one Archive Manager server, more complex
configurations are possible, e.g.
· ONE archive server (server assigned Archive server role)
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· retrieve server(s) (server(s) assigned Retrieve server role) and/or
· PST import server(s)

All in ONE Location, i.e. Location ID of all servers is "1”.
NOTE: In case of large organizations scattered around the globe, Archive Manager for
Exchange provides you with the possibility to configure several Locations, i.e. several
Archive Manager Archive servers distinguished by a unique identifier – the LocationID. (For
more information on Locations and LAN configurations see the "Full Install Guide for Archive
Manager”.)

Recommendation
· When more than 1000 mailboxes are being archived, we recommend dedicating a separate

machine as Archive Manager Retrieve server besides the Archive Manager Archive server
· Maximum 3000 mailboxes can be archived with one Archive Manager Archive server. For more

mailboxes it is necessary to install another Archive Manager Archive server, i.e. to create a new
location with a new location number
As you can see each server has its role in the environment. This server role has to be assigned to
the server on this tab in the Server role down-drop box. Possible server roles are:
· Archive server (only 1 Archive server per location is allowed)
· Retrieve server
· PST Import server

After you have assigned roles to your servers it is necessary to register them on the Locations tab
of the Archive Manager for Exchange (see the section "Locations tab”).

IMPORTANT: If there is only 1 Archive Manager for Exchange server in the environment, it
has to be assigned ARCHIVE SERVER role.
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Auditing tab
If Auditing feature was installed, you need to activate it on this tab. To activate auditing, check
Activate Auditing check box. In the Server Name enter the name of the machine where the
Auditing feature is installed and specify the Server Port (the default port is 7783). Click Apply.
NOTE: For more information on Auditing see the Auditing manual.

Archive settings
Compression tab
On this tab you may specify your compression criteria. Compressing is then done "on the fly”.

To specify compression criteria:
1. On the Tools menu, click Options.
2. In the Options window, click on the Archive settings tab.
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3. To compress .MSG files, simply select the Compress .MSG check box. To compress
attachments, select the Compress attachments check box. If you have decided to compress
attachments, yet wish to exclude some types of attachments from compression, you can
specify that in the Excluded extensions text box – the respective attachments will not be
compressed (such as .zip files etc). Simply enter the respective extension in the text box and
click Add. Do not forget to finish by clicking OK.
NOTE: When specifying Excluded extensions you can use the following wild card *
which stands for any number of characters and ? stands for any single character

Retention tab
For legal reasons some emails must remain retrievable for many years. Our email archiving
solution uses the Hierarchical Storage Management system (HSM). HSM offers the possibility to
organize documents in a logical way, e.g. some documents need to be stored for a longer period
than the others. In the HSM system you may define different retention categories for each type
of document (for example, one retention category for short-term documents and other retention
category for long-term documents).
On this tab you may choose which retention category should be used as default for archiving
items if no specific retention category is chosen. It usually applies for manual archiving using
Archive Manager Client Addin.
However, every group or user can have its own default retention category assigned. This can be
done on the Manager view/Settings/Group level retention tab (see the section Group level
retention in the Settings tab chapter). Retention category set as default on this tab applies also to
AMAC preferences on the aforementioned tab – and vice versa.
NOTE: If you are running Archive Manager for Exchange for the first time, just one
retention category is available. It is the default retention category created by the setup.
Otherwise you can choose from all retention categories from the previous settings and you
can also create your own on the Retention tab of the Manager view.
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For more information regarding retention categories see the topic Retention tab.
You may still archive email items under different retention categories (not the default one). That
can be specified through jobs, since for each job you may assign either a desired retention
category or the default one. This topic will be described later in the "Jobs tab” section of the
"Manager view” chapter. Moreover, it is possible to choose the desired retention categories for
an individual item when it is archived manually in the Archive Manager for Exchange (see the
"Archive view” chapter).

Shortcut tab
Here you can set the layout of archived emails’ shortcuts, i.e. you can set how the archived emails
will be displayed in the Outlook preview pane. The layout and the type of shortcut are defined
through templates. The template specified on this tab will be used in cases when no other
shortcut template settings apply.
NOTE: Shortcut templates can be created under Manager view/Settings/Shortcut
templates. Then they can be assigned to different users or groups under Manager
view/Settings/Shortcut template assignment.
In the Default shortcut template drop down box select a shortcut template from the available
ones. Then click Apply.
Default shortcut template can be set also under Manager view/Settings/Shortcut template
assignment. If the default shortcut template is changed there it is changed also on this tab and
vice-versa.
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Links tab
If you plan to use attachment links in shortcuts (either Create links for attachments or Generate
an HTML shortcut from template option from the previous tab) you need to configure the link
generator server on this tab.
In the Alias for attachment link URL enter the alias of your Archive Manager Archive server - the
link generator server name. The ALIAS of your Archive Manager server can be accessed both from
inside and outside the LAN.
NOTE: We recommend creating an ALIAS (DNS alias) for the Archive Manager Archive
server. It will serve as a virtual name and changing the physical name of the Archive server
will not affect the attachment links.
If the https channel will be used, check the use SSL check box.
After modifying these settings click Apply. Then click Yes to restart the relevant service.
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Advanced tab
This tab offers additional archive settings:
Activate archiving of unread messages - clear the check box if you do not want to archive unread
emails.
Activate archiving of pending appointments and tasks - clear the check box if you do not want to
archive unfinished appointments and/or tasks.
Mark restored messages as Read - select the check box if you want to mark restored emails as
Read.

Message Classes
Supported Classes tab
Microsoft Exchange stores emails and other objects in its database. We are referring to these
objects as items. Each item has its own message class, which defines the type of the item:
message, post, appointment, etc. Since the handling of these items is different, different
shortcuts are created for each item type. By default only some message classes are archived
(IPM.Note, IPM.Post, IPM.Document etc.). Additional item types to be archived can be defined
on this tab.
Message Class

Description

IPM.Note

message

IPM.Post

message posted to a folder

IPM.Fax

a fax message
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IPM.Document

a file added to the folder (the base class never
appears, it always contains the file type, e.g.
IPM.Note.Document.Word.8)

IPM.Appointment

calendar item; a recurring calendar item

IPM.Task

an Outlook task

IPM.Contact

an Outlook contact

IPM.Activity

an Outlook journal message

IPM.StickyNote

an Outlook sticky note

REPORT.IPM.Schedule.Meeting.Request

a meeting request

For a complete list of message classes, please refer to:
http://msdn.microsoft.com/en-us/library/aa204771.aspx
The following message classes and its subclasses are supported message classes by default, i.e.
they can be archived by Archive Manager for Exchange:
· IPM.Note,
· IPM.Post,
· IPM.Document,
· IPM.Fax
· IPM.Appointment
· IPM.Task
· IPM.Contact

NOTE: Make sure they are not deactivated on the Deactivated Classes tab, if you want to
archive them.
Archiving of calendar items (IPM.Appointment), contact items (IPM.Contact) and task items
(IPM.Task) is supported with some limitations. When a shortcut is created from such item, it
becomes read-only which prevents further modification of the item. It can only be modified by
Archive Manager Outlook Addin. If these items change constantly, we recommend archiving
these items with "Keep the original email” or "Delay shortcut creation” option (see "Retention
tab” part of the manual). Please note that recurring appointments and tasks are not archived.
If appointments are planned to be archived, it is a good idea to deactivate archiving of
appointments which are not finished. It can be set on the Tools/Options/Archive
settings/Advanced tab (Deactivate not finished appointment and task archivation option).
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In addition to the default supported message classes you can define additional message classes
which should be archived:
1. On the Tools menu click on Options.
2. In the Options window, click on the Message Classes tab.
3. Click the Add button to open the message classes list. Select one or more message classes
which you want to archive. You can also specify different message class in the text box below
the list.
By default there is no need to fill in the Shortcut message class based on field. Leave this field
blank or choose one option from the down-drop list. In this way you will define which type of
shortcut will be created when the selected message class is archived. Please note that
specifying of a new shortcut message class can have undesired effects. To get more
information about this option, contact our support.

4. Then click OK.

5. Then click Apply.
6. A message box appears that informs you that you have to restart MamExHandler service
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Deactivated classes tab
Classes which you specify on this tab will not be archived. You can either check the desired
message class(es) or click the Add button to choose from the list of additional message classes.
You can also specify different message class in the text box below the list. When you have chosen
the desired message classes in the list, click OK, then click Apply on the Deactivated Classes tab.
NOTE: If a message class is specified on the Supported Classes tab as well as on the
Deactivated Classes tab, it will NOT be archived.

User Roles
As default, only the super-user, which was specified during the Archive Manager for Exchange
installation, has log on permissions to Archive Manager for Exchange. On this tab you can add
other users which will be allowed to log on to the Archive Manager for Exchange server.

To add a new on-premise Exchange user:
1. Click the Add User icon or right-click inside the User Roles tab and select Add from the context
menu. To add an Office 365 user, click the Add Office 365 user icon.
2. In the Search Active Directory pop-up dialog click Find. Locate the desired user in the list and
click Select.
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3. The user will be displayed on the User Roles tab.

To grant log on permissions to a user:
1. Select the user.

2. Select the check box under the Allow column to grant the following permissions, or select the
check box under the Deny column to deny the following permissions:
a. Logon - user will be able to logon to the Archive Manager for Exchange and manage Archive
Manager
b. Logon to PST Importer – user will be able to launch PST Importer
c. Modify roles – user will be able to manage user roles on this tab
d. Access mailbox browser – user will have access to archiving/restoring, i.e. the user will be
able to enter the Archive view
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e. Modify mailbox permission – user will be able to modify permissions in Mailbox Rights
Manager.
NOTE: If neither Allow nor Deny is checked, the role is denied.

Settings
In addition to AMAC preferences specified under the Tools/Options as described above there are
more AMAC preferences available under Tools/Settings. AMAC preferences apply if no specific
archive settings are selected.
Run Archive Manager for Exchange (click Start/Programs/Metalogix/Archive Manager for
Exchange). In the Archive Manager for Exchange window click on the Tools menu, and then click
on Settings to open the Settings window.

Archive/Restore tab
On this tab you may choose to re-archive delayed or backup shortcuts

Usually, when archived with Archive Manager, emails are replaced with shortcuts on the
Microsoft Exchange Server. In some cases you may have decided to archive the emails and at the
same time not to create shortcuts for them or delay the shortcut creation (this is done via
retention categories, see the section Retention categories and their usage ). In such cases the
emails are copied to archive and remain unchanged also in Microsoft Exchange Server (no
shortcuts are created). In specific cases you may want to re-archive such items to save any
possible modifications made after archiving. Should you wish to re-archive these items (possible
only manually), it is necessary to allow it:
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Allow re-archiving of delayed shortcuts is checked – it will be possible to manually re-archive
emails which have been already archived via retention category with "Delay shortcut creation”
settings.
Allow re-archiving of backup shortcuts is checked – it will be possible to manually re-archive
items which have been already archived via retention category with "Keep original email”
settings.
NOTE: Both above mentioned options are only valid while the Archive Manager for Exchange
is running. When the application is restarted, these options are reset. This function is
supported only with MAPI.

Visualization tab
If you select Auto in the Size units when displayed or Size units when set dropdown menus, then
the size of the files will be displayed correspondingly: in B, KB, or in MB.
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Others tab
The following AMAC preferences can be managed from this tab:

Special
Service status refresh rate - The default is 10 seconds. This means that every 10 seconds the
status of the services will be checked and the list of services displayed in the Status view will be
refreshed.
Mailbox access timeout - The default is 120 seconds. Timeout value for all open mailboxes across
the application.

Export/Import
CSV column delimiter - The column delimiter can be set to a comma (,) or to a semicolon (;) for all
export or import processes. You should check your MS Office settings first, and then set it
accordingly.

Paging
Paging activates a faster response time when loading large sets of items in the Mailboxes,
Archives, Public Folders and Public Folders Archive lists. You can set how many items can be
displayed on one page.
Activate paging - select this check box to activate paging.
Items per page - the number of items that are displayed in each set or page. The default value is
1000.
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When paging is activated, the current page is displayed in the Page field at the bottom of the list.
The administrator can navigate the pages in one of two ways: by entering a specific page in the
Page field or by clicking the First, Prev (previous), Next or Last buttons to sequentially iterate
through the pages.
Consider the scenario where each mailbox has over 50,000 emails items. Listing all the emails at
once would require a significant amount of time. With paging activated, only a part of the list is
displayed with navigation aids at the bottom of the list. When the administrator navigates
through the pages, only a subset of the list is displayed and the time required to display the
subset is greatly reduced.
If the average set of email items per user is less that 1000, you may choose to deactivate this
feature. The navigation aids will not be displayed at the bottom of the list as shown below.
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Paging is activated by default and we recommend that you should keep paging activated.
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4
Manager view
Manager view is an important part of Archive Manager for Exchange. In this view you may define
the type of jobs used for automated archiving; global parameters; you may set automated email
archiving not only for groups but for individual users (mailboxes) as well, etc. All such settings
can be specified on the following tabs: Groups, Settings, Public folders, Jobs, Retention and
Locations.
Automated archiving is done via jobs. You, therefore, first need to define jobs (see Jobs tab ).
With jobs, archiving is done in the background with predefined settings. We will get to that later.
Let us now describe what the above-mentioned tabs are used for.

Groups tab
By clicking on the Groups tab a list of all synchronized groups will be displayed in the left pane. At
times when you only want to display some of the groups, it is good to use a filter, especially
when the list of synchronized groups is too long.

On the Groups tab you may set your own archiving criteria for each group. Double-click the
desired group to open its Properties window. Then, in the Properties window, set your criteria
for archiving that specific group on its General, Scheduler, Folders, Classes and Script tabs. (See
the section Setting criteria for group archiving.)
Let us first describe how to display only desired groups.
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How to set a filter to display only desired groups
On the Groups tab you may have a large number of groups displayed. To display only the desired
ones, use filters while specifying multiple logical conditions.

To create a filter, follow these steps:
1. In Manager view on the Groups tab, click on the Set filter button. The Filter window opens.

2. Select any or none of the following: RDN, ALIAS, DISPLAYNAME, or EMAILADDRESS in the first
dropdown menu; then select any or none of the following: =, STARTSWITH, ENDSWITH, or
CONTAINS in the second dropdown menu; and then enter text in the text box next to the Add
button. Then click Add.

EXAMPLE: If you select DISPLAYNAME in the first drop-down menu; CONTAINS in the second
dropdown menu; and if you enter ‘act’ in the third dropdown menu located next to the Add
button, then you have created the following filter: DISPLAYNAME CONTAINS ‘act’. With this filter
all groups with DISPLAYNAME containing ‘act’ will be displayed on the Groups tab.
By clicking the Add button the filter will be displayed in the text box below, as seen on the
following figure.
You can even check the syntax by clicking on the Check Syntax button.
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3. Click Save.
4. If the filter you have created is a new one then, upon clicking on the Save button, another
dialog window opens where you can enter the name in the Name of the filter text box, e.g.
Filter ‘act’. Confirm by clicking OK. A filtered list of groups will be displayed on the Groups
tab. (i.e. groups whose DISPLAYNAME contains ‘act’)

The figure below shows only those groups whose DISPLAYNAME contains ‘act’ (Filter ‘act’ from
the above mentioned example).
NOTE: Instead of creating a filter you may want to use someone else’s. In that case, upon
clicking on the Set filter button select the desired name in the Select user drop-down menu
and the desired filter in the Select filter drop-down menu. The selected filter will be
displayed in the text box below. Confirm by clicking OK in the Filter window.
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How to remove a filter
On the Groups tab in Manager view you have an option to set a filter to display only groups
meeting the desired criteria. Having set a filter, the Set filter button turns green (see below).

To remove a previously set filter, simply click on the Clear filter button. The list of all
synchronized groups will be displayed again and the Set filter button turns black.

Setting criteria for group archiving
When deciding to archive a desired group, specify the criteria according to which emails of that
group’s members will be archived. You will do that through properties of the respective group.
So, first switch to Manager view, and then click on the Groups tab. In the left pane choose a
group, whose members’ emails you plan to archive.
There are three ways of opening the Properties window:
· Double-click the desired group to open its Properties window,
· Right-click the desired group and then, in the context menu, select Properties to open its

Properties window,
· Select the desired group and then click on the Properties icon on the toolbar to open its

Properties window.
In the displayed Properties window of the desired group you may set your criteria on the
General, Scheduler, Folders, Classes, and the Script tabs.
On the following figure you will see a list of groups displayed in the left pane. If you select a
group, its properties will be displayed in the right pane.
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NOTE: The icons of groups activated for archiving are displayed in green.

General tab
On this tab you have an option to activate archiving for a desired group. Here you may specify a
period following which messages will be archived by using a pre-defined job. You can also specify
a limit-value for the files so that files exceeding that limit-value are archived.

To activate archiving for a group:
1. In Manager view click on the Groups tab. In the left pane double-click the desired group. The
Properties window opens.
2. In the Properties window, click on the General tab.
3. To activate archiving for this group, select the Allow to archive check box. In the Retention
category down-drop box you can select a retention category which will be used for the group
archiving. This retention category can be DIFFERENT from the one assigned to a job that will be
in charge of the group. (The relevant job is specified on the scheduler tab.) This allows you to
have several groups archived via the same job and at the same time each group being archived
with specific retention category. Should you select the Use job settings option, the retention
category of the job will be used.
4. In the Archive files older than (days) text box you can enter a period following which
messages will be archived.
5. In the Archive files bigger than text box you can enter the size of the messages to be archived;
please do not forget to select the proper item from the dropdown list in order to specify their
size either in B, KB, or MB.
EXAMPLE: On the following figure we set archiving of messages older than 10 days and exceeding
0.01 MB.
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6. The Advanced criteria give user opportunity to set filter for e-mails (IPM.Note) based on the
e-mail address, subject and body. E-mails satisfying the given criteria will be excluded from
archiving or only the e-mails satisfying the given criteria will be archived by the job set for
that group.

7. Finish by clicking Apply and then OK.
Upon activating a group you need to assign it a job that will do the archiving in the background
(see the section "Jobs tab”).
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Scheduler tab
On this tab you need to specify the job for archiving. Automated archiving is done via jobs. Jobs,
however, must be specified up-front on the Jobs tab. Therefore, if no jobs have been defined
yet, do so first (see "How to create a job”).
Once jobs are defined on the Jobs tab, you may select one.

To assign a job to the desired group:
1. In Manager view click on the Groups tab. In the left pane double-click a desired group. The
Properties window opens.
2. In the Properties window click on the Scheduler tab.
3. In the Selected job dropdown list select a job you prefer for archiving, for instance Job1.
NOTE: If no jobs are created, the dropdown list is empty.

4. Upon selecting a job, the Scheduling starts at box, the Schedule interval (in days) box, as well
as the Job status box are automatically filled in with the settings of that specific job.
EXAMPLE: In the following figure a job called Job1 has been selected. Groups scheduled for
archiving with this job will be archived every day at 8 PM starting on October 02, 2021. The
status of that job is Scheduled, which means that the job is currently active.
NOTE: When the status of a job is Stopped, the job is put on hold and needs to be "turned
on” (Scheduled) to run at the predefined time. A job’s status (Stopped, Scheduled) can
be changed on the Jobs tab.
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5. Click Apply and then OK.
NOTE: On the figure below you may notice that one group (e.g. test) is indicated by a green
icon with an exclamation mark (!). It notifies the administrator that this group is activated for
archiving, although no job is assigned to it.

Exclude tab
You may have activated and scheduled a group for automated archiving, yet you might want to
exclude some of the folders and their content from being archived or define folders to be
processed. That can be specified on the Folders tab in the Properties window of the respective
group. Use regular expressions to exclude custom folders based on folder name or path.
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To exclude folders from automated archiving:
1. In Manager view click on the Groups tab. In the left pane double-click the desired group. The
Properties window opens.
2. Click on the Folders tab. Here you can either:
· include certain folders in automated archiving

Be aware that if some folder(s) are listed in Include folders section, NO OTHER folders will
be archived. All other folders will be automatically excluded from archiving. When adding
folders, wildcards can be used – see further.
or
· exclude certain folders from automated archiving

It is possible to check folders in the list (Inbox, Outbox, Sent Items and Deleted Items) or
define custom folders. When defining custom folders, also wildcards can be used – see
further.
IMPORTANT: If you exclude a folder from automated archiving, then its subfolders will
NOT be archived either.

3. When adding folders either in Include or Exclude section, click on the Add button. In the
Folder window that opens, enter the folder name or path.
NOTE: As a path separator use a slash "/”.
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Wildcards
Asterisk (*) has a specific function in the Include section. Three basic scenarios apply:
a) <folder>
If only folder is specified (e.g. Inbox, Export/marketing...), it will be archived, but its
subfolder will not be archived.
b) <folder>/*
If folder is followed by a slash with asterisk „/*" (e.g. Inbox/*, Export/marketing/*...), only
subfolders will be archived, NOT the given folder.
c) <folder>*
If folder is directly followed by the asterisk „*" (e.g. Inbox*, Export/marketing*...), both folder
and it subfolders will be archived.
EXAMPLE: In the example on the figure below, the configuration is the following:
Include folders: Inbox*
Exclude folders: Inbox/private
This means that Inbox and all its subfolders will be archived, except the private subfolder.

4. Click Apply and finish by clicking OK. The respective folders will be excluded from automated
archiving.
You may of course review your decision. In that case deselect the respective check-box, or simply
select the respective folders in the Custom folders list-box and then click on the Remove button.
Do not forget to click Apply and OK.
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Classes tab
On this tab you may specify which types of email items will be automatically archived/excluded
in mailboxes of a given group.

To select message classes:
1. In Manager view click on the Groups tab. In the left pane double-click the desired group. The
Properties window opens.
2. Click on the Classes tab.
3. There are three items selected by default for archiving: IPM.Note (email), IPM.Post (Note in
Outlook), IPM.Document (OLE-documents). To select additional ones, click on the down arrow
next to the Add button to open the dropdown menu.
Similarly, you can also define message classes that will be excluded from archiving.
NOTE: If the Message classes list is empty, the IPM.Note is added automatically! In such a
case, only IPM.Note will be archived.

4. Select the desired item from the help-list or type in the message class you wish to include.
IMPORTANT: You can enter any message class on this tab. However, only those message
classes which are allowed to be archived on the global level will be actually archived. For
more information see Message Classes.
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5. Click on the Add button. The respective item will be added to the list in the Message classes
box.
6. Click Apply and then OK.
Message classes specified on this tab will be archived only if they are allowed to be archived on
the global level. For more information see Message Classes.
NOTE: If you want to remove any of the message classes listed under the Message classes
box from archiving, simply select them and then click on the Remove button.

Script tab
You might want to modify the script to define additional conditions you may have wanted to
apply to a desired group. This can be done on the Script tab of the respective group.
NOTE: For instance, script is used when a particular feature of Archive Manager is deployed
(e.g. live email indexing feature which allows fulltext search of live/non-archived emails in
the ArchiveWeb interface).

To generate a script for the desired group:
1. In Manager view click on the Groups tab.
2. Select the desired group in the left pane. Right-click it and in the context menu select
Properties.
3. In the Properties window click on the Script tab.
4. Click on the Generate button. Then in the Generate script window click Yes to generate a new
script.
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5. Upon clicking Yes, the newly generated script will be displayed in the text box, as shown
below. You may now modify it to your needs. By clicking on the Check button you will verify
the syntax. When you are done, click Apply and then OK to confirm.

NOTE: Please notice that by having modified the script, certain fields on the General and
Classes tabs become inaccessible, meaning that they cannot be modified there. A generated
script may be deleted, simply by clicking on the Clear button. Then the fields on the General
and Classes tabs will become accessible again.

How to activate the archiving option for a group
Keep in mind that automated archiving of emails via jobs is only possible for those groups that
have had the archiving option activated. So, even if a job has been assigned to a group, but the
group archiving option is not activated no automatic archiving will take place. Therefore, do not
forget to activate it first.
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To activate the archiving option for a group:
1. In Manager view click on the Groups tab.
2. In the left pane double-click the desired group. Its Properties window opens.
3. In the Properties window on the General tab select the Allow to archive members of this
group check box.

4. Click Apply and then OK. The group is now allowed to archive.
Now you are ready to assign a job that would do the archiving.

How to deactivate a group from being able to archive
1. In Manager view click on the Groups tab.
2. In the left pane double-click the desired group. Its Properties window opens.
3. In the Properties window on the General tab make sure that the Allow to archive check box is
de-selected.
4. Click OK. That group can no longer be archived.
NOTE: Even if a job is assigned to it, no automated archiving of this group’s items will take
place.

How to copy a group’s settings
In the Manager view on the Groups tab there are two ways of copying a group’s settings:

Method I
1. To copy a group's settings, select the desired group in the list in the left pane and then click on
the Copy settings ( ) icon on the toolbar.
2. Then select the target group and click on the activated Paste settings ( ) icon next to the
Copy settings icon on the toolbar. Settings of the original group will be copied onto the target
group.
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Method II
1. To copy a group's settings, select the desired group in the left pane.
2. Right-click it and then, in the context menu, select Copy settings.
3. Then select the target group, right-click it and in the context menu select Paste settings. The
settings of the original group will be copied onto the target group.

How to schedule group archiving
The group which you want to be archived automatically has to be allowed to archive and a job
must be assigned to it (see the section "How to archive emails of a group via a job”). Without
activating it and having assigned a job to it, a group will not be allowed to archive automatically.
It can, however, be archived manually (see the chapter Archive view).
NOTE: Groups allowed to archive are displayed green. An icon of a group for which the
archiving option has been activated, yet with no job assigned to it, is displayed green with an
exclamation mark (!), to notify the administrator (see below).
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How to configure specific folders for automated
archiving
Let’s say you have set the automated archiving for a group, yet you want to exclude/include some
of the folders for automated archiving. To do so, follow these steps:
1. In Manager view click on the Groups tab.
2. In the left pane select the desired group and double-click it to open its Properties window.
3. In the Properties window, click on the General tab to make sure that the Allow to archive
check box is selected. Then click on the Scheduler tab to verify whether a job was assigned.
Then click on the Folders tab.
4. On this tab configure your desired settings in two sections:
· Include folders – only the added folder will be archived. All its subfolders and other folders

will be excluded from automated archiving. To include subfolders, use asterisk:
<folder>* - Folder and all its subfolders will be archived
<folder>/* - Only subfolders will be archived.
· Exclude folders – added folder nor its subfolders will be archived

NOTE: As a path separator in both sections use a slash "/”.
5. Finally click OK.

EXAMPLE: If you define for example the Inbox as an exclude folder, neither of its subfolders is
processed. Provided that you want to exclude Inbox but archive its subfolders, add the Inbox as:
Inbox/*. Click Apply and then OK. The respective folders will be excluded from automated
archiving.
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How to display group members
To check group members:
1. In Manager view, click on the Groups tab.
2. In the left pane, right-click a desired group and, in its context menu, click Show members.

3. A list of group members will be displayed.

Settings tab
On the Settings tab in Manager view you may specify additional useful settings. We will describe
what the upper and lower limit values are used for, etc.
· Threshold settings
· Clients Permissions
· Group level retention
· Shortcut templates
· Shortcut template assignment
· Archive size report
· Notification settings

Threshold settings
On this tab it is possible to define mailboxes for which the Threshold job should run (see
"Threshold job”). The threshold functionality allows the administrator to control the size of the
mailboxes in the Microsoft Exchange Server and to prevent them from overflowing. (The limit
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defined for a mailbox in MS Microsoft Exchange Server can be processed by Archive Manager as
well).
The administrator can set the Lower and Upper limit. Upper and Lower values are percentages
from the total mailbox limit allocated to a mailbox/group on the MS Microsoft Exchange Server.
These two values are closely associated with Threshold job, which actually does the "cleaning up”
of the Microsoft Exchange message store. When the Upper value is reached for a specific
mailbox/group, then archiving via Threshold job can "free up” some space on the MS Microsoft
Exchange Server until the Lower value is reached for the respective mailbox/group.
Example: The mailbox has a limit of 100 MB (defined in MS Microsoft Exchange Server). The
administrator defines the threshold values 50/90. If the mailbox size reaches 90% of the limit (90
MB), the Threshold job will archive the mailbox until the size of the mailbox drops under 50% of
the limit (50 MB). The threshold job archives the oldest messages first (default settings). The
order of the messages can be modified using the scheduler service config key
("ThresholdSortBy”) in <installdir>\ Metalogix\MAM4Exchange\ Services\ PamExSchedulerSv\
PamSchedulerSv.exe.config. The following values can be used:
· Order by last modification date (ascending, i.e. oldest first) [value = "0”]
· Order by received date (ascending) [value = "1”]
· Order by size (descending, i.e. biggest first) [value = "2”]

NOTE: After config file modification services must be restarted.
Further, it is possible to exclude specific messages from threshold processing. The Threshold job
will archive the mailboxes but it will filter out specific messages based on your configuration.
Available filtering for Threshold job:
· Filtering by message size
· Filtering by age
· Filtering by folder
· Filtering by message class

This filtering can be also configured using the scheduler service config keys in <installdir>\
Metalogix\MAM4Exchange\ Services\ PamExSchedulerSv\ PamSchedulerSv.exe.config. For more
information see the following table:
Filtering

Config key

Default value

Description

By message size

ThresholdMinimumSize

4

Minimum size
(in KB) of the
email which can
be included in
the threshold
processing. All
emails smaller
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than the
defined size are
not archived.
By age

ThresholdMinDate

0

If value > 0,
messages which
are younger
than x days are
excluded from
processing.

By folder

ThresholdExcludeFolders

-

Semicolon
separated list of
exclude folders
defined for
threshold job;
the syntax is the
same as in case
of group
exclude folders.

By message class

ThresholdMessageClasses

-

Semicolon
separated list of
include
message classes
for the
threshold job.

The mailbox limit in Microsoft Exchange Server can be defined on two levels: on the mailbox
level and on the Information Store level. For Archive Manager the mailbox limit has a higher
priority than the Information Store limit. These limits are read from Microsoft Exchange Server
and can be checked in Address Book Manager (Tools > Address Book Manager > click the Mailbox
node > double-click the desired mailbox > in Properties window switch to the Others tab).

Adding a group/mailbox onto the Threshold tab
To add a group/mailbox to the Threshold tab:
1. In Manager view, click on the Settings tab.
2. Click Threshold settings.
3. Right-click inside the right pane and then select Add group or Add mailbox from the context
menu.
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4. In the Select mailbox or group window enter the name of the desired group/mailbox in the
text box or select the group/mailbox from the list. Then click OK.

5. The respective group/mailbox will now appear on the Threshold tab.
As a next step you need to set the mailbox size limit as well as Upper and Lower values to that
group/mailbox.

Setting the mailbox size limit, as well as Upper and Lower values
By setting size limitations for a group/mailbox you actually allocate space on the MS Microsoft
Exchange message store for the desired group/mailbox.
Upon adding a group/mailbox onto the Threshold settings tab you should specify their maximal
size limit, as well as Upper and Lower values. Whenever the Threshold job (see the section
"Threshold job”) starts running it looks for mailboxes and groups having been specified on the
Threshold settings tab, and starts archiving the content of those which have reached their Upper
value, and keeps archiving until the Lower value has been reached.

To set size limitations for a group/mailbox:
1. In Manager view, click on the Settings tab
2. Click on the Threshold settings tab.
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3. Right-click the desired group/mailbox in the list and then, in the context menu, select
Properties. The Properties window opens.
4. In the Properties window enter your specifications for Manually defined limit. This will be the
maximal space that every mailbox of the group (or the given mailbox) will occupy in the MS
Microsoft Exchange Server. Should you want to use a value different from the limit defined in
Active Directory, check the Always use the manually set limit instead of the mailbox limit
check box. If this check box is not checked, the Active Directory limit will be used instead of
the here defined value.
Enter your specifications for Lower limit and Upper limit as well.
NOTE: Make use of the Find mailbox limit link to display the limit set in the Active
Directory for the selected mailbox.
If you want those settings to be applied to any subgroup of a group, select the Apply the settings
recursively for group member check box. In that case your settings will be applied to its
subgroups.
In the Retention category down-drop box you can select the retention category to be used for
archiving. Otherwise the retention category of the Threshold job (see the section "Threshold
job”) will be used as default.
Click Apply and then OK.

Group Properties window

Mailbox Properties window

5. Click OK and verify the settings in the Threshold tab.

Archi ve Ma na ger for Excha nge Admi ni s tra ti on Gui de
Ma na ger vi ew

134

Clients Permissions
Archive Manager Client AddIn for MS Outlook has been designed for complete usage of Archive
Manager for Exchange archiving solutions. Its extra features are directly incorporated in MS
Outlook.
Global add-in settings are applied automatically onto every client machine with the Archive
Manager Client AddIn installed. They apply also for OWA, if Archive Manager OWA Extensions
are installed. It is therefore good to decide beforehand on some company strategy. In some cases
you may want to modify the settings for some mailboxes/groups, and let them either gain
additional rights, or withdraw some rights from them.
Permissions can be specified on the Clients Permissions tab in the Archive Manager for Exchange.
At the same time, by adding users onto this tab you have an option to modify the permissions for
them.
NOTE: Regarding the retention categories, individual groups or users can have their own
default retention categories at Addin archiving. It may be set on the Settings/Group level
retention tab (see the following section "Group level retention tab”). Otherwise the global
default retention category is applied.

How to set Clients Permissions
To define Clients Permissions:
1. In Manager view, click on the Settings tab.
2. Click the Clients Permissions node in the left pane. Then double-click the [Global settings]
icon.
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3. The Properties window opens. For every option (Deleting, Restoring, Fulltext search, etc.) you
may choose individually whether you want to activate or deny. When you are finished, click
Apply and then OK.

4. Options selected in the previous step will be applied globally to all users with the Archive
Manager Client AddIn installed.
Let us describe what the activating of individual options mean for the user who has the Archive
Manager Client AddIn installed:
Deleting

User will be able to mark items in the archive for
deletion. This means that items marked for deletion
will be DELETED from the archive upon the
expiration of their retention period by using the
Delete Files job, if specified (see the section
"Delete Files job”).

Restoring

User will be able to restore items from the archive
himself.

Fulltext search

User will be able to conduct full-text search within
his archived items.

Archiving

User will be able to archive items himself.
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Offline support

User will be able to work offline with archived
items.

Dialog Download

User will see a message box displayed when
downloading.

Dialog Create new version

User will see a message box displayed when
creating a new version.

Dialog Get versions

User will see a message box displayed when
retrieving one of the archived versions.

Versions view

User will be able to view different versions of
archived items.

Dialog Get fulltext results

User will see a message box displayed when getting
full-text search results.

Dialog Identifying user

User will see a message box displayed when
identifying the user at the beginning (when
opening MS Outlook).

AddIn Options

User will be able to set some options, such as
whether to auto-synchronize when Outlook
starts/exits; what format to save archived messages
in.

Create version

User will be able to create versions.

Select retention

User will be able to choose which retention
category should be used at archiving

NOTE: If all the global ones are activated, then users with the Archive Manager Client
AddIn installed will have add-in features activated. Similarly, if all the global ones are
deactivated, then users with the Archive Manager Client AddIn installed will have add-in
features deactivated. You may however want to assign different rights to some users, i.e.
to override the global ones. In that case add those users onto this tab and specify the
desired rights for them individually. See the section How to override global Clients
Permissions settings.
NOTE: If all the global ones are activated, then users with the Archive Manager Client AddIn
installed will have add-in features activated. Similarly, if all the global ones are deactivated,
then users with the Archive Manager Client AddIn installed will have add-in features
deactivated. You may however want to assign different rights to some users, i.e. to override
the global ones. In that case add those users onto this tab and specify the desired rights for
them individually. See the section How to override global Clients Permissions settings.
IMPORTANT: Be aware that after installation of Archive Manager Client AddIn no rights are
allowed, yet no rights are denied. It is up to the administrator to choose the best approach
regarding setting up the global rights.

Archi ve Ma na ger for Excha nge Admi ni s tra ti on Gui de
Ma na ger vi ew

137

Keep in mind that if for Global Settings you:
1. allow all of the options, then all users with the Archive Manager Client AddIn or Archive
Manager OWA Extension installed will be allowed to do archiving, restoring, etc.
2. deactivate all of the options, then all users with the Archive Manager Client AddIn or Archive
Manager OWA Extension installed will not be allowed to do archiving, restoring, etc.
In both cases you will have to add all those users for whom you want to change the settings onto
this Clients Permissions tab and specify the desired options for them.

How to override global Clients Permission settings
To override Clients Permissions settings and assign different rights to
a group/mailbox:
1. In Manager view, click on the Settings tab.
2. Click on the Clients Permissions permissions tab in the right pane.
3. Click with your right mouse button inside the right pane and, in the context menu, select Add
group/Add mailbox.

4. In the Select group or mailbox window enter the name of desired group/mailbox in the text
box or select the desired one in the list below. Then click OK.
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5. The respective group/mailbox will be added onto the Clients Permissions tab. Right-click it
and, in the context menu, click Properties to open its Properties window.

6. In its Properties window you may either allow or deny individual options simply by clicking on
appropriate Allow or Deny check boxes.
These attributes will override the global ones.
For group: You may wish to apply those settings for subgroups as well. In that case select the
Apply these permissions for group members recursively check-box.
When you have finished, click Apply and then OK.
For mailbox: If you select the Use global settings and ignore inherited permissions check box, the
global rights will be inherited again and the ones specified in the Properties window, will be
overridden. In those cases you may check the effective Addin rights by clicking on the final result
link.
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Group properties window

Mailbox properties window

If we assume in our example that all rights in the global settings for the mailbox are allowed,
then after clicking on the final result link you would get the following:

Group level retention
As a part of AMAC preferences, the default retention category was specified on the
Tools /Options/Archive settings/Retention tab. For more information see Archive settings. The
default retention category is used if no specific retention category is chosen at archiving. It
usually applies for manual archiving using Archive Manager Client Addin.
However, this tab gives you the opportunity to set different default retention categories for
different groups or users. It is especially useful in case of Archive Manager Client Addin.
Company needs or user preferences can be taken into account. For each group/user you can
specify the default retention category used when archiving in Outlook via Addin.
NOTE: Addin rights for individual users or groups can be set on the Settings > Clients
Permissions tab.
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How to specify global default retention category
Global default retention category can be set on the Tools /Options/Archive settings/Retention
tab.

How to set default retention category for individual groups or
mailboxes
To override global default retention category and assign specific default retention category to
individual group/mailbox:
1. In Manager view, click on the Settings tab.
2. Click on the Group level Retention tab in the right pane.
3. Click with your right mouse button inside the right pane and in the context menu select Add
group/Add mailbox.

4. In the Select mailbox or group window enter the name of the desired group/mailbox in the
text box or select the desired one in the list below. The click OK.
5. The respective group/mailbox will be added onto the Retention tab. Right-click it and, in the
context menu, click Properties.
6. In its Default retention window select the desired retention category in the down-drop box.
For group: You may want to assign that retention category to subgroups as well. In that case
select the Apply recursively for group members check box.
Click Apply, then OK.
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NOTE: The default retention category assigned to the mailbox has higher priority than
the default retention category assigned to the group.

Shortcut templates
When an email is archived, usually (depending on settings) just a shortcut is left behind in the
Microsoft Exchange server. Administrator can configure shortcuts according to the company
needs and define how the shortcuts should be displayed in the user’s Outlook preview.
Shortcut layout and type is specified through shortcut templates. There can be various shortcut
templates defined for different users/groups. For instance, Mac users may need specific
shortcuts.
This node is reserved for shortcut template creation. Different types of templates can be created.
It is possible to configure maximal shortcut size, the format of the message body and create
attachment links reachable from the preview pane of Outlook/OWA.
Shortcut templates created on this tab can then be assigned to groups or users on the Shortcut
template assignment node, e.i. the user/group’s archived emails will have the defined
configuration.
NOTE: One of the shortcut templates can be selected as a global template in the Shortcut
tab from Tools/Options/Archive Settings. This template will then be used in cases when no
other template settings are applied. As default it is the Default template.
To create a new shortcut template select the Shortcut templates node. Then right-click inside the
main pane and from the context menu select Create new shortcut template.

Before specifying settings for shortcuts it is important to think over how the shortcut (archived
email) should look like. Consider your priorities and intentions as well as expectations of the
users. For instance, if it is vital to keep the shortcuts small, you will want to truncate the body
text and not to keep formatted body text. On the other hand, you may want users to be able to
read the emails in the preview pane (no body-text truncating) and also to access attachments
from the preview pane (e.g. Create links for attachments option) etc. - read further about
possible options.
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As default (i.e. when no settings are specified on this tab) the Archive Manager archiving
processes replace the email on MS Microsoft Exchange with the shortcut that includes the header
and the body of the archived email. Therefore, the Outlook Preview is able to display the
archived items while the Attachments field is left empty. The attachment is included in the
message when the email is retrieved from the archive by double-click.
You can set the format of the shortcut as well. Check the Generate an HTML shortcut from
template check box to create shortcuts in HTML format. The HTML shortcut includes also links for
attachments, so there is no need to activate Generate an HTML shortcut from template and
Create links for attachments at the same time.
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Fig. Default HTML shortcut in the Outlook preview pane

Choose your desired HTML shortcut template from the down-drop box under the Generate an
HTML shortcut from template. If you have not created any template yet, there is just the Default
one. You can create your own templates to customize the HTML shortcuts design. For more
information see How to create a customized HTML shortcut template .

When the message is archived, its header and body are kept in the MS Microsoft Exchange Server
as default, no matter what size they are. Only attachments are removed. Should you wish to
allocate just fixed size for every archived email and in this way save even more space on your MS
Microsoft Exchange, check the Truncate body text check box. In the Bytes text field enter the
MAXIMAL size of the shortcut left on the MS Microsoft Exchange Server. The message body will
be truncated, if it is bigger than the specified size.
NOTE: Remember that in the Preview pane of Outlook user can see only the shortcut left
on the MS Microsoft Exchange Server and the Outlook Find feature can search also only in
this shortcut
If you check the Keep formatted body text (RTF) check box, the formatted text of shortcut will not
be altered.
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If the Keep formatted body text (RTF) is not checked, only the plain text message body will be
kept.
NOTE: The Keep formatted body text (RTF) and the Truncate body text options are mutually
exclusive. So are Keep formatted body text (RTF) and Generate an HTML shortcut from
template. After changing settings on this tab, you may want to apply them not only to new
shortcuts which will be created from now on, but also to shortcuts which were created
previously. To do so, you have to run the Repair shortcut command on a group, mailbox or
folder where these new settings should apply to previously created shortcuts.
The settings under Entourage options apply for Entourage users as well as other email clients
(e.g. mobile clients). Check the Open email in EML format so that users will be able to open
archived emails from the preview pane.

Attachments
To make the attachment accessible from the Preview pane, check either the Create links for
attachments or Generate an HTML shortcut from template check box and configure links creating
on the Attachment Options tab as described further. The HTML link available in the Outlook/OWA
Preview will be created. It will bear the name of the attachment with an .html extension as
shown below.

When clicked, the following info panel may be displayed. Click the link to download the
attachment from the Archive Manager server.
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If you plan to use attachment links in shortcuts you need to configure the settings on the next tab
(Attachment Options tab).

The settings are as follows:
· Do not create attachment links for all embedded files - Links will not be created on the shortcut

for embedded files.
· Create attachment links only for the following file types: Click the Add button to add any file

types to display its link on the shortcut.
· Do not create attachment links only for the following file types: Click the Add button to exclude

file types from being displayed as links on the shortcut
NOTE: The Create links for attachments option must be selected in the General tab. You
can use only one of the two options: Create attachment links only for the following file
types or Do not create attachment links only for the following file types. If you use either
one, the other option will be deactivated.
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Shortcut template assignment
When an email is archived, usually (depending on settings) just a shortcut is left behind in the
Microsoft Exchange server. Administrator can configure shortcuts according to the company
needs and define how the shortcuts should be displayed in the user’s Outlook preview.
Shortcut layout and type is specified through shortcut templates. These templates are created
under Shortcut templates node (see the previous section).
Different users/groups can have different shortcut templates assigned on this tab.
NOTE: Default shortcut template can be specified also on the Tools/Options/Archive
settings/Shortcut tab. If the default shortcut template is changed here it is changed also on
that tab and vice versa.

To assign a group/user specific shortcut template:
1. Right-click inside the main pain. From the context menu select Add group/Add mailbox.

2. In the pop-up dialog select the desired group/user in the listview and click OK.
3. The group/user will be displayed in the listview with default settings specified. To adjust the
settings right-click the group/user and from the context menu select Properties.
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4. In the pop-up window select the desired template from the downdrop box. If applicable you
can check the Apply recursively for group members check box to apply it also for possible
subgroups. Then click Apply.

Archive size report
From time to time, administrators may need to know the status of users’ mailboxes, just to get an
overview of the entire size of mailboxes in the HSM store. For that purpose they may easily
create reports containing all relevant data.
When clicking on the Archive size report tab for the first time there will be no mailboxes
displayed.
To display all mailboxes, click Calculate. The list of mailboxes will be displayed in the right pane,
including message size, archived size, archived size uncompressed, shortcut size, and the limit of
mailboxes as well. Mailboxes can be sorted simply by clicking on the respective column headers
(Object, Message size, Archive size, Archive size uncompressed, Shortcut size, and Limit).
NOTE: The size of delayed shortcuts is not calculated in the Shortcut size column.
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To get an overview, create a report by clicking Export. The Export Wizard window will open with
three options to choose from: All mailboxes, Filtered mailboxes, or Distribution lists with
members, depending on whether you want to create a report including all the mailboxes, only
filtered mailboxes, or distribution lists with members only. Detailed explanation is given in
subsequent section.

How to create a report for all mailboxes, filtered mailboxes and
distribution list
To get an overview of the HSM store, create a report by following
these steps:
1. In Manager view, click on the Settings tab, and then on the Report tab.
2. Click on the Export button to create a report. On the first page of the Export Wizard, select:
a) All mailboxes option and then click Next.
b) Filtered mailboxes option and then click Next.
c) Distribution lists with members option and then click Next.

i. If you have selected All mailboxes option, go to step 3.
ii. If you have selected Filtered mailboxes option, then:
In the Define a filter window that opens simply click on the Filter button to either
create a filter or select an already created one listed in the Selected filter list-box.
In the Filter window that pops up:
· either select an already existing filter in the Select filter dropdown box and then click

OK;
· or create your own by choosing RDN/ALIAS/DISPLAYNAME/EMAILADDRESS in the first

dropdown menu, =/STARTSWITH/ENDSWITH/CONTAINS in the second dropdown
menu, and entering text in the text box next to the Add button.
Then click on the Add button. If you want to combine some other conditions, simply
use brackets and logical operators and confirm by clicking Add.

Archi ve Ma na ger for Excha nge Admi ni s tra ti on Gui de
Ma na ger vi ew

149

The resulting filter will be displayed in the text box below. To check the syntax, simply
click on Check Syntax. Click Save to give this newly created filter a name, and confirm
by clicking OK.

The resulting filter will be displayed in the Selected filter list box. Click Next and
proceed to step 3.

iii. If you have selected Distribution lists with members option, then:
On the next page of the Export Wizard you may select the desired groups for your
report. Simply select appropriate items in the Available Distribution lists list box and
click the left-to-right arrow button. The respective items will subsequently be moved
to the Use these DLs in this order list box.
· To include all groups, click on the left-to-right double-arrow button.
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· To remove some of the groups and have them not included, select the respective

item in the Use these DLs in this order list box and then click on the right-to-left
arrow button.
· With the Move up and Move down buttons simply organize your report to your

needs. Groups will be displayed in the report (Excel sheet) exactly in the order as
specified in the Use these DLs in this order list box.

When you are satisfied with the list of groups listed in the Use these DLs in this order
list box, proceed by clicking Next.
3. On the Choose output fields page in the Export Wizard you can select fields for your report.
Simply select the desired item in the Available fields list box and click the left-to-right arrow
button. The item will subsequently be moved to the Use these fields in this order list box.
· If you want to include all the fields in the report, click on the left-to-right double-arrow

button.
· If you want to remove some of the fields and have them not included in the report, then

select the respective item in the Use these fields in this order list box and then click on the
right-to-left arrow button.
· With the Move up and Move down buttons simply organize your report to your needs. They

will be displayed in the report (Excel sheet) exactly in the order as specified in the Use
these fields in this order list box.
When you are satisfied with the selection of fields and their order, proceed by clicking
Next.

4. On the next page you may specify the name of the exported file and the place it should be
saved to. Just enter the path and appropriate name in the Select output file text box; or click
on the Browse button to select the appropriate folder.
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5. Then click Finish to see the full path displayed, including file-name.

6. By clicking on the Details button, the details will be displayed. Click OK.
7. Having created the report, open it directly from the place you saved it to. (In our example
from C:\export.csv)
NOTE: If the data in the report (Excel sheet) is contained in only one column, check if a
proper delimiter has been set on the Others tab (see the "Others tab”).

Notification settings
This feature has been designed to notify the users, preferably administrators, about
circumstances leading in some cases to critical situations. Depending on the type of confidence
level, alert messages (notification) will be sent to recipients added onto the Notification settings
tab.
You may specify which user will be sending notifications. Simply right-click the Notification
settings node in the left pane and in the context menu click Notification settings.

In the Notification Settings window specify the SMTP server (Port and use of SSL as appropriate)
and the Sender. (User and password are optional.) When you are done, click Apply and then OK.
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The sender you have specified will be sending alert notifications. These settings will be
displayed in the right pane.

Once the sender is defined, follow the steps below to configure
several notification tasks:
1. Right-click the Notification settings node and select Add Notification Task.
2. In the Task Settings window define the Task name and Recipients e-mail. Several recipients
should be separated by semicolon (;).
It is possible to Send test mail by clicking the link.

3. Then click the Scheduler tab where sending notification can be scheduled.
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4. On the Reports Types tab specify the desired reports:

a) License Usage
The Report contains the licensed mailboxes, mailboxes in use and the maintenance
information. If the customer is over the license limit or the maintenance is expired, this
information will be displayed in red font in the email.
b) Usage Statistics
If you activate the check box Exclude deleted/deactivated user accounts then deactivated
user accounts will be excluded from the report.
c) Archive Statistics
For example:
a. The scheduler is set up to 8 PM, and the interval is one day. You intend to have a
statistic for the last 24 hours. So you will generate the statistic for the last 24 hours
beginning at 8 PM
b. The scheduler is setup up to 8 PM, and the interval is 4 hours. You intend to have a
statistic for the last 4 hours. So you will generate the statistic for the last 4 hours
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(statistic between 4 PM until 8 PM). The next job run is at 12 PM. So you will generate
the statistic for the last 4 hours (statistic between 8 PM until 12 PM)
c. The scheduler is setup for 6 PM, and the interval is one week. You intend to have a
statistic for the last 7 days. So you will generate the statistic for the last 7 days by hours.
The next job run is at 6 PM one week later.
5. Individual tasks can be Deactivated, Deleted or Changed by right-clicking the task name under
the Notification settings node.

Public folders tab
From the Public folders tab you can set your the criteria for automated archiving of emails in the
public folders. Public folders are archived in the same way as groups are archived.
NOTE: For more information about archiving public folders manually, see Public Folders tab
in the Archive View chapter.
To display public folders, click on the Public folders tab in Manager view. Then expand the tree
structure in the left pane.
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NOTE: The icons of public folders that are activated for archiving are displayed in green..

How to set criteria for archiving a public folder
When you have decided to archive the content of a public folder, you need to specify the criteria
according to which emails of that folder will be archived. You may do that through the properties
of the folder in question.
There are two ways of setting the criteria for archiving a desired public folder:
· You may either right-click the desired folder and select Properties in the context menu to open

the Properties window; or
· You may select the desired folder and then click on the Properties icon on the toolbar following

which the Properties window for that specific folder opens.
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Steps to set your criteria in the Properties window

1. In the Properties window, click on the General tab.
On this tab you may activate the archiving option for public folders. Only with this option
activated the public folder can be archived via jobs. You can also specify the period after
which messages will be archived and a limit-value for the files.
Select the Allow to archive members of this group check box, to activate archiving.
In the Retention category down-drop box you can select a retention category which will be
used for archiving the public folder. It allows you to archive the public folder with specific
retention category. This retention category can be DIFFERENT from the one assigned to a job
that will be in charge of the public folder. (The relevant job is specified on the scheduler tab.)
Should you select the Use job settings option, the retention category of the job will be used.
In the Archive files older than (days) text box you may enter a number, specifying after how
many days you want messages to be archived.
In the Archive files bigger than text box you may enter a number, specifying the minimum
size of the messages to be archived; please do not forget to select the proper item from the
dropdown list to specify size either in B, KB, or MB.
If you want the subfolders to be archived as well, select the Apply these settings recursively
check box.
EXAMPLE: On the figure below we want to archive all messages older than 10 days and
exceeding 100KB (also applied to subfolders). Further, the retention category of the job will
be used and all settings will be applied recursively to subgroups.
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When you click Apply, the respective public folders are now activated for archiving. In the
next step you need to specify a job that would be used for automated archiving. You will do
that on the Scheduler tab.
NOTE: Public folders that are setup for archiving but don't have an associated job are are
indicated with a green icon with an exclamation mark
2. Switch to the Scheduler tab.
Automated archiving is done via jobs that must be specified beforehand on the Archive
Manager for Exchange/Jobs tab. So if no jobs have been defined yet, do so first (See "How to
create a job”). Once jobs have been defined on the Jobs tab, you may select the relevant one.
To do so, open the Selected job drop-down list and select a job, for instance 9 pm archiving.
As soon as you select a job, the Schedule interval (in days), Scheduling starts at, as well as Job
status text boxes are automatically filled in with that job’s settings.
EXAMPLE: On the following figure we have selected a job called 9 pm archiving. Messages will
be archived daily at 21:00 as of October 23, 2021. The status of that job is Scheduled, which
means that the job has not been put on hold and will run at the specified time.
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Click Apply.
3. In the Properties window click on the Classes tab.
Here you can specify the types of email items contained in the respective public folder to be
archived/excluded from archiving by default. Message classes archived by default are listed in
the Message classes list box. They include IPM.Note (email), IPM.Post (Note in Outlook),
IPM.Document (OLE-documents). You may of course remove any of them from that box and
thus exclude them from archiving by default. Similarly, you may add additional classes and
have them archived by default.
Click on the down arrow next to the Add button to open the drop-down menu. Select the
desired item and then click Add.

The respective item will be added to the list in the Message classes list-box. To confirm, click
Apply.
4. In the Properties window click on the Script tab. You may want to modify the script for a public
folder, simply to define further conditions.
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To display the first script, click Generate. It will be subsequently displayed in the text box
below. Now you may modify it to your needs. When you are done, click Apply and then OK to
confirm.

NOTE: Public folders that are setup for archiving are indicated with a green icon. If subfolders are included, the icon will also display an arrow to indicate recursive selection.

How to activate the archiving option for a public
folder
To activate the archiving option for a public folder:
1. In Manager view click on the Public folders tab.
2. In the left pane select the desired public folder, right-click it and then, in the context menu,
click Properties to open its Properties window.
3. In the Properties window on the General tab do not forget to select the Allow to archive check
box.
4. Click Apply and then OK to confirm. The archiving option is now activated for the folder. Now
you are ready to assign a job that would do the archiving.
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How to deactivate the archiving option for a public
folder
Steps to deactivate the archiving option for a public folder:
1. In Manager view click on the Public folders tab.
2. In the left pane select the desired public folder, right-click it and then, in the context menu,
click Properties to open its Properties window.
3. In the Properties window on the General tab do not forget to deselect the Allow to archive
check box.
4. Click Apply and then OK to confirm. It is no longer possible to archive this public folder via job.

How to copy a public folder’s settings
In Manager view, click on the Public folders tab.

To copy a public folder’s settings, choose one of the following
options:
Method I
1. To copy the settings of a public folder, select a desired folder in the left pane and then click on
the Copy settings icon on the toolbar.
2. Then select the target public folder to copy those settings onto and click the Paste settings
icon on the toolbar. Those settings will be copied onto the target folder.
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Method II
1. To copy the settings of a public folder, select a desired public folder in the left pane, rightclick it and then, in the context menu, click Copy settings.
2. Then select the target public folder to copy those settings onto. Right-click it and, in the
context menu, select Paste settings. Those settings will be copied onto the target folder.

How to schedule archiving for a public folder
First you need to check if the desired public folder has had the archiving option activated (see the
section How to activate the archiving option for a public folder). Folders activated for archiving
are displayed in green. You can now schedule archiving by assigning a job (see the sections
"Scheduler tab” and How to create a job).

Jobs tab
On this tab you can define jobs for automated archiving. Archiving with jobs is done in the
background – with predefined settings.
IMPORTANT: On the Jobs tab, at the bottom of the right pane, you have to specify the backup
time, in other words, the period during which jobs are not supposed to run in order to
activate database backup. It is not possible to archive until it is set. Just enter the time in the
Backup start time and Backup stop time fields and then click Update.
You may for instance schedule your database backup overnight.
NOTE: Do not schedule your jobs during the backup interval, as they are paused until the
backup period is over and no mails would be archived during that period. After that the job is
resumed.
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At first there may not be jobs defined, as seen below. You need to create them.

Creating a job
As mentioned previously, automated archiving is done via jobs which need to be specified up
front.

To define a new job:
1. In Manager view click on the Jobs tab.
NOTE: When creating new job, click the Refresh button to update the Jobs tab.
2. Right-click in the left pane and in the context menu select New job.
NOTE: You can also click on the Create new job icon on the toolbar to define a job.
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3. In the Job Settings window that is displayed and select the type of job. Each job type is
explained in the following topics.

4. Click the Retention tab. On this tab you need to specify the retention category which defines
the retention time for the items archived via this job. By the means of these categories you
can adjust shortcut behavior and set various retention times for archived items. You can
choose from available categories or you can create your own categories on the Retention tab
of Manager view.
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5. Click the Scheduler tab. On this tab you should specify the time when scheduling begins: in
the Scheduling starts at field enter the date (by clicking on the upward or downward arrows,
or by overwriting it) and time (directly by overwriting the time).
In the Schedule interval box you may specify a period following which the job restarts itself.
Just click on the upward and downward arrows. The period may be set in minutes or days.
Should you select the Allowed time [hours] box, then you may enter your archiving period
simply by clicking on the upward or downward arrows.

If you select the Scheduling ends on check box you may specify a time when the scheduling
ends. The period is set to Never by default, i.e. when the check box is not selected. Click on
the downward arrow to open the calendar where you can select the appropriate month (by
clicking on the left and right arrows) and time (by selecting the appropriate day).
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6. Click the Compression tab. On this tab you may specify which of the files will be compressed,
simply by selecting the appropriate check boxes: Compress .msg file, and Compress
attachments.
Compression-related settings having been defined under Tools/Options/Archive settings
relate to manual archiving only; they are not automatically used by jobs. Therefore,
compression-related settings need to be specified individually for each job.
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Normal job
A Normal job is used for archiving emails of a specific group. You can create multiple normal jobs
and assign each job to one or more groups.

To define a Normal job:
1. In Manager view, click on the Jobs tab.
2. Click with your right mouse button inside the left pane. A context menu appears. In the
context menu select New job.
3. In the Job Settings window that appears, select Normal on the General tab. Do not forget to
enter a name in the Job name text box.
4. Then specify your scheduling criteria on the Retention, Scheduler, and Compression tabs.
Finish by clicking OK.
NOTE: To archive emails of a specific group, the job has to be assigned to that group (see
the following section How to archive emails of a group via a job).

Jobs that you create will be displayed in the left pane on the Jobs tab (in Manager view). Under
the Status field you may check their current status.
· Scheduled (displayed green) means that the job is scheduled and currently archiving emails or

in a stand-by mode until it restarts again;
· Stopped (displayed red) means that the job, although might be scheduled, is currently not

active.
In the right pane you will see the respective job’s settings displayed.
Change the status to Scheduled simply by clicking on the Schedule button or by right-clicking the
respective job and selecting Schedule in the context menu. You may stop an already scheduled
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job by clicking on the Stop button or by right-clicking the respective job and selecting Stop in the
context menu.
At the bottom of the right pane you should specify the backup time, in other words the period
during which jobs are not supposed to run, in order to activate database backup. If it is not set, no
archiving is possible. Just enter the time in the Backup start time and Backup stop time fields and
then press Update. You may for instance schedule your database backup over night. Pay attention
to this backup period, as no jobs should be running at that time.

NOTE: Jobs which are running at the moment are highlighted in green in the Existing jobs
pane of the Jobs tab.

Threshold job
Companies usually define within their IT department rules regarding storage space mailboxes or
groups may occupy on the MS Microsoft Exchange server, to avoid mail server overloading. The
Threshold job is used specifically for that purpose.
By defining the maximal size of a mailbox on the Threshold tab (see the section "Threshold tab”)
you may actually specify space having been reserved for it on the MS Microsoft Exchange server.
Other specifications (Upper and Lower values) are defined there as well.
When the Threshold job starts running, all mailboxes listed on the Threshold tab whose size has
reached their respective Upper value will be archived until their respective Lower value has been
reached (for each mailbox there can be assigned different threshold values). This way you can
easily arrange enough space on your MS Microsoft Exchange server, so that CPU efficiency is
preserved at a desirable level.
Example: The mailbox has a limit of 100 MB (defined in MS Microsoft Exchange Server). The
administrator defines the threshold values 50/90. If the mailbox size reaches 90% of the limit (90
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MB), the Threshold job will archive the mailbox until the size of the mailbox drops under 50% of
the limit (50 MB). The threshold job archives the oldest messages first (default settings). The
order of the messages can be modified using the scheduler service config keys (ThresholdSortBy)
in <installdir>\ Metalogix\MAM4Exchange\ Services\ PamExSchedulerSv\
PamSchedulerSv.exe.config. The following values can be used:
· Order by last modification date (ascending, i.e. oldest first) [0]
· Order by received date (ascending) [1]
· Order by size (descending, i.e. biggest first) [2]

NOTE: After config file modification the services must be restarted.
Further, it is possible to exclude specific messages from threshold processing. The Threshold job
will archive the mailboxes but it will filter out specific messages based on your configuration.
Available filtering for Threshold job:
· Filtering by message size
· Filtering by age
· Filtering by folder
· Filtering by message class

This filtering can be also configured using the scheduler service config keys in <installdir>\
Metalogix\MAM4Exchange\ Services\ PamExSchedulerSv\ PamSchedulerSv.exe.config. For more
information see the following table:
Filtering

Config key

Value/default

Description

By message size

ThresholdMinimumSize

4

Minimum size
(in KB) of the
email which can
be included in
the threshold
processing. All
emails smaller
than the
defined size are
not archived.

By age

ThresholdMinDate

0

If value > 0,
messages which
are younger
than x days are
excluded from
processing.
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By folder

ThresholdExcludeFolders

-

Semicolon
separated list of
exclude folders
defined for the
threshold job.
The syntax is
the same as in
case of group
exclude folders.

By message class

ThresholdMessageClasses

-

Semicolon
separated list of
include
message classes
for the
threshold job.

The Threshold job runs in the background with pre-defined settings. Archived emails are
replaced with a shortcut and the space is released for further usage.

To define a Threshold job:
1. In Manager view, click on the Jobs tab.
2. Click with your right mouse button inside the left pane. A context menu appears. In the
context menu select New job.
3. In the Job Settings window that appears, select Threshold on the General tab. Do not forget to
enter a name in the Job name text box. Then specify your scheduling criteria on the remaining
tabs.

NOTE: There can be ONLY ONE Threshold job defined.
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Delete Files job
The purpose of the Delete Files job is to purge following items from the archive:
· Items marked for deletion upon expiration of their Retention + Keep alive time
· Items whose Delete time, if such was defined, has elapsed (Delete time = maximal time for

which the items can reside in archive)
TIP: Undelete feature of Archive Manager for Exchange allows user to list archived items that
are marked for deletion in Outlook folder.
If the Undelete feature is implemented, user can perform Undelete operation on such items
marked for deletion. After the undelete operation the item(s) will have the same status as
regular archived items. Upon expiration of their retention time they will still reside in the
archive.
In the previous section we described how certain items can be marked for deletion. Once
marked, such files can be deleted from the HSM store upon the expiration of their retention
period – and this is done by the Delete Files job. THIS JOB REMOVES THEM DEFINITELY FROM THE
ARCHIVE, thus freeing up space in your archive for further usage.
As with other scheduled jobs, the Delete Files job shall run in the background with predefined
settings. BUT BE CAREFUL WHEN USING THIS JOB AS IT COMPLETELY DELETES EMAILS FROM
ARCHIVE (after their Retention + Keep alive time or Delete time has elapsed).

To define a Delete Files job:
1. In Manager view, click on the Jobs tab.
2. Click with your right mouse button inside the left pane. A context menu appears. In the
context menu select New job.
3. In the Job Settings window that appears, select Delete Files on the General tab. Do not forget
to enter a name in the Job name text box. Then specify your scheduling criteria on the
Scheduler tab. Finish by clicking OK.
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NOTE: There can be ONLY ONE Delete Files job defined. As with other scheduled jobs, the
Delete Files job runs in the background with predefined settings.

Shortcut Sync job
The Shortcut Sync job keeps the shortcut information in the Archive Manager database consistent
with the shortcuts in the Microsoft Exchange Server. The Shortcut Sync job searches through
synchronized mailboxes for shortcuts to items that are archived in the HSM store. Archived items
in the HSM store without shortcuts in the Microsoft Exchange server are marked for deletion or
purged if their retention time has expired. The retention category used for archiving these items
should be configured to allow the Shortcut Sync job to operate.

To define a Shortcut Sync job:
1. From the Manager view, click the Jobs tab.
2. Right-click inside the left pane. Select New job from the context menu. The Job Settings
window opens.
3. From the General tab select Shortcut Sync. Enter a name in the Job name text box.
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4. Click the Scheduler tab and set the scheduler properties as described below:
a. Scheduling starts at - enter the date manually or by clicking the upward or downward
arrows, and time (directly by overwriting the time).
b. Scheduling ends on - select this option to specify a date when the scheduling ends. Click
the date picker icon to open the calendar and select the month and date. The default is
Never when the option is not selected.
c. Schedule interval - specify a period following which the job restarts itself. Click the upward
or downward arrow. The period can be set in minutes or days.
d. Allowed time [hours] - enter the archiving period by clicking the upward or downward
arrow. The minimum allowed time is 1 hour.
5. Click the Options tab and select the options as described below:
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a. Synchronization - select this option to perform a standard shortcut synchronization of
mailboxes or public folders. If mail items are moved to another mailbox or location, then
duplicate mail items are archived.
NOTE: Standard shortcut synchronization is included in all the other options even if
this option is not selected.
b. Promote delayed shortcuts - select this option to create a normal shortcut for email items
that are bound to a retention category configured to delay shortcut creation for a specified
period. If the Shortcut Sync job discovers email items for which the shortcut creation delay
period has expired, a normal shortcut will be created for the archived email item.
c. Recover documents with shortcuts - select this option to recover documents marked for
deletion. If the Shortcut Sync job discovers a shortcut which has an archived document
marked for deletion, then the document is recovered.
d. Delete shortcuts for removed documents - select this option to allow the Shortcut Sync job
to delete shortcuts from the Microsoft Exchange Server when the job discovers archived
documents that are purged by the Delete Files job.
A user could have decided to delete a shortcut to an archived item from Microsoft Outlook
if it is no loner required or could have moved the shortcut from one folder to another. If
the user clicks the Delete archived messages icon on the toolbar or Delete selected
messages from the Archive Manager for Exchange menu of the Archive Manager Client
AddIn, then such items are marked for deletion in the HSM store. These items are kept in
the HSM store during their retention period. When the retention period and keep-alive
time expires for items marked for deletion, they can be purged by a scheduled Delete Files
job. If the job is not scheduled, emails remain in the archive.
If the user selects archived items and clicks the Delete icon on the Outlook toolbar or clicks
SHIFT + Delete on the keyboard then the corresponding shortcut is deleted since these are
Microsoft Outlook commands and not Archive Manager Client AddIn commands. Shortcuts
that are deleted with Microsoft Outlook commands will lose their reference to the
corresponding archived item in the HSM store and will not be marked for deletion in the
Archive Manager database. These are considered as lost items.
Any lost item can be restored by the administrator during its retention period until you run
the Shortcut Sync job. When the job runs, all lost items are marked for deletion. They
cannot be restored from the Archive tab in the Archive Manager for Exchange
Administration Center. Use this job when you are sure that no more lost items need to be
restored and that the space they occupy could eventually be released for use when the
retention period expires. Even though items marked for deletion cannot be easily restored
they can still be discovered during their retention period using the advanced search
because they are retained in the HSM store. To find the documents marked for deletion,
use the Advanced Search icon on the toolbar ( ) or the Archive Manager Client AddIn in
Outlook. In the Archive Manager Advanced Search window, the items that are marked for
deletion will be displayed with a blue icon.
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e. Delete expired shortcuts - select this option to delete shortcuts for email items that are
bound to a retention category configured to delete a shortcut after a specified time. If the
Shortcut Sync job discovers shortcuts with expired time, then the shortcut is removed from
the Microsoft Exchange server.
f. Delete archived items without shortcuts - select this option to mark archived documents
for deletion when the corresponding shortcut is removed from the Microsoft Exchange
server.
IMPORTANT: You must select all mailboxes and public folders when you select this
option. Shortcuts can be inadvertently moved to another mailbox or location
manually. Without synchronizing all mailboxes and public folders, the Shortcut Sync
job may not find the shortcut for an archived item and could remove the item.
6. Click the Mailboxes tab and select the mailboxes as described below:
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a. Synchronize all mailboxes - select this option to include all mailboxes for the Shortcut Sync
job. When this option is selected the List of Members and the Add and Remove buttons are
deactivated. You must select this option if you select the Delete archived items without
shortcuts option from the Options tab.
b. To add members:
i. Click Add. The Select Mailbox dialog appears.
ii. Select one or more groups or mailboxes. You can hold down the Ctrl or Shift keys to
select multiple mailboxes and groups.
iii. Click
to add the selected groups or mailboxes to the Selected objects list box.
Conversely, you can select groups or mailboxes from the Selected objects list box and
click
to remove the selected groups or mailboxes from the Selected objects list box.
iv. Click OK to add the selected members to the group or click Cancel to discard the
changes.
c. To remove members:
i. Select one or more members to remove. You can hold down the Ctrl or Shift keys to
select multiple members.
ii. Click Remove. A confirmation dialog appears.
iii. Click Yes in the confirmation dialog to remove the member. Click No to retain the
member.
7. Click the Public Folders tab and select the public folders as described below:

a. Synchronize all Public Folder mailboxes - select this option to include all Public Folder
mailboxes for the Shortcut Sync job. When this option is selected the List of Members and
the Add and Remove buttons are deactivated. You must select this option if you select the
Delete archived items without shortcuts option from the Options tab.

Archi ve Ma na ger for Excha nge Admi ni s tra ti on Gui de
Ma na ger vi ew

176

b. To add members:
v. Click Add. The Select Mailbox dialog appears.
vi. Select one or more Public Folder mailboxes. You can hold down the Ctrl or Shift keys to
select multiple mailboxes.
vii.Click
to add the selected Public Folder mailboxes to the Selected objects list box.
Conversely, you can select Public Folder mailboxes from the Selected objects list box
and click
to remove the Public Folder mailboxes from the Selected objects list box.
viii.Click OK to add the selected Public Folder mailboxes or click Cancel to discard the
changes.
c. To remove members:
iv. Select one or more Public Folder mailboxes to remove. You can hold down the Ctrl or
Shift keys to select multiple members.
v. Click Remove. A confirmation dialog appears.
vi. Click Yes in the confirmation dialog to remove the member. Click No to retain the
member.
8. Click OK to save the job setting and close the window.

Changing job settings
Job settings cannot be changed while the job is scheduled or running. You need to stop it first.

To change job settings:
1. In Manager view, click on the Jobs tab.
2. Select the desired job. Then click on the Stop button in the right pane. (Or you may right-click
the respective job and in its context menu click Stop.)
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3. Then click on the Change button (
) next to the Stop button (or right-click the
respective job and, in its context menu, click Change settings).
4. In the Job Settings window specify your new settings on the respective tabs.
5. When it is done, do not forget to click on the Schedule button (
) in the right pane to
schedule the job again (or right-click it and, in its context menu, click Schedule).

Starting a job immediately
Steps to start a job running immediately:
1. Go to the Jobs tab in Manager view.
2. Select the desired job – either stopped or a scheduled one. Right-click it and in the context
menu select Start now! The respective job will start running immediately.
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NOTE: Jobs which are just running are highlighted in green in the Existing jobs pane of the
Jobs tab.

Stopping a scheduled job
Steps to stop a scheduled job:
1. Go to the Jobs tab in the Manager view.
2. Select the desired scheduled job. Right-click it and in the context menu select Stop. The
respective job will stop running and its status will be changed to Stopped (displayed red)
NOTE: You always need to stop a job if you want to change its settings. Settings of a
scheduled or running job cannot be changed.

Archiving group emails with a job
On the figure below you can see the Group tab of the Manager view. List in the left pane displays
groups of users synchronized with Archive Manager. Some group icons are displayed in green, the
others not. Green indicates that the group has been activated for archiving.
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When you select a group on the Groups tab its properties are subsequently displayed in the right
pane.
The right pane is useful as there you can see some of the group’s properties. For example on the
previous figure you can see that SEA Pilote is activated for archiving (Activated: Yes), scheduling
will be done with 9pm-archiving (Scheduled in job: 9pm-archiving), Outbox and Deleted items
folders are excluded from automated archiving (Exclude folders: Outbox, Deleted items), all files
bigger than 10.24 MB will be archived (Archive files bigger than: 10.24 MB), message classes that
will be archived include IPM.Note, IPM.Post, IPM.Document (Included message classes:
IPM.Note, IPM.Post, IPM.Document).
NOTE: For more information on group settings see the section "Setting criteria for group
archiving”.

To archive emails of a group with a job:
1. In Manager view click on the Groups tab.
2. Right-click a desired group and, in its context menu, click Properties to open its Properties
window.
3. On the General tab check if that group has been activated for archiving (the Allow to archive
check box must be selected). Then click Apply.
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4. On the Scheduler tab select the desired job in the Selected job dropdown menu. Click Apply
and OK to confirm all.

Job reporting
Job reporting is a feature which allows the administrator to see how many messages are waiting
(are scheduled) for archiving, i.e. how many messages were given to the asynchronous archiving
service (DirectArchive service).
The messages are collected from different sources: scheduled jobs. When a "source” decides to
archive messages, it simply puts them into a database table. The asynchronous service
periodically reads this table and processes messages, depending on job settings.
The job reporting feature simply displays the content of that database table: it displays ONLY
those messages that are queued for processing. The content is automatically categorized by the
start time of the job.
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Steps to see the status or how many messages are queued for
archiving:
1. In Manager view, click on the Jobs tab. All jobs you have defined so far are displayed in the
left pane. At the bottom of that pane, click on the Job reporting tab to open the Pool monitor
window.

2. In the Pool monitor window unfold the Job independent node. You will get displayed all your
jobs. Number next to the job indicates how many emails assigned to the job are waiting to be
processed. Under the Job independent folder you can find emails from DirectArchive which
are waiting to be processed.

3. To get more details about the chosen job simply click on it. Items to be processed by that job
appear in the right pane of the window. The number of items is displayed also at the bottom
in the left corner. Click the Refresh icon to update the situation.
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NOTE: A lot of useful information can be found in the list view, e.g. the sequence number
of the item (Sequence), ID of the owner (Owner), Status (WAIT - waiting to be processed
or PAUSED – the respective job is stopped), location of the mailbox item (URL), the date
of creation (Creation date), number of unsuccessful attempts to process the item (Error
count), ID of the job in charge of the item (Job) etc.
4. Click the View switcher icon ( ) next to the Refresh icon to display the Mailboxes pane. In
this pane you can see mailboxes from which the selected job is archiving or mailboxes of job
independent items. The first number in square brackets next to the mailbox is the mailbox ID,
the second number is the number of emails waiting to be archived in that mailbox.
Click on the mailbox node (in our example user004) to display the waiting items of that
mailbox.

5. If archiving of an item failed even after several attempts, it is displayed red. In such cases you
may try to archive it again. Right-click the item and select Resume in the context menu.
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There are other options in the context menu for any item as well:
· Pause – archiving of that item will be paused, i.e. will not be process in that cycle, however,

it will be processed in the subsequent cycle.
· Deactivate - the respective item will never be processed by the job in question.
· Delete – the item will be deleted from the list.
· Info – Message information window opens displaying location, mailbox, subject, receive

date, message class and size of the selected message

Select Add/Remove columns option to customize the order and selection of columns in the
list view of the Pool monitor.
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Retention tab
On the Retention tab of the Manager view different retention categories for email archiving can
be set (e.g. retention category for short-term documents, retention category for long-term
documents etc.). In other words, various types of emails require different ways of archiving and
the time for which they need to be stored and retrievable can differ as well. Further we discuss
the usage of retention categories, their description and management from the end-user point of
view.
Various features of retention categories enhance the adaptability of Archive Manager for
Exchange for individual users together with the email life-cycle management. Emails can now be
archived with two-tier delete and manipulation protection. Tier one defines the retention time
in which archived emails can be neither deleted nor moved to different storage media – these
policies vary according to company or state regulations. Tier two allows the administrator to
transfer emails to long term storage media or delete them.
The shortcut creation time known simply as "shortcut delay” can be defined allowing Blackberry
users’ access to mails and attachments that have already been archived. The "Delete shortcut
after a time” feature can be used to reduce the number of "redundant” shortcuts left in the
Microsoft Exchange Store after a specific number of days, months or years.
The retention categories which are created here can be assigned to jobs on the Jobs tab.
IMPORTANT: The default retention category needs to be specified on the
Tools/Options/Archive settings/Retention tab. For more information see Archive settings.
This category will be applied if no specific category is selected, e.g. for direct archiving and
manual archiving using AddIn.
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Retention categories and their usage
The following types of settings are available:

Settings related to emails in the HSM Store:
· Retention time – the archived email is not delete-able from the HSM Store for the defined time

period. Retention time is thus the MOST CRUCIAL feature of Archive Manager for Exchange
related to law regulations. Emails ‘deleted’ using functionalities of Archive Manager for
Exchange or Outlook Addin are actually only marked for deletion and they reside in the archive
until this retention time expires.
· Delete time – the email, although not marked for deletion, is automatically deleted (by the

Delete Files job) from the archive after the expiration of the defined time period. It is the
MAXIMAL time for which the emails reside in the HSM Store. This time period cannot be
smaller than the retention time.
· Keep-alive time – it is the time period after email deletion, during which the deleted email can

be turned back to the store. However, this is possible only if the Delete time has not elapsed
yet.

Settings related to emails on the MS Microsoft Exchange Server:
· Keep the original email – email is archived but it is not modified in any way (no icon, no

shortcut, keep residing on the MS Microsoft Exchange Server). This option is used just for
backup.
· Delete original email – the email is removed from the MS Microsoft Exchange Server

immediately after archiving, no shortcut is created thus it is not reachable from the user’s
mailbox and it is displayed as "lost” in the Archive view.
· Create shortcut – the email is archived and it is replaced with a shortcut. This type of archiving

saves the space on the MS Microsoft Exchange Server and at the same time activates the user to
work with the archived email just as with non-archived one. Email can be replaced with the
shortcut immediately or it is kept without changes for the defined time period and after its
expiration shortcut is created ("Delay shortcut creation by” option ).
o Delete shortcut after a time – the shortcut of the email is automatically removed
from the MS Microsoft Exchange Server after the expiration of the defined time
period (email cannot be reached from the user’s mailbox any longer and is displayed
as ‘lost’ in the Archive view). However the email still resides in HSM Store.
The starting point of all the above mentioned times (except the Keep-alive time) is either the
moment of archiving or the moment of receipt. The starting point can be set when the retention
category is created.
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CAUTION: Please consider carefully the retention settings, especially when setting receive
time as the starting point. If a message has been received e.g. 6 months ago and your
retention time/delete time is just 3 months, the message will be archived. However, it can
be deleted from the archive immediately, as 3 months has already passed since the
beginning of its retention time.

In addition to the default retention category created during installation the administrator is able
to create any number of retention categories satisfying specific criteria of the enterprise. The
retention category consists of a name, a description, the above mentioned retention times and of
the HSM scheme. It is fully manageable from Archive Manager for Exchange.

Creating a new retention category
Steps to create a new retention category
1. On the View menu click Manager.
2. Click on the Retention tab.
3. Right-click inside the list view, select New category from the context menu and navigate
through the wizard as follows:
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4. Basic settings window pops-up. Enter the name for your retention category in the Category
name text box (e.g. Keep shortcut for 3 years).

5. In the Target HSM scheme dropdown box choose the target scheme which will be used for
archiving. In the HSM system you may define different HSM Schemas, which are virtual
categories for documents. (One HSM Schema has been created at installation of Archive
Manager for Exchange and you may have created more HSM Schemas during the setup of
Archive Manager for Exchange, each with a particular number assigned to it.)
6. In the Lifetime calculated from dropdown box you can choose from two options – Archive
time and Receive time; i.e. you can define here the starting point from which the all the
retention related times should be calculated. Either it will be the time when the item gets
archived (Archive time) or it will be the item’s Received time.
7. In the Category description text box fill in a short description of the new category.
8. Click Next.
9. In the Document lifetime window specify your settings.
It is strongly recommended paying very much attention to these settings as they define the
time period for which the emails are archived.
Set the Retention time. During this period none of the emails in the HSM store archived via
this retention category can be removed from the archive. It is possible to select:
· Fixed period (set the desired period)
· Indefinite period (the retention time is not set specifically but can be defined later)
· Infinite period (retention is everlasting)

Select Activate automatic document deletion check box and specify Delete time if you want
to COMPLETELY DELETE an archived emails whose retention time has elapsed from the HSM
Store after a defined time.
NOTE: Activate automatic document deletion option applies to emails which are not
marked for deletion.
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By specifying the Keep alive time you set the time period for which the email, deleted after
its retention time has elapsed, will be still kept in the HSM Store. Just use the arrows to set
the time or directly overwrite it. Delete and Keep alive time can be set in days, months or
years.

NOTE: The Delete time cannot be smaller than the Retention time. Pay due attention to
these crucial settings as here you set the time for which emails exist in the archive.
10. Click Next.
11. In the Shortcut lifetime window you can choose from three options:
a. Keep the original e-mail – select this option, should you wish to archive email and not to
modify it in any way. In this case no shortcut will be created and the whole email will
reside in the MS Microsoft Exchange Server. In the Archive view on the Mailbox tab such
item will be displayed with the following icon:

b. Delete original e-mail – select this option, should you wish to delete all original email from
the MS Microsoft Exchange Server immediately after its archiving. No shortcut is created
and the email is not accessible from the user’s mailbox. In the Archive view such item is
displayed as lost.
c. Create shortcut – select this option, should you wish to replace the original email with a
shortcut after archiving and thus make it accessible for the user and save the space on MS
Microsoft Exchange Server at the same time.
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In case you have selected the Create shortcut option, further settings become available
and you can adjust shortcut behavior to meet your needs. You can choose if the shortcut
creation will follow immediately after archiving of the email (Create shortcut immediately
radio button) or will be delayed for the specified period of time (Delay shortcut creation
by radio button) when e.g. Blackberry users will be able to view their attachments. While
no shortcut is created, the email is displayed in the Archive view with the following icon:
Moreover, you can decide whether you want to keep the shortcut in the user’s mailbox
until the user deletes it (Keep shortcut for ever option) or the shortcut will be deleted
automatically after the defined time (Delete shortcut after a time option).
12. Click Next.
13. Extra settings window pops-up. If the Allow automatic deletion of unreferenced emails check
box is selected, emails archived via this category will be marked for deletion whenever the
Shortcut Sync job cannot find the reference to the emails in any of the users’ mailboxes. If the
check-box is not selected, Shortcut Sync job will not marked eventual "lost items” for deletion
(see the section "Shortcut Sync job”).
Example:
I. Emails are archived by a retention category with Allow automatic deletion of unreferenced
emails checked and shortcuts are left in the Microsoft Exchange Server
II. You delete shortcuts from Microsoft Exchange (either by removing the shortcuts manually in a
items”
III.
CAUTION: If the items were archived with 0 retention time and with Allow automatic
deletion of unreferenced emails allowed, the Shortcut Synch Job deletes them
COMPLETELY.
IV. Items marked for deletion are deleted from archive when their Retention (and Keep alive)
time elapses and you run the Delete Files job
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IMPORTANT: Items marked for deletion still reside in the HSM Store but cannot be
restored using Archive Manager for Exchange, e.g. on the Archive tab.
14. Click Next to finish the creation of the new retention category.

Changing the settings of a retention category
To change the settings of an existing retention category:
1. Double-click the selected retention category to open the Retention category properties
window (or right-click it to open its context menu and select Properties).

2. On the respective tabs specify your new settings for the retention category. On the General
tab you can change the name, HSM Scheme, retention time, keep alive time as well as allow
automatic deletion of old documents and modify related Delete retention time. Click Apply
and OK.
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3. Shortcut settings can be modified on the Shortcut tab. Click Apply and OK to apply the new
settings.

4. On the Additional tab set the shortcut synchronization behavior – if the Activate document
clean-up by Shortcut synchronization job check box is selected, emails archived via this
category will be marked for deletion (or completely deleted if their retention time is 0)
whenever the Shortcut synchronization job cannot find the reference to the emails in any of
the users’ mailboxes. If the check box is not selected, Shortcut synchronization job will not
mark them.
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5. Click Apply and OK to apply your settings.

How to customize retention categories list view
After right-clicking any retention category on the Retention tab, the context menu appears.
· Add/Remove columns – click it in case you want to add or remove columns from the list view.

Add/Remove columns window opens. To add/remove a column, select the desired one from
the Available columns/Selected columns list. Then click on the Add/Remove button.
To change the order of the selected columns click the one you want to move and use the Up
and Down buttons. Click OK.

· Delete category – retention category can be deleted only if nothing was archived via this

retention category

Locations tab
For better performance and to secure load balancing Archive Manager for Exchange provides you
with the possibility to install several Archive Manager servers even in several locations (for more
information on Archive Manager locations and server roles see the section "General tab”).
After you have:
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1. installed your Archive Manager servers
2. assigned the servers their server roles on the Tools /Options/Server settings tab
You should:
3. register the servers as Archive/Retrieve severs here on the Locations tab of the Archive
Manager for Exchange.
NOTE: If you have only ONE Archive Manager server installed, you do not need to register it.
It needs to be mentioned that only the right pane of the Locations tab is active for adding, editing
or deleting. Left pane has been reserved for information purposes.

Registering Archive/Retrieve sever
To register a new server:
1. In Manager view open the Locations tab.
2. Expand the All locations node in the left pane of the window.
3. Select the location where you want to add the new server. Then right-click and select Add
server to location from the context menu.

4. In the New location server properties window enter the information as described below:
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a. Name - Name of the server.
b. Type - Choose from the following server types: Archive, Retrieve or PST Importer.
c. Alias - Enter the FQDN name of the server. Required if you use https for communication.
d. User secure connection (https) - Select this option if you use https for communication.
NOTE: If users are using Outlook Addin make sure that they can access the entered
location server. If users are using a proxy server, make sure that the location server is
accessible through the proxy.
If your environment uses https for communication and ArchiveWeb or OWA to access
archived items, the following settings must be configured:
· The site bindings and SSL Settings for the location server certificate must be

configured.
· The AM for Exchange service URL property for ArchiveWeb must be configured to use

https. See the ArchiveWeb Guide for more information.
· The Archive ManagerExchangePamWS URL property for OWA must be configured to

use https. See the OWA Guide for more information.
· In the Location server properties window, the Alias must be specified and the Use

secure connection (https) check box must be selected.

5. Click Apply, then OK. The new server will appear in the right pane of the Locations tab.
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NOTE: To delete the server from the list just right-click it in the left pane and select
Delete server from the location option in the context menu.

To add a new location:
1. In Manager view click on the Locations tab.
2. Expand the All locations node in the left pane of the window to see the all locations and its
servers.
3. Right-click the All locations and select the Add new location option.

4. In the New location properties window enter the name and display name in the respective
text boxes. You can change the location ID as well.

5. Click Apply, then OK.
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NOTE: To add a new server to the new location follow the steps described earlier in this
chapter. To delete/edit a location, right-click it and select Delete location /Properties in the
context menu.
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5
Status view
Status view is displayed by clicking Status on the View menu. By clicking on different nodes in the
left pane of the Status view you will display information on current version of Archive Manager
for Exchange, logged-on users, status of services, database, HSM Store etc.
By clicking on the Application Server node in the left pane you will display some detailed
information about the current version, as shown below:

By clicking on the Services node in the left pane you will see all Archive Manager for Exchange
services and their status.
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Services can be restarted by clicking on the Restart button. You can use the Stop button (
stop the selected service and then the Start button ( ) to start it again.

) to

By clicking on the Connections node in the left pane you will display current connections and
logins. Here you can find out access rights etc.

Archive Manager for Exchange can run on several computers in parallel and can communicate
with several MS Microsoft Exchange servers.
By clicking on the Microsoft Exchange servers node a list of synchronized MS Microsoft Exchange
servers will be displayed, including the number of threads.
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To change the number of threads, double-click a desired Microsoft Exchange server. In the
Threads window simply set the number of threads to be processed in one cycle. The higher the
number, the less number of cycles you have – it however slows down the system. An optimal
number is from 15 to 20.

If you, for instance, set the number of threads to 4 and click OK.

Click Yes to restart the service. Then by clicking on the Connections node, 4 entries will be
displayed (see the following figure).
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By clicking on the HSM node you will retrieve some information on your HSM store type,
HSM/Archive Manager Server and the ID of the default Retention Category. This is for
informative purposes only.

By clicking on the Database node some information about the database in use will be displayed.
This information is taken from the DB Config tool.
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6
Archive view
Archive view has been designed for shortcut repairing, for manual archiving/restoring (Mailboxes
and Public folders tabs) and for browsing purposes. Even restoring of lost items is possible in this
view (Archive and Mailboxes tabs).
There are four tabs – Mailboxes, Archive, Public Folders and Public folders Archive tabs.

Mailboxes tab
This tab is used for:
· Manual archiving/restoring of an item/folder/mailbox
· Repairing shortcuts
· Archiving only certain type of messages or mailbox folders(via Archive wizard)
· Restoring only certain type of messages (via Restore wizard)
· Lost items restoring on a mailbox level (via Restore wizard)
· Manual creating of shortcuts for archived items with "delay shortcut” settings

Before archiving with Archive Manager for Exchange
Before archiving with Archive Manager for Exchange all users and groups whose mailboxes you
plan to archive need to be synchronized with Archive Manager for Exchange Server (see
"Installation Guide for Archive Manager for Microsoft Exchange”). Keep in mind that archiving
cannot be applied to emails received by mailboxes that were not synchronized with the Archive
Manager Server.
The synchronization process can be automated, i.e. the synchronization can be scheduled in the
Archive Manager for Exchange\Tools\Address Book Manager and can run in the background (see
"Installation Guide for Archive Manage for Microsoft Exchange”).
When mailboxes are synchronized with Archive Manager Server you may start archiving with
Archive Manager for Exchange.
NOTE: The archiving services are configured to run automatically (service type set to
"Automatic” in Start\Settings\Control panel\Administrative tools\Services) and some of
them are running under the super-user account. If some services are not started, it is
necessary to start them manually using the included Start.bat batch file under C:Program
Files (x86)\ Metalogix\MAM4Exchange\Tools. If it does not help, please review the event
log entries (Start\Control panel\Administrative tools\Event viewer). The most common
problem of not starting services is the incorrectly configured identity – in this case either run
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an update (repair) of the Archive Manager for Exchange setup or correct the service
identities manually (using Start\Programs\Administrative Tools\Computer Management).
Simply display a desired mailbox in the left pane. Use the Look for combo box, enter the
respective name and press Enter. Should you enter an asterisk, a list of all groups and mailboxes
will be displayed. It is possible to find the desired mailbox while using the Set filter button as
well. Once you have displayed the desired mailbox folder you may start archiving/restoring
emails placed in that mailbox.
NOTE: Mailboxes have a unique identity number which is displayed in square brackets to
distinguish mailboxes in the case where two mailboxes have the same display name. The
unique identity helps the administrator to identify the correct mailbox.

For archiving and restoring you may use the Archive and Restore icons on the toolbar and the
context menu as well. On the following figure we have selected a non-archived email therefore
the Archive icon on the toolbar is accessible. On the next figure we have selected an archived
email therefore the Restore icon on the toolbar is accessible.
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The right pane of the Archive view displays the content of a folder selected in the left pane of the
window.
NOTE: Only the left pane is active for switching between folders, mailboxes, and groups. The
right pane has been reserved for manual email archiving/restoring.
Every item of the folder has its icon which represents the status of the item. You can open the
legend for icons when you click the Show legend icon on the toolbar ( ) or from Enterprise
Manager/Archive view/Archive tab when you right-click an item in the right pane and select
Show legend from the context menu. The Legend window with icon explanation appears:

How to manually archive an item
To archive individual items without using a job, use manual archiving.
For manual archiving of items placed in mailboxes – use the Mailboxes tab in the Archive view.
For manual archiving of items placed in public folders – use the Public folders tab (see the section
"Public folders tab (Archive view)”).

To archive items of individual mailboxes manually:
1. Click View on the Archive Manager for Exchange menu bar. Select Archive.
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2. Click on the Mailboxes tab.
3. Find the desired mailbox in the left pane. You may use the Look for combo box for that
purpose. Simply enter the desired name in the Look for combo box and then press Enter.
If you enter, for instance, the letter "a” and press Enter, a list of all users whose mailbox name
contains the letter "a” will be displayed.
If you enter, for instance, the asterisk "*” and press Enter, a list of all users will be displayed.

4. Double-click the required mailbox, e.g. Administrator, to expand its subfolders and then click
on the desired one (e.g. Inbox).
5. Select the desired items in the right pane and then click on the Archive icon on the toolbar.
NOTE: You can also right-click the desired item and then, in the context menu, select
Archive item.

6. The Archive Options window pops up before archiving. In the Retention category down-drop
box you can choose the retention category for archiving. The basic characteristics for each
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category (HSM Schema, Retention time and Delete time) will appear below the down-drop
box.
NOTE: If no selection is made in the Archive Option window, the retention category set as
default (see the section "Retention tab”) will be used for the archived item.

7. Click Archive.
8. When archiving is complete, the Processing result window will be displayed. Click OK.

9. The archived item will subsequently be displayed with a different icon (see below).

How to restore an item
To restore individual items, use the Mailboxes tab in Archive view. To restore items in public
folders, use the Public folders tab. For more information see the section Public folders tab
(Archive view).

To restore individual items:
1. In Archive view click on the Mailboxes tab.

Archi ve Ma na ger for Excha nge Admi ni s tra ti on Gui de
Archi ve vi ew

207

2. Find the desired mailbox in the left pane. You may use the Look for combo box for that
purpose.
3. Double-click the desired mailbox to display its subfolders. Select the desired folder in the left
pane. Its content will subsequently be displayed in the right pane. Only the left pane is active
for switching between folders.
4. Right-click the desired archived item in the right pane and then, in the context menu, select
Restore item.
NOTE: You can also select the desired archived item and then click on the Restore icon on
the toolbar.

5. The Restorer options window opens. If you select the Delete all versions of the document
check box then all versions of that document in the HSM store will be marked for deletion and
can be deleted with Delete Files job when their retention time elapses. If the check box is not
selected, versions will be displayed as lost on the Archive tab of Archive Manager for
Exchange. Click Accept.

6. When restoring is complete, in the Processing result window click OK. The respective item
will be restored and its icon will change, too.
NOTE: When restoring an item having several versions archived, those versions will be
displayed in the right pane. You may choose to restore any of those versions.
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How to manually archive all items in
a folder/mailbox
You can archive the content of a folder or a whole mailbox manually. The process is similar to
email archiving described in the section "How to manually archive an item”.
NOTE: Manual archiving of folder in public folders can be done on the Public folders tab in
Archive view. See the section Public folders tab (Archive view).

To archive the entire contents of a folder or mailbox manually:
1. In Archive view, click on the Mailboxes tab.
2. Find the desired folder/mailbox in the left pane. You may use the Look for combo box.
3. Right-click the desired folder/mailbox and then, in the context menu, click Archive
folder/Archive mailbox.
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Folder archiving
4. In the Retention category down-drop box of the Archive Options window you can leave the
default retention category or select another one. Click Archive.
5. When the process is finished, in the Processing result window click OK. All items in the
folder/mailbox will be archived.

How to restore all items in a folder/mailbox
Restoring of all items in a folder/mailbox is done in Archive view on the Mailboxes tab. If you
want to restore only certain type of messages (e.g. calendar items or tasks) for a mailbox, filter
out the desired message classes via Wizard – see the section "Restore Wizard – How to restore
only certain type of items”.
NOTE: Restoring of all items in a public folder can be done on the Public folders tab in
Archive view. See the section Public folders tab (Archive view).

To restore all items in a folder/mailbox:
1. In Archive view, click on the Mailboxes tab.
2. Find the desired folder/mailbox in the left pane. You may use the Look for combo box for that
purpose.
3. Right-click the desired folder/mailbox in the left pane and then, in the context menu, click
Restore folder/Restore mailbox.
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NOTE: You may also select the desired folder in the left pane and then click on the
Restore icon on the toolbar.

Mailbox restoring
4. In the Restorer options window click Accept. If you select the Delete all versions of the
document check box then all versions of items placed in that folder/mailbox will be marked
for deletion in the HSM store and can be deleted with the Delete Files job when the retention
time elapses. If the check box is not selected, versions will be displayed as lost on the Archive
tab of Enterprise Manager.

5. When restoring is complete, in the Processing result window click OK. All items placed in that
folder/mailbox will be restored.
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Repairing shortcuts
Usage:
· when some shortcuts are not working properly in Outlook
· when general shortcut settings on Tools/Options/Archive settings/Shortcut tab were changed

and these new settings should be applied to all shortcuts of a group, mailbox or folder

To repair shortcuts for a group/mailbox/folder:
1. In the Archive view click on the Mailbox tab.
2. Right-click the desired group/mailbox/folder in the left pane of the window and select Repair
shortcuts option in the context menu.

Archive Wizard
Archive wizard accessible from the mailbox context menu on the Mailbox tab is a powerful tool
for manual archiving. Administrator can archive several mailboxes at once and apply archiving
filters regarding:
· message type
· mailbox folders

To archive mailbox(es) with predefined settings:
1. In the Archive view click on the Mailbox tab.
2. Select one of the desired mailboxes in the left pane. You may use the Look for combo box for
that purpose.
3. Right-click the mailbox and select Archive wizard from the context menu.
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4. The Archive messages wizard opens. Use the Add button to add more mailboxes for which you
want to archive messages. Click Next.

5. In the following dialog you can set filters regarding message classes and folders.
a. To archive all messages select Archive all messages switcher.
If you want to archive only certain message classes, select the Filter messages switcher and
click the Filter button. In the pop-up message filter select to archive:
· All supported message classes (as set in Tools/Options/Message classes)
· Selected message classes and check those message classes which you want to archive.

NOTE: The selected message classes must be set as supported message classes on the
Tools/Options/Message classes/Supported classes tab. If they deactivated or not
supported, they will not be archived.

b. To archive all folders select Archive all folders switcher.
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If you want to archive messages only from certain mailbox folders, select the Filter folders
switcher and click the respective Filter button. Specify your settings in the pop-up message
filter. Click Selected folders switcher to choose folders to be archived:
· Include mail folders – all mail folders (Inbox, Sent Items, Drafts etc.) in the mailbox will

be archived, including user defined mail folders
· Include non mail folders – all non mail folders will be archived (e.g. Tasks, Calendar etc.)
· And you can select also specific folders under Default folders

Example: In the above figure we have selected Include mail folders check box and the
Calendar check box. As a result, all mail folders (Inbox, Sent Items etc.) of the given
mailbox will be archived and Calendar folder will be archived, too.
6. Then select the retention category which you want to use for archiving. Click Next.
7. In the Summary window click Start. When the process finishes, click Finish.

Restore Wizard – How to restore only certain type of
items
Restore wizard accessible from the mailbox context menu on the Mailbox tab significantly
extends restoring options. Administrator can decide to restore:
· filtered mailbox items that are filtered by type of item (e.g. calendar items, tasks etc.) or by

receive date.
· lost items of several mailboxes at once (see the next section Restore Wizard – How to restore

lost items for several mailboxes).

To restore filtered mailbox items:
1. In the Archive view click on the Mailboxes tab.
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2. Find one of the desired mailboxes in the left pane. You may use the Look for combo box for
that purpose.
3. Right-click the mailbox and select Restore wizard from the context menu.
4. The Restore mailbox wizard opens. Choose the Restore items filtered and click Next.

5. In the Settings window click Add button to add also other mailboxes.

6. The Select mailbox window opens. Enter the mailbox name in the upper text field or doubleclick all desired mailboxes from the list. Selected mailboxes will appear in the Selected
objects field. Finish by clicking OK.
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7. Back in the Settings window all selected mailboxes will be displayed in the Selected
mailboxes list. If you select Delete document after restore check box, restored messages will
be marked for deletion in the archive. Now click the Filter message class button to choose the
message classes to restore.

8. The message filter pops-up. Select the message classes which you want to restore for the
chosen mailboxes and click OK.

9. You can also filter messages by date when they were received or modified. To do so check the
Filter by date check box. Then opt for Receive date or Modification date and click Change
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filter. Then in the pop-up window specify after/before/between option in the Date downdrop box. Finally enter the desired date and click Apply.

10. In the Summary window click Finish. When the processing has finished, you can check the
result of processing. Next to every processed folder you can see the number of all folder
items/number of items processed/number of errors, e.g. "Folder Inbox processed 125/19/0”.
If no items satisfy the entered criteria, no summary is displayed. Click Close.

Restore Wizard – How to restore lost items for
several mailboxes
Users may have deleted the shortcut of an archived item simply by pressing the SHIFT key along
with the Delete key on the keyboard or by clicking on the Delete icon on the Outlook toolbar.
NOTE: (not by clicking on the Delete archived messages icon and selecting Delete from
archive option, which is an Archive Manager Client AddIn feature). In such cases those
archived items are lost for the user. They cannot be reached by the user, but they still reside
in the HSM store at least until their retention time expires. They can be recovered manually
by the administrator only on the Archive tab and lost items from several mailboxes can be
restored at once on the Mailboxes tab. (Such lost items have a blue icon on the Archive tab.

To restore all lost items for several mailboxes:
1. In the Archive view click on the Mailboxes tab.
2. Find one of the desired mailboxes in the left pane. You may use the Look for combo box for
that purpose.
3. Right-click the mailbox and select Wizard from the context menu.
4. The Mailbox wizard opens. Choose the Restore lost items option and click Next.
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5. In the Settings window click the Add button to add also other mailboxes for which you want to
restore lost items.

6. The Select mailbox window opens. Enter the mailbox name in the upper text field or doubleclick all desired mailboxes form the list. Selected mailboxes will appear in the Selected
objects filed. Finish by clicking OK.

7. Back in the Settings window all selected mailboxes will be displayed in the Selected
mailboxes list. Now choose one of the following options:
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a. Mark the document as deleted after restore check box – lost item(s) will be restores and
displayed in the user’s mailbox as non-archived; all versions of the lost item(s) will be
marked for deletion in the archive
b. Create shortcut check box – shortcut of the item(s) will be displayed in the user’s mailbox
and all versions will be accessible

8. Maybe you do not want to restore all lost items in the selected mailboxes. Click Filter to set a
filter for restoring. It is a search based filter. You can filter by sender, subject and also other
parameters.
Specify your filter parameters and click Start search button in the Search based filter window.
Click Apply if you want to restore the found item.
If you have finished, click Next.

9. In the Summary window read the summary. Click Evaluation, if you want to display the
number of lost items to be processed. Then click Finish.
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How to manually create a shortcut for an archived
item
In the Archive view on the Mailbox tab some items can be displayed with the following icon:
(delayed shortcut) or (backup shortcut). This indicates that the email has been archived but no
shortcut was created for it. That happens when the email has been archived via retention
category which keeps the original email or delay shortcut creation. (See "Retention tab”). It is
possible to create a shortcut for such email on the Mailbox tab.

To create a shortcut for an archived item:
1. In the Archive view click on the Mailboxes tab.
2. Find the desired mailbox in the left pane. You may use the Look for combo box for that
purpose. Double-click it to unfold its subfolders.
3. Locate the desired item with delayed shortcut/backup shortcut icon in the right pane. Rightclick it and then, in the context menu, click Promote delayed shortcut/Promote backup
shortcuts as required.
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4. When the processing is over, in the Processing result window click OK.

Archive tab
This tab is generally used
· to restore lost items

(they have no shortcut in MS Outlook, but they physically remain in the
HSM store during their retention time)

· as a mailbox browser

NOTE: On the Archive tab the administrator can browse through mailboxes and their folders.
For each folder there is a list of all its items displayed in the right pane of the window.
Different colors of the icon represent different status of the item. You can open the legend
for icons when you right-click an item in the right pane and select Show legend from the
context menu or you can click the Show legend icon on the toolbar ( ). The Legend window
with icon explanation appears.
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Some basic icons:
Blue indicates that the archived items are lost, i.e. they remain in the HSM store at least
during their retention time but they have no shortcut in Outlook. User cannot reach them. Such
lost items can be recovered manually only by the administrator on this tab or on the Mailboxes
tab (see the section "How to restore lost items for several mailboxes).
Green indicates that the archived item has a shortcut in Outlook. It can be restored.
Yellow indicates that the shortcut in the mailbox folder belongs to a different user.

Restoring lost items
Users may have deleted the shortcut of an archived item simply by pressing the SHIFT key along
with the Delete key on the keyboard or by clicking on the Delete icon on the Outlook toolbar and
not by clicking on the Delete archived messages icon and selecting Delete from archive option,
which is an Archive Manager Client AddIn feature.
In such cases those archived items are lost for the user. They cannot be reached by the user, but
they still reside in the HSM store at least until their retention time expires. They can be
recovered manually by the administrator only. Such lost items have a blue icon on the Archive
tab.
On this tab the administrator can restore:
· one lost item
· all lost items of a folder
· all lost items of a mailbox
· (restoring of lost items for more mailboxes at once can be done on the Mailbox tab – see the

section "How to restore lost items for several mailboxes”)
NOTE: In all three cases mentioned above the administrator can restore also to a folder or a
mailbox different from the original one (see Lost items restoring to a specific folder ).

To restore one or more lost items:
1. Click View on the Archive Manager for Exchange menu bar. Select Archive. Then switch to the
Archive tab.
2. In the left pane find the desired user whose lost item(s) you want to restore. You can use the
Look for combo box where you do not need to enter an exact name of the user.
3. To restore ONE LOST ITEM, open the folder in which the shortcut to this item was originally
kept. A list of all items of the folder will be displayed in the right pane. Right-click the desired
lost item (blue icon). In the context menu select Restore lost item option.
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To restore ALL LOST ITEMS OF A FOLDER right-click that folder in the left pane. In the context
menu select Restore lost folder items option.
To restore ALL LOST ITEMS OF A MAILBOX right-click that mailbox in the left pane. In the
context menu select Restore lost mailbox items option.
NOTE: If you want to display lost items only, right-click in the right pane and, in the
context menu, click Show only lost items.

Restoring a lost item
4. In the pop-up Restore options window choose between two options:
a. Delete all versions of the document check box – all versions of the lost item(s) will be
marked for deletion in the archive, just the latest one(s) will be displayed in the user’s
mailbox as non-archived
b. Restore shortcut only check box – shortcut of the item(s) will be displayed in the user’s
mailbox and all versions will be accessible
NOTE: If none of the options is checked, email is returned to the user’s mailbox as nonarchived and its versions, if any, are displayed as lost in Archive Manager for Exchange.

5. Click Accept. The respective archived item will be restored to the folder its shortcut had been
deleted from.
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6. When restoring is over, in the Processing result window click OK.

Restoring lost items to a specific folder
Using this option lost items can be restored to a mailbox different from the original one.
However, when only shortcut is restored (i.e. not the original message) to a different mailbox,
the mailbox user is not the owner of such item. It means that the user will not be able to delete
or modify the archived item using that shortcut. The user will be able to restore the shortcut and
perform the changes but cannot control the archived counterpart. On the Archive tab such item is
displayed with a yellow icon: .

To restore lost item(s) to a folder or a mailbox different from the
original one:
1. Click View on the Enterprise Manager menu bar. Select Archive. Then switch to the Archive
tab.
2. In the left pane find the desired user whose lost item(s) you want to restore. You can use the
Look for combo box where you do not need to enter an exact name of the user.
3. To restore ONE LOST ITEM, open the folder in which the shortcut to this item was originally
residing. A list of all items of the folder will be displayed in the right pane. Right-click the
desired lost item (blue icon). In the context menu select Restore lost item to option.
To restore ALL LOST ITEMS OF A FOLDER right-click that folder in the left pane. In the context
menu select Restore lost folder items to option.
To restore ALL LOST ITEMS OF A MAILBOX right-click that mailbox in the left pane. In the
context menu select Restore lost mailbox items to option.
NOTE: If you want to display lost items only, right-click in the right pane and, in the
context menu, click Show only lost items.

Archi ve Ma na ger for Excha nge Admi ni s tra ti on Gui de
Archi ve vi ew

224

4. In the pop-up Restore lost items window choose between two options:
a. Delete all versions of the document check box – all versions of the respective lost item(s)
will be marked for deletion in the archive, just the latest one(s) will be displayed in the
user’s mailbox as non-archived.
b. Restore shortcut only check box – shortcut of the respective item(s) will be displayed in
the user’s mailbox and all versions will be accessible.
NOTE: If none of the options is checked, email is returned to the user’s mailbox as nonarchived and its versions, if any, are displayed as lost in the Enterprise Manager.
5. Then click the Change button to specify the destination where the item(s) will be restored.
6. In the Mailbox folders pop-up window define a mailbox (using the Change button) and a
folder of that mailbox where the lost item(s) should be restored. If the folders are not
displayed, click Refresh. Click OK.

7. Back in the Restore lost items window the defined folder is displayed in the Destination field.
Click Start. Then OK.
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Restoring mailbox folders
When mailbox folders or sub-folders with archived items are deleted, the information about the
folder structure is available to Archive Manager. The entire folder structure can be restored. For
example, assume that the sub-folder tree Inbox > Conference > Vendors was deleted. Deleted
folder names appear in blue color.

To restore the folder structure
1. Select the root node of the deleted folder structure.
2. Right click and select Create folder structure from the context menu. The folder structure will
be restored along with any archived items in those folders and the folder names will be
displayed in normal black color.
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Public Folders tab
You can archive and restore items in a Public Folders manually. Restore wizard for lost item
restoring is also accessible in the context menu (see the "Restore wizard” section). However, first
we describe here the steps which have to be completed so that the users can archive in their
Outlook Public Folders.
For manual archiving of the items directly in Outlook public folders you need to do some specific
steps beforehand:
· First (and this is very important!), owner rights must be assigned for the respective public

folder in MS Outlook. (See the section How to manually archive an item in an Outlook public
folder)
· Then one additional simple step needs to be taken (we will describe it in detail below). (See

the section How to manually archive an item in an Outlook public folder)
NOTE: The process described below needs to be performed for every public folder whose
items you plan to archive/restore. The process needs to be done only once for each such
folder.
After going through the process you can archive and restore items in the MS Outlook using
Archive Manager Client Addin as described in this chapter or on the Public Folders tab using
toolbar icons or the context menu (as on the Mailbox tab).
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How to manually archive an item in an Outlook public
folder
1. Open Microsoft Exchange Administrator Center.
2. Click public folders and then click the public folders tab.
3. Select a public folder from the list (click through sub folders to reach a descendant subfolder). Then click Manage under Folder Permissions on the right.

4. In the pop-up window click Add (plus sign). Then click Browse to select the super-user that
you have configured in Archive Manager.

5. Set Permission level to Owner. Then select the Folder owner option.
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6. Click Close in the confirmation dialog and then click Save again to exit.
7. Now copy any archived email into that public folder: select an archived email and press CTRL
while dragging that email into that public folder. Now you may try to restore it. Only for this
mail you will get a warning message saying "Failed to restore 1 item”. For all other items
placed in that folder archiving (as well as restoring) will work properly.

How to restore archived items of an Outlook public
folder
Restoring of archived items residing in a public folder is done easily. Let’s say you have prepared
a public folder for archiving (see the process described in the section How to manually archive an
item in an Outlook public folder) and have already archived items there. Now you may restore
any archived item by simply selecting it and clicking on the Restore icon, or by clicking Restore in
the Archive Manager for Exchange.
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Restore wizard
Now get back to Archive Manager for Exchange itself. Restore wizard accessible form the context
menu on the Archive View/Public Folders tab allows administrator to restore all lost items in
Public Folders in a few simple steps.

To restore all lost items in a public folder:
1. In the Archive view click on the Public Folders tab.
2. Right-click the desired public folder and from the context menu click Wizard.
3. In the pop-up dialog click Next.
4. Now specify the restore behavior. Either:
Mark documents as deleted after – if checked, lost items will be restored to public folder and
they will be marked for deletion in the archive
or
Create shortcut – if checked, only shortcuts will be created for the lost items in the public
folder
If necessary, check the Process folders recursively check box. Then click Next.
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5. The Summary dialog displays your settings. You can check the number of items to be
processed by clicking the Evaluate button. To process the items click Finish.

Public Folders Archive tab
This tab is generally used
· to restore lost items

in public folders (they have no shortcut in MS Outlook, but they
physically remain in the HSM store during their retention time)

· as a public folder archive browser

NOTE: On the Public Folder Archive tab the administrator can browse through folders and
sub-folders. For each folder there is a list of all its items displayed in the right pane of the
window. Different colors of the icon represent different status of the item. You can open
the legend for icons when you right-click an item in the right pane and select Show legend
from the context menu or you can click the Show legend icon on the toolbar ( ). The
Legend window with icon explanation appears.

Icons for public folder item
Blue indicates that the respective archived items are lost, i.e. they remain in the HSM store at
least during their retention time but they have no shortcut in Outlook. User cannot reach them.
Such lost items can be recovered manually only by the administrator on this tab or on the Public
Folder tab (see the section How to restore archived items of an Outlook public folder).
Green indicates that the respective item is archived and has a shortcut in Outlook. It can be
restored.
Yellow indicates that the shortcut in the mailbox folder belongs to a different user.
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Restoring lost items
Users may have deleted the shortcut of an archived item simply by pressing the SHIFT key along
with the Delete key on the keyboard or by clicking on the Delete icon on the Outlook toolbar and
not by clicking on the Delete archived messages icon and selecting Delete from archive option,
which is an Archive Manager Client AddIn feature.
In such cases those archived items are lost for the user. They cannot be reached by the user, but
they still reside in the HSM store at least until their retention time expires. They can be
recovered manually by the administrator only. Such lost items have a blue icon on the Public
Folder Archive tab.
On this tab the administrator can restore:
· one lost item
· all lost items of a folder
· all lost items of a sub-folder

To restore one or more lost items:
1. Click View on the Archive Manager for Exchange menu bar. Select Archive. Then switch to the
Public Folder Archive tab.
2. In the left pane find the desired public folder whose lost item(s) you want to restore.
3. To restore ONE LOST ITEM, open the public folder in which the shortcut to this item was
originally kept. A list of all items of the public folder will be displayed in the right pane. Rightclick the desired lost item (blue icon). In the context menu select Restore lost item option.
To restore ALL LOST ITEMS OF A PUBLIC FOLDER right-click that folder in the left pane. In the
context menu select Restore lost folder items option.
NOTE: If you want to display lost items only, right-click in the right pane and, in the
context menu, click Show only lost items.
4. In the pop-up Restore options window choose between two options:
a. Delete all versions of the document check box – all versions of the lost item(s) will be
marked for deletion in the archive, just the latest one(s) will be displayed in the public
folder as non-archived
b. Restore shortcut only check box – shortcut of the item(s) will be displayed in the public
folder and all versions will be accessible
NOTE: If none of the options is checked, email is returned to the public folder as nonarchived and its versions, if any, are displayed as lost in Archive Manager for Exchange.
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5. Click Accept. The respective archived item will be restored to the folder its shortcut had been
deleted from.
6. When restoring is over, in the Processing result window click OK.

Restoring public folders
When public folders or sub-folders with archived items are deleted, the information about the
folder structure is available to Archive Manager. The entire folder structure can be restored. For
example, the image below indicates that the sub-folder tree Conference > Vendors was deleted.
Deleted folder names appear in blue color.

To restore the folder structure
1. Select the root node of the deleted folder structure.
2. Right click and select Create folder structure. The folder structure will be restored along with
any archived items in those folders and the folder names will be displayed in normal black
color.

Archi ve Ma na ger for Excha nge Admi ni s tra ti on Gui de
Archi ve vi ew

233

Archi ve Ma na ger for Excha nge Admi ni s tra ti on Gui de
Archi ve vi ew

234

7
Post Processing
Post Processing is a service which allows running customer specific tasks over archived emails
and their attachments across selected mailboxes. So those clients who are using other software
programs and wish to process within those software programs archived emails and their
attachments may do so via the Post Processing service.

How to use post processing
To use the Post Processing service, the user must use the Archive Manager Configuration tool.

Upon receiving a plugin, take the following steps:
1. Make sure that the Post Processing service has started.
NOTE: Without the Post Processing service started any plugin – even the active ones –
will not run and therefore no post processing will be performed.

2. Add the plugin to the Post Processing for Exchange scope.
3. Select all mailboxes to which post processing is to be applied.
4. Define the initial bookmark date for the plugin if necessary.
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NOTE: A bookmark indicates the date and time where the the indexing process has
reached. All emails and their attachments that are archived after this bookmark date will
be processed unless they have already been indexed. There can be several plugins running
in parallel, each with a different bookmark date. However, do not start post processing
service on multiple servers for the same database. Running the post processing service on
multiple servers is not recommended since that can cause conflicts in bookmarking. The
same database should not be indexed by more than one post processing service.
The Post Processing service manages (starts and stops) the plugins at regular intervals. Advanced
Post Processing settings can be configured after clicking the General Settings tab on the Post
processing tab.
Each plugin is loaded by default with the date and time (initial bookmark date). This means that
the plugin processes emails and their attachments having been archived after this initial
bookmark date. If post processing should begin from some other bookmark date, then make sure
to reset the initial bookmark date.
Enhance your ArchiveWeb search by a new search option. Besides Subject and From text boxes in
the Exchange Archive search a brand new searching option can be added to the search query – To
field. In this way user can search for items sent to specific recipient.
To activate the above mentioned searching by recipients, a post processing plugin must be
installed. This plugin indexes mail recipients.

Steps to install the SearchIndexPluginRange post processing plugin
1. Open Archive Manager Configuration Tool from <installdir>\Program Files (x86)
\Common Files\PAM\PAMConfig\PamConfig.exe.
2. Open the Post Processing tab.
3. Open the Post Processing Scopes tab.
4. Right-click on the desired scope and from the context menu and select Configure.
5. Click Add.
6. Installed plugins will be loaded in the Add Plugin pop-up window. Select
PostProcessPAMsearchIndex.SearchIndexPluginRange from the drop-down box and click Add.

7. The plugin is listed in the Plugins list in Configuration tab. By default it is active.
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Steps to Configure a Plugin
When a new plugin is added to the Plugins list, there are no mailboxes specified by default. You
must specify the mailboxes as well as the Bookmark Date. If no mailboxes are selected then post
processing will not process any archived emails and attachments.
1. From the Plugins list, select the PostProcessPAMsearchIndex.SearchIndexPluginRange plugin.
Either click the Properties button or right-click the selected plugin and click Properties from
the context menu.
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2. In the Post Processing plugin properties window set the properties as described below.
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The plugin properties are as follows;
a. Plugin is active - select this check box to activate the plugin.
b. Apply for selected mailboxes - the plugin scope is determined by the mailboxes that
you can select when you click Mailboxes.
i. In the Plugin mailboxes window click Add to add mailboxes.
ii. In the Select mailbox enter the name of a mailbox in the text box to search for the
mailbox. Double-click the desired mailbox in the list to transfer it to the Selected
objects section. In the Selected objects section you can check which users you have
selected.
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iii. Confirm by clicking OK. The selected mailboxes appear in the Plugin mailboxes
window.

iv. Click Close.
c. Apply for all mailboxes - the plugin scope is across all mailboxes.
d. Start Date - indicates the date when email indexing starts. Click the drop down to set
the date from the calendar popup.
e. End Date - indicates the date when email indexing ends. Click the drop down to set the
date from the calendar popup.
f. Bookmark Date - indicates the most recent index date and time. Click the drop down to
set the date from the calendar popup. When the plugin is installed, the Bookmark Date
should be the same as the Start Date. If you want to index old email items, set the Start
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Date and the Bookmark Date to the same date in the past from where you would want
the indexing to begin.
g. Reindex keywords - select this check box if keywords should be re-indexed within the
specified data range.
h. Reindex recipients - select this check box if email recipeinets should be re-indexed
within the specified data range.

Steps to specify a bookmark date and time
1. Right-click the plugin and click Set Bookmark from the context menu.
2. In the Enter bookmark window specify the desired time. Click OK.

NOTE: The bookmark date is displayed in the Plugins list in the Configuration tab. If you
reset the bookmark date, the change takes effect immediately, and there is no need to
deactivate and activate the plugin again. If you remove a plugin using the Remove button,
it will stop entirely without remembering where it stopped. You must reconfigure the
plugin if you reload it.

Archi ve Ma na ger for Excha nge Admi ni s tra ti on Gui de
Pos t Proces s i ng

241

8
Advanced Search
The Advanced Search feature helps an administrator to search for archive items. It cannot be used
to search non-archived items. This feature is a component of Archive Manager and is installed by
default. Advanced Archive Search has some special capabilities:
· It can search for emails in the archive that are marked for deletion. Items that are marked for

deletion are not visible in the Archive tab but they still reside in the archive until their
retention time expires.
· It can perform an OCR search in attachments that contain scanned content. However, characters

that are too small may not be correctly recognized. This capability must be activated in the
Configuration tool > Post Processing > OCR Engine tab.

Steps to search for archived emails
1. Click the Advanced Search icon
opens.

on the toolbar. The Advanced archive search window

2. Click the Messages tab.

3. Click Add new clause and enter the search criteria using the fields as described below:
a. Field - click the drop down to select the property of the email to be searched. For example,
select Subject as the field to search.
b. Operator - click the drop down and select a search operator.
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c. Value - Specify the search text. If the selected Field requires a date value, a date picker
icon appears to help you choose a date. This field supports wildcard characters as
described in the table below:
Wildcard

Description

Example

*

A substitute for zero or more
characters

*.pdf

?

A substitute for a single
character to match

Sales201?.pdf

4. To add more criteria, click Add new clause again. When you add more than one search clause,
the logical operator drop down box appears. You can select either the And or the Or operator.
The default operator is And. You can even group clauses to create nested search criteria by
selecting consecutive check boxes and clicking the icon.
5. To restrict your search to one or more mailboxes, click the button with the three dots in the
Search only in the following mailboxes section.
6. From the Select mailbox window that opens, select one or more mailboxes and then click
to move them to the Selected objects box. Click
to remove them from the Selected
objects box.

7. Click OK to close the window. The selected mailboxes will appear in the Search only in the
following mailboxes field.
8. Click the Settings tab.
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9. Configure the settings if needed, as described below:
a. Items per page - restricts the number of emails that can be displayed in the search result
list.
b. Search options allow you to specify the category of documents to search.
· No selection - only archived documents are searched. Previous versions of these

documents are not included.
Select one of the following options:
· Search in archived and deleted documents - all documents will be searched. Previous

versions of these documents are not included.
· Search in deleted documents - deleted documents and documents that are marked for

deletion will be searched. All other archived documents will be ignored. Previous
versions of these documents are not included.
Add an additional criteria:
· Search in versions - Previous versions will be included for the document category

specified. The match will be shown for each version separately.
10. Click Search to search for archived emails based on the selection criteria, the mailboxes
specified and the settings that are applied. Items marked for deletion are displayed with a
blue icon in the search result list.
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Example of a nested search query
Consider the following search request: All email items that were received by David Webb before
10th November 2020 and the subject contains either the words Wealth or Commerce.
Search criteria contains only email properties. Therefore the nested search criteria can be written
as follows:
Received Date < 11/10/2020 AND (Subject contains Wealth OR Subject contains
Commerce)

The context of the search query is restricted to a single mailbox called David Webb, but there are
no restrictions to the scope since All items are required to be searched in the specified mailbox.
To define the query in the Advanced archive search window, follow the steps described below:
1. Click the Advanced Search icon
opens.

on the toolbar. The Advanced archive search window

2. Click the Messages tab.
3. Click Add new clause and enter the search criteria using the fields as described below:
a. Field: Received Date
b. Operator: <
c. Value: 11/10/2020
4. Click Add new clause and enter the search criteria using the fields as described below:
a. And/Or: And
b. Field: Subject
c. Operator: Contains
d. Value: Wealth
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5. Click Add new clause and enter the search criteria using the fields as described below:
a. And/Or: Or
b. Field: Subject
c. Operator: Contains
d. Value: Commerce
6. Since Subject Contains Wealth Or Subject Contains Commerce are nested criteria, select the
two check boxes where the Field value is Subject. Then click the icon that appears. The
fields that are grouped are marked as shown on the image below:

NOTE: If there are nested criteria within a nested criteria, start the grouping with the
innermost nest. When the grouping is successfully applied, the checked boxes are
cleared and the group icon disappears.
7. Click the button with the three dots in the Search only in the following mailboxes section.
8. From the Select mailbox window that opens, select David Webb and then click
them to the Selected objects box.

to move

9. Click OK to close the window. The selected mailboxes will appear in the Search only in the
following mailboxes field.
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10. Since the scope of the search is All items, there is no need to change any properties in the
Settings tab.
11. Click Search to search for archived emails based on the selection criteria, the mailboxes
specified and the settings that are applied.

How to build search queries
This topic describes how to build search conditions using the advanced search capabilities of
Archive Manager for Exchange. A search condition (or query) can contain zero or more search
clauses that are combined using operators and grouping of search clauses.

Simple Conditions
A simple search conditions needs no search clause or can contain just one search clause.

Example 1
Click Search without adding a search clause. In this case, you will get back all the archived items.

Example 2
Add a single search clause with a condition where the field Subject contains the word "them”.
When you click Search, you will get back all the archived items where the Subject contains the
word "them”.
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AND/OR operators
The AND/OR operator is used between two search clauses. With these operators, you can
combine two or more search clauses. The AND operator will return a search result if both the
search clauses separated by the AND operator are fulfilled. The OR operator will return a search
result if any one of the search clauses separated by the OR operator are fulfilled. The AND
operator has a higher priority over the OR operator. When a search condition contains both the
AND and OR operators, the search clauses that are combined with the AND operator must be
fulfilled first.

Example 1
To find all items where the Subject contains word "them" AND the Sender is "amadmin", you
must combine two search clauses as shown:
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Example 2
To find all items where the Subject contains word "them" OR the Sender is "amadmin", you must
combine two search clauses as shown:

Grouping
Sometimes simple combinations of search clauses with the AND and OR operators are not
enough. Grouping is a good solution to change the priority between the operators. The grouped
search clauses have a higher priority than the operator before or after the group. The examples in
this section describe how the grouping works.

Example 1
To find all items where the Subject contains the word "them" AND the Sender is "amadmin", and
all these items must also have an attachment then the search condition is as shown:
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Query: (Subject contains "them” OR Sender is "amadmin") AND has attachment
We can split this search condition into two parts
1. (Subject contains "them” OR Sender is "amadmin”) which is a group
2. AND has attachment
Since a grouping has a higher priority, the search condition in the group must be fulfilled first. In
this case each item in the search result will have a Subject that contains the word "them” AND the
Sender is "amadmin”, and the item will also have an attachment

Example 2
To find all items where the Subject contains word "them” or, the Sender is "amadmin” and at the
item must have an attachment, then the query is as shown:

Query: Subject contains "them” OR Sender "admin” AND has attachment
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This query can be split into two parts
1. Subject contains "them” OR
2. Sender is "amadmin” AND the item has an attachment
The AND operator has a higher priority so the search clauses combined with the AND operator
must be fulfilled first. In this case the search result will contain items where the item must have
an attachment and the Sender must be "amadmin”, or Subject should contain the word "them”.

Example 3
To find all items where the Subject contains the word "them" and the Sender is "amadmin”, or the
item has attachment, and the item must be in the "Inbox" folder then the search condition is as
shown:

Query: Subject contains "them” AND (Sender is "amadmin" OR has attachment)
AND Folder path is "Inbox"

This query can be split into three parts
1. Subject contains "them” AND
2. (Sender is "amadmin” OR the item has an attachment)
3. AND Folder path is "Inbox”
The grouped search clauses have the higher priority in this query so the search condition in the
group must be fulfilled first. In this case the search result will contain items where the Subject
must contain the word "them” + Sender should be "amadmin” or the item has an attachment + the
folder path must be "Inbox”.
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Example 4
To find all items where the Subject contains the word "them” and Sender is "amadmin”, or the
item has an attachment and these items should be in the "Inbox” folder then the search query is
as shown:

Query: Subject contains "them" AND Sender is "amadmin" OR has attachment AND
Folder path is "Inbox"

This query can be split into two parts
1. Subject contains "them” AND Sender is "amadmin” OR
2. Item has attachment AND Folder path is "Inbox”
The AND operator has a higher priority in this query so the conditions with the AND operators
must be fulfilled first. In this case the search result will contain all items where Subject contains
the word "them" and Sender is "amadmin" or the item must have an attachment and the folder
path must be "Inbox".

Example 5
To find all items where the Subject contains word "them” or these items are in the "Inbox”
folder, and the Sender is "amadmin” or the item has an attachment, then the query is as shown:
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Query: (Subject contains "them” OR Folder path is "Inbox") AND (Sender is
"amadmin" OR has attachment)

This query can be split into two parts
1. (Subject contains "them" OR Folder path is "Inbox") AND
2. (Sender is "amadmin" OR item has attachment)
The grouped condition has the higher priority in this query so the conditions in the group must be
fulfilled first. In this case the search result will contain items where Subject should contain
"them” word or folder path should be "Inbox” + Sender should be "amadmin” or the item should
have an attachment.

Example 6
To find all items where the Subject contains the word "them" or, these items are in the "Inbox”
folder and the Sender is "amadmin", or the item has an attachment, then query is as shown:
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Query: Subject contains "them” OR Folder path Inbox AND Sender is "amadmin”
OR item has an attachment

This query can be split into three parts
1. Subject contains "them” OR
2. Folder path is "Inbox" AND Sender is "amadmin"
3. OR item has an attachment
The AND operator has a higher priority so the conditions with the AND operator must be fulfilled
first. In this case the search result will contain items where Subject must contain the word "them”
or folder path must be "Inbox” and Sender must be "amadmin” or the item has an attachment.

Search result options
You can perform the following operations on the emails that are displayed in the search result
list:
· Restore a copy
· Restore To
· Save search result to file
· Export data
· Mark for deletion
· Recover a document

Restore a copy
One or more archived emails can be restored to their original location. This is useful when a user
has deleted an email that was archived and would like to restore it from the archive again.

Steps to restore emails to their original mailboxes
1. Right-click the selected email(s) and choose Restore a copy from the context menu.
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2. The Restore window opens.

· Check Delete all versions of the item to restore the email to the mailbox and delete all

other versions.
· Check Restore shortcut only to restore only the shortcut.

NOTE: Either the shortcut or the email is restored to the mailbox even if the original
shortcut/email is also in the mailbox, i.e. duplicate items can be created. If no check
box is selected, the whole email is restored to the mailbox without marking any version
for deletion.
3. Click Accept.

Restore To
One or more archived emails can be restored to another location.

Steps to restore emails to another location
1. Right-click the selected email(s) and choose Restore a copy from the context menu.
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2. The Restore window opens.

a. To specify a destination mailbox folder click Change. The Mailbox folders window opens.
b. Click Change to choose another mailbox or click Refresh to display the folders in the
selected mailbox.
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c. Select a folder from the list of folders and click OK to close the window.

d. Check Delete all versions of the item to restore the email to the mailbox and delete all
other versions.
e. Check Restore shortcut only to restore only the shortcut.
NOTE: Either the shortcut or the email is restored to the mailbox even if the original
shortcut/email is also in the mailbox, i.e. duplicate items can be created. If no check
box is selected, the email is restored to the mailbox without marking any version for
deletion.
3. Click Start to restore the selected emails to the new destination.
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Save search result to file
You can export all the items in the search result to an XML file.

Steps to export data
1. Right-click anywhere in the search result list and choose Save search result to file from the
context menu.

2. The Save export file window opens.
3. Specify the name of the file and click Save.
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Export data
Archive Manager for Exchange allows exporting of found items to a mailbox or PST file by running
export tasks. Administrator can even export emails saved in several search result files by adding
one or more documents to one export task.

Steps to export search results
1. Right-click in the result list and from the context menu choose Export data.

2. The Export tasks window opens. You can also open this tool when you click Export tasks from
the Tools menu. For more information about exporting data see Export Tasks.

Mark for deletion
This option marks selected documents as deleted. Only documents marked as deleted can be
purged from the archive after their retention time expires. They will be completely deleted with
the Delete Files job, if such a job is scheduled. Documents that are not marked as deleted will
never be purged unless you have defined a retention time for them.

Steps to mark items for deletion
1. Right-click the selected item in the search result list view and select Mark for deletion option
from the context menu.
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2. Then click Yes. As a result the item will be marked for deletion. It will neither be accessible in
the Archive Manager for Exchange sever nor in the ArchiveWeb application. It can be only be
found with the Advanced Archive Search.

Recover document
Email items that are marked for deletion but available in the archive are displayed with blue
icons in the search results list. It is possible to recover these documents and view them in Archive
Manager for Exchange server and in ArchiveWeb.

To recover document marked for deletion:
1. Right-click the selected item in the search results list view and select Recover document
option from the context menu.
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2. As a result the deletion mark will be removed and the item will be again displayed on the
Archive tab in the Archive view as a lost item. It will be also be accessible also ArchiveWeb.
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9
Appendix
· How to create a customized HTML shortcut template

How to create a customized HTML shortcut
template
On the Shortcut tab of the Archive Manager for Exchange (Tools/Options/Archive
settings/Shortcut tab) you can configure Archive Manager for Exchange to create HTML shortcuts
for archived emails. The appearance of the archived email in the Outlook Preview pane depends
on the template which you choose on that Shortcut tab. Besides the default template for the
shortcuts you can create your own templates satisfying your criteria and thus modify the design
of the Outlook preview pane for archived emails.

To create your own template:
1. Go to <installdir>\ Metalogix\MAM4Exchange\Tools\Templates.
2. In the Template directory create a new folder. Its name will be the name of your new
template displayed on the Tools\ Options\ Archive settings\ Shortcut tab of Archive Manager
for Exchange (in our example the name of the template is Beautiful).

3. Copy the sampleHTMLShortcut.html file to the new template folder (in our case to Beautiful).
Or copy the html file from the Default folder, if the sample is not available.
4. Rename the sampleHTMLShortcut.html to HTMLShortcut.html.
5. Now you can modify the HTMLShortcut.html file in the new folder to create your desired
template. To do so, open the file in Notepad and edit the HTML code.

Important variables:
%ATTACHMENTS% - email attachments
%BUTTONS% - buttons
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%BODY% - message body
%PROPERTIES% - message specific properties needed for Macintosh clients

The original HTML:
<! DOCTYPE
h t ml
PUBL I C
" - / / W3 C/ / DTD
XHTML
1. 0
St r i c t / / EN"
" h t t p : / / www. w3 . o r g / TR/ x h t ml 1 / DTD/ x h t ml 1 - s t r i c t . d t d " >
<h t ml x ml n s =" h t t p : / / www. w3 . o r g / 1 9 9 9 / x h t ml " >
<h e a d >
<me t a h t t p - e q u i v =" c o n t e n t - t y p e " c o n t e n t =" t e x t / h t ml ; c h a r s e t =u t f - 8 " / >
<t i t l e >
</ t i t l e >
<s t y l e t y p e =" t e x t / c s s " >
<! - body {
ma r g i n : 0 ;
t ex t - al i gn: c ent er ;
paddi ng- t op: 10px ;
}
t d. hl av i c k a {
di s pl ay : bl oc k ;
hei ght : 20px ;
c o l o r : wh i t e ;
b a c k g r o u n d - c o l o r : # 6 6 9 9 FF;
f o n t - f a mi l y : a r i a l ;
f ont - s i z e: 14px ;
t ex t - al i gn: l ef t ;
}
t d. hl av i c k a s pan {
f o n t - we i g h t : b o l d ;
paddi ng- l ef t : 5px ;
}
t d. but
v er t i
t ex t paddi
paddi
}

t ons {
c a l - a l i g n : b o t t o m;
al i gn: r i ght ;
ng- r i ght : 10px ;
n g - b o t t o m: 1 0 p x ;

t d. but t ons a {
c o l o r : # FFFFFF;
b a c k g r o u n d - c o l o r : # 6 6 9 9 FF;
f o n t - f a mi l y : a r i a l ;
f ont - s i z e: 11px ;
paddi ng: 5px ;
bor der : 1px s ol i d #333366;
f o n t - we i g h t : b o l d ;
t ex t - dec or at i on: none;
ma r g i n - l e f t : 3 p x ;
}
t d. but t ons a: hov er {
f ont - s i z e: 12px ;
f o n t - we i g h t : b o l d ;
}
t d. pr i l ohy {
bac k gr ound- c ol or :

wh i t e ;
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f ont f ont paddi
t ex t -

f a mi l y : a r i a l ;
s i z e: 12px ;
ng: 5px 5px 5px 5px ;
al i gn: l ef t ;

}
t d. pr i
c ol or
ma r g i
ma r g i
f ont }

l ohy a {
: bl ac k ;
n- r i ght : 15px ;
n- t op: 15px ;
s t y l e : n o r ma l ;

t d. pr i l ohy a: hov er {
t ex t - al i gn: c ent er ;
f o n t - we i g h t : b o l d ;
}
t d. c i ar a {
bac k gr ound- c ol or :
wi d t h : 1 0 0 %;
}

#333366;

t d. t ex t {
di s pl ay : f l oat ;
c ol or : #2a2a2a;
t ex t - al i gn: c ent er ;
b a c k g r o u n d - c o l o r : wh i t e ;
f o n t - f a mi l y : a r i a l ;
f ont - s i z e: 12px ;
paddi ng: 5px ;
t ex t - al i gn: l ef t ;
}
t d. s t r ed {
bor der : 1px s ol i d #333366;
}
t d. pat a {
di s pl ay : bl oc k ;
wi d t h : 9 9 . 9 %;
hei ght : 15px ;
bac k gr ound- c ol or :
paddi ng- r i ght : 0;
}
-->
</ s t y l e >

# 6 6 9 9 CC;

</ h e a d >
<b o d y >
<t a b l e wi d t h =" 1 0 0 %" b o r d e r =" 0 " c e l l s p a c i n g =" 0 " c e l l p a d d i n g =" 0 " >
<t r >
<t d b g c o l o r =" wh i t e " c l a s s =" s t r e d " h e i g h t =" 1 0 0 %" >
<t a b l e
wi d t h =" 1 0 0 %"
c e l l p a d d i n g =" 0 " >
<t r >

b o r d e r =" 0 "

h e i g h t =" 1 0 "

<t d h e i g h t =" 1 0 0 %"
a r c h i v e d </ s p a n ></ t d >
</ t r >

c l a s s =" h l a v i c k a " >

<s p a n >T h i s

c e l l s p a c i n g =" 0 "

me s s a g e

wa s

</ t a b l e >
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<t a b l e
wi d t h =" 1 0 0 %"
c e l l p a d d i n g =" 0 " >
<t r >

b o r d e r =" 0 "

h e i g h t =" 1 0 "

c e l l s p a c i n g =" 0 "

<t d h e i g h t =" 1 0 0 %" c l a s s =" p r i l o h y " >%AT T ACHMENT S%</ t d >
<t d h e i g h t =" 1 0 0 %" c l a s s =" b u t t o n s " n o wr a p >%BUTTONS%</ t d >
</ t r >
</ t a b l e >
<t a b l e
wi d t h =" 1 0 0 %"
c e l l p a d d i n g =" 0 " >
<t r >

b o r d e r =" 0 "

h e i g h t =" 2 "

c e l l s p a c i n g =" 0 "

<t d b g c o l o r =" # a 0 c 3 c 9 " wi d t h =" 1 0 0 %" h e i g h t =" 2 p x " ></ t d >
</ t r >
</ t a b l e >
<t a b l e
wi d t h =" 1 0 0 %"
c e l l p a d d i n g =" 0 " >
<t r >

b o r d e r =" 0 "

h e i g h t =" 1 0 "

c e l l s p a c i n g =" 0 "

h e i g h t =" 1 0 "

c e l l s p a c i n g =" 0 "

<t d h e i g h t =" 1 0 0 %" c l a s s =" t e x t " >
<p r e WRAP=" h a r d " >%BODY%</ p r e >
</ t d >
</ t r >
</ t a b l e >
<t a b l e
wi d t h =" 1 0 0 %"
c e l l p a d d i n g =" 0 " >
<t r >

b o r d e r =" 0 "

<t d h e i g h t =" 1 0 0 %" c l a s s =" p a t a " ><b ></ b ></ t d >
</ t r >
</ t a b l e >
</ t d >
</ t r >
</ t a b l e >
</ b o d y >
</ h t ml >

Default HTML shortcut in the preview pane

Example of customized HTML shortcut
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10
About Us
Quest creates software solutions that make the benefits of new technology real in an
increasingly complex IT landscape. From database and systems management, to Active Directory
and Office 365 management, and cyber security resilience, Quest helps customers solve their
next IT challenge now. Around the globe, more than 130,000 companies and 95% of the Fortune
500 count on Quest to deliver proactive management and monitoring for the next enterprise
initiative, find the next solution for complex Microsoft challenges and stay ahead of the next
threat. Quest Software. Where next meets now. For more information, visit www.quest.com.

Contacting Quest
For sales or other inquiries, visit www.quest.com/contact.

Technical Support Resources
Technical support is available to Quest customers with a valid maintenance contract and custome
rs who have trial versions. You can access the Quest Support Portal at https://support.quest.com
The Support Portal provides self-help tools you can use to solve problems quickly and
independently, 24 hours a day, 365 days a year. The Support Portal helps you to:
· Submit and manage a Service Request
· View Knowledge Base articles
· Sign up for product notifications
· Download software and technical documentation
· View how-to-videos
· Engage in community discussions
· Chat with support engineers online
· View services to assist you with your product
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